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This section includes the following help topics:
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Comparison of FileCloud Sync and Drive
You can use the following FileCloud tools to access and manage your files stored and shared in the 
cloud:

   FileCloud Sync

   FileCloud Drive

When should I use FileCloud Sync and when should I use FileCloud 
Drive?
Deciding on which tool to use depends on how you want to access and manage your files. It can also 
depend on some of the following factors:

 Company policy

 Internet connectivity

 Security policies 

Use the information in Table 1 to understand the difference in the tools and choose which is the best 
one for you. You can also decide to use them both!

Table 1. FileCloud Sync vs. Drive

USE CASES

FileCloud Sync FileCloud Drive

Offline copy is needed for reasons such as 
traveling & intermittent network access. 

Offline copy is not needed or not allowed per company policy

Team collaboration View FileCloud server files as a drive. User doesn't want files to 
be downloaded for local copy. File downloaded only in edit. 

Recommended when lots of files needs to 
be moved to the FileCloud Server. The 
process is a lot more efficient than 
uploads.

Doesn't consume permanent storage. Ideal for newer laptops 
with SSDs where hard disk capacity is limited

Recommended If you are working with 
files that are 1 GB or larger, because they 
are stored directly in File Explorer.

Recommended for working with small to medium sized files 

When you try to open a large file in an application via FileCloud 
Drive, it is not instantaneously available like smaller files. 
Depending on your network connectivity, this could take longer 
than several seconds.
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Locally view FileCloud files & have a 
selective and/or all files/folder from 
FileCloud as copy on Desktop

Scenario where you need access to TBs of files and don't want 
every file to be synced.

Better in editing large files such as 
AutoCAD

Easier on bandwidth usage - all files doesn't need to be 
downloaded and uploaded. Use to upload, edit, or download a 
small number of files or small documents.

Better when working on files directly from 
your HDD

Better when editing linked documents 
such as graphic files that link to multiple 
other files. 

Ideal Dropbox replacement - great offline 
edits.

CHALLENGES

FileCloud Sync FileCloud Drive

Requires storage space on the HDD to 
store offline files

Requires active and stable internet connection

Are files downloaded to desktop?

 Yes, synchronized with FIleCloud 
Server periodically

Are files downloaded to desktop?

 Files are downloaded only on edit
 Upon save, file is synchronized back to FileCloud server

How does locking work?

 No deliberate locking can be issued in 
FileCloud Sync client.

 As files are proactively synced 
between FileCloud Server & Sync 
Client - Conflicts & updates are 
notified on Sync. 

How does locking work?

 Automatically lock on edit in FileCloud Drive.
 If lock is not possible, edit will be prevented and server 

copy will not be changed

OTHER FEATURES

FileCloud Sync FileCloud Drive

Selective Sync - Not all files under 
FileCloud is copied to Desktop

Map FileCloud folders as a Drive
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Actively Bi-directional Set limit on file size at Drive level

FileBrowser app to edit and browse all 
documents via a explorer like interface
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Using FileCloud for Office

FileCloud for Office is an MS Office add-in for Word, Excel, and PowerPoint files which can be used 
in both Windows and macOS with FileCloud Sync, FileCloud Drive, and FileCloud Desktop. It is 
available in FileCloud beginning with version 23.1.
Prior to version 23.1, DocIQ was available for similar operations. DocIQ is still available in Sync and 
Drive for previous users, but it is entering the end-of-life process and will no longer be available for 
download as of October 1, 2024. Support will no longer be available as of December 31, 2024. For 
more information, see https://www.filecloud.com/end-of-life-policy/.

https://www.filecloud.com/end-of-life-policy/
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How do I install FileCloud for Office?
Before installing:
Contact FileCloud Support and request that your cookie same-site value 
be set to None.

To add FileCloud for Office to the Office files that you access through 
the client app:
Perform the following procedure once each for a Word, an Excel, and a 
PowerPoint file in the client. 

1. Open the Office file from the client application.
2. Click File > Get Add-ins.
3. In the Office Add-ins search box, enter FileCloud for Office and click 

Enter.
FileCloud for Office is returned.

4. Click Add to add FileCloud for Office to the Office file.
5. Click Home in the menu bar, and on the right click FileCloud (FFO 

Commands).
A panel showing FileCloud for Office opens on the right.

6. Repeat this for the other two types of Office files.

FileCloud for Office is now attached to all Office files in your client folder. 
Just click FileCloud (FFO Commands) in the toolbar to view it.

What applications does FileCloud for Office works with?

 Word 
 Excel



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

Using FileCloud for Office – 7

 PowerPoint

What does FileCloud for Office do?

FileCloud for Office works with Office documents to enable you to:

 automatically lock and unlock files when they are opened and closed
 share files
 access different versions of files

For more information, click the link to the individual client section for FileCloud for Office:

Using FileCloud for Office with Sync

Using FileCloud for Office with Drive

Using FileCloud for Office with FileCloud Desktop for macOS
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FileCloud Sync

You can use FileCloud Sync to keep local copies of your FileCloud folders and files. You access the 
local copies through Windows Explorer or Mac OSX Finder on your desktop.  These files and folders 
are periodically synchronized with their online copies.  In other words, if you have made changes to a 
local copy of a file, the changes are replicated to the file on your server. If you make changes to a file 
on your server, the changes are replicated to your local copy of the file. (You also have the option of 
only copying changes to files made in one of these locations to the other.)

 FileCloud Sync is a client application. This is because it allows you to access the FileCloud 
Server and the files you store there.

 You can access files in Sync like you do in Windows Explorer or Mac OSX Finder.

 The same features that are available on the User Portal are also available in Sync.

 Sync allows you to easily open the User Portal if you need to.

 You can configure Network Folders as well as My Files to be automatically synchronized to your 
client.

 You can back up Sync files for safekeeping

 Sync includes an assistant to make it easy to access Sync files from Microsoft applications.

Install and Log In to FileCloud Sync
You must install FileCloud Sync before you can begin synchronizing documents on your local 
computer to the FileCloud Server site.

You can install FileCloud Sync on computers running the following operating systems:

 Windows

 Mac OSX

 Linux

Sync Requirements:

 Synchronized files must be on a physically attached disk to the machine running Sync

 You cannot synchronize files located by a UNC or Network path

FileCloud Sync supports Mac versions OSX 10.14 and above.
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Install Sync on Mac OSX

You must install FileCloud Sync before you can begin synchronizing documents on your local 
computer to the FileCloud Server site.

To install FileCloud Sync on macOS:

1. Download FileCloud Sync App from https://www.filecloud.com/additional-downloads/#sync

2. After successfully downloading the app, run the downloaded dmg file FileCloudSync64.dmg.

3. Drag and drop FileCloud Sync app to Applications.

4. Go to Applications and open the FileCloud Sync App.

Install Sync on Windows

You must install FileCloud Sync before you can begin synchronizing documents on your local 
computer to the FileCloud Server site.

FileCloud for Office is an MS Office add-in for Word, Excel, and PowerPoint which can be used in 
both Windows and macOS with FileCloud Sync, FileCloud Drive, and FileCloud Desktop. It is available 
in FileCloud beginning with version 23.1.
For instructions on how to install FileCloud for Office, see Using FileCloud for Office.
Current FileCloud Sync DocIQ users: DocIQ is still available in Sync and Drive for previous users, but 
it is entering the end-of-life process.
Now, when you upgrade FileCloud Sync, you are given the choice of using FileCloud for Office or 
continuing to use DocIQ. If you choose to use FileCloud for Office, please see the Using FileCloud for 
Office with Sync documentation.

 FileCloud Sync installers do not create a Sync desktop shortcut. However, users can create the 
shortcut manually.

https://www.filecloud.com/additional-downloads/#sync
https://www.filecloud.com/supportdocs/display/FCDOC/.Using+FileCloud+for+Office+v23.232Mobile
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To install Sync on Windows:

1. Download FileCloud Sync App from https://www.filecloud.com/additional-downloads/#sync

2. After successfully downloading the App, run the execution file FileCloudSync.exe.
The first screen of the wizard recommends that you use the FileCloud for Office feature.

3. Click Next.

https://www.filecloud.com/additional-downloads/#sync
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4. Leave the checkbox checked, and click Next.
If you are already a Sync user using DocIQ, and this is an upgrade, the next screen gives you the 
option of using DocIQ or FileCloud for Office. For more information, see Using FileCloud for 
Office with Sync. If you are a new Sync user, the following screen does not appear.

https://www.filecloud.com/supportdocs/display/FCDOC/Using+FileCloud+for+Office+with+Sync
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The next screen appears.

5. Click Install.
The wizard shows the installation's progress.
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When installation is complete, the following screen appears:

6. Leave Yes, restart the computer now selected to restart your computer and begin using Sync or 
the latest version of Sync, and click Finish.

Start and Log In to Sync

After you install Sync and restart your computer if necessary, you must provide your FileCloud account 
information to Sync. 

To start and log in to Sync:

1. In your Start menu, expand the FileCloud Sync folder and click the FileCloud Sync icon.
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2. The Get Started wizard opens to its welcome page:

By default, the user interface language is English, the sync folder is your local FileCloud folder, 
and remote management is enabled.

3. Change the user interface language to the language you prefer; do not change the other settings 
unless instructed to by your administrator.

4. Click Get Started.
The window for Step 1 Log In, opens.

Step 1 Log In
In the window for step 1, Log In, enter your credentials and log in to FileCloud Sync.
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1. For Login Method, leave the default of Password, or choose SSO or Device Authentication Code.

2. If you use Password: 

a. In FileCloud Sync Server URL, type the address of yourFileCloud server.

b. In Account and Password, type in the credentials that were sent to you when your FileCloud 
account was created.

c. Click Log in.

3. If you choose SSO (single sign-on), type the address to the FileCloud server that was sent to you 
when your FileCloud account was created.
You are redirected to the SSO Login page, where you can enter your username and SSO 
password to log in. 

4. If you choose Device Authentication code, 

a. In FileCloud Sync Server URL, type the address of your FileCloud server.

b. In Account, type in the username that was sent to you when your FileCloud account was 
created.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 16

An Enter Device Code dialog box opens.

c. Click Open Website.
The log-in screen of the user portal opens.

d. Log-in to the user portal.

e. In the upper-right corner of the screen, click your username and choose Settings.

f. In the Settings screen, click Devices.

g. Next to the listing for Cloud Sync, click the check.

A dialog box with the device authentication code opens.

h. Enter the authentication code into the Enter Device Code dialog box, and click Submit.

5. Or enter Proxy settings.
The window for Step 2, Cloud Storage opens.
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Step 2 Choose which cloud folders to sync
In the window for step 2, Cloud Storage, you choose which files to sync.

1. Choose:

 Sync Everything to sync all of your FileCloud files and folders.

 Sync nothing and use only Document Editing mode to use Sync to edit your FileCloud files 
from your desktop without syncing changes with FileCloud.

 Sync only selected folders to choose which folders' content to sync. If you choose this 
option, you are prompted to choose the folders to sync.  

i. Click Add Folders.
The Select Folders dialog box opens.

ii. For each folder that you want to sync, in My Files, Team Folders, or Shared with Me, 
navigate down to the folder, and choose Select.
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2. Click the right arrow to go to the window for Step 3, Network Folders.

After installation, you can change your sync options.

Step 3 Sync Network Folders
Since Network Folders are not a FileCloud Online feature; check Don't Sync Network Folders, and then 
click the arrow to go to Step 4, Backup Folders.
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Step 4 Backup Folders

If you see the message Backup folders not enabled. This feature is not available, please contact 
your administrator, you may continue to set up and log in to FileCloud Sync by clicking the right 
arrow in the screen.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 20

The window for step 4, Would you like to back up your folders to FileCloud?, lets you choose which 
folders to back up on FileCloud.

Choose one of the options:

 Do not save additional backups on FileCloud (This can be changed later from Advanced 
Settings)

 Select folders to back up to FileCloud.

If you choose Select folders to back up to FileCloud, you are prompted to choose the folders to back 
up.

1. Click Add Folders.
The Select Directory dialog box opens.

2. Choose the folder that you want to back up.
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3. In Schedule, choose how often you want to back up the folder.

4. Check Email notification after backup completes if you want to be notified each time the folders 
in the directory are backed up.

5. Click Add to Backups.
The Select Directory dialog box closes and the folder is added for backing up.
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For information about editing settings for backing up folders, see Backing Up Files.

Click the right arrow to go to Step 5 Finish.

Step 5 Start using Sync
The window for step 5, Finish  lets you start syncing and go to advanced settings. 
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Click Start syncing to turn on Sync.

Click Start syncing and go to advanced settings to go to the Settings page of the Sync dashboard.

Exiting or Resetting Sync

When you exit Sync, your session ends, but your username, password, and configuration settings are 
saved, so that when you re-open Sync, your settings are automatically filled in.

Resetting Sync removes your username, password, and configuration settings from Sync. When you 
reset, the login screen reappears, and you must newly enter your username and password and set up 
your Sync configuration.

You can exit Sync or reset Sync from the Account Settings option in the mini-dashboard or the main 
dashboard.
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To exit Sync
In the mini-dashboard or the main dashboard, in the upper-right corner, click your username and 
choose Exit.

Sync closes, but when you reopen it, you are automatically logged in and your configuration settings 
are applied.

To reset Sync

1. In the mini-dashboard or the main dashboard, in the upper-right corner, click your username and 
choose Reset.

The following confirmation dialog box opens. It alerts you that you will be logged out and your 
settings will be cleared.
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2. Click Continue.
You are logged out of Sync and all of your settings are removed.
The Get Started page opens.
In addition to entering your username and password, you are required set up sync folders and 
sync schedules again.

Checking for Updates to Sync

To check if there are updated versions of Sync:

1. To open the mini-dashboard, In your system tray, right-click on the Sync icon and choose Open.

2. To open the main dashboard, In the mini-dashboard, click Dashboard.

3. In the navigation panel, click Help.

4. In the Help screen, click Check for Updates.

If there are updates to install, you are redirected to the installation link.
If you have the latest version installed, the following message appears at the bottom of the 
screen:
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Opening and Using Sync Dashboards
Once Sync is installed and running, you can work in the Sync folders in file explorer, and perform Sync 
operations in its mini-dashboard and main dashboard.

The mini-dashboard was made to give you a small interface that stays out of your way as you work, 
but enables you to run Sync operations and provides you with the information you need about your 
data and Sync operations. The main dashboard enables you to fully configure your Sync application as 
well as run Sync operations and view Sync logs.

Each time you open Sync, the mini-dashboard opens. From the mini-dashboard, you can access the 
main dashboard.

1. In your system tray, right-click the Sync icon, and choose Open.

The mini-dashboard opens. 
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2. At the bottom of the mini-dashboard, click Dashboard.

The main dashboard opens:

Working in the Mini-Dashboard

In the mini-dashboard, you can view Sync information, enable and disable the application, and run Sync 
manually. 

 The Cloud Storage icon appears checked if syncing is enabled for it or with a warning sign if 
there are any file syncing errors.

 If enabled but not syncing, Cloud Storage displays idle.

 In the center of the mini-dashboard is a list showing data from the most recent sync.
The number of conflicts (if any) is displayed at the top of the list, and synced files and folders 
are displayed below it. 
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 The mini-dashboard displays a row of icons that you can click to perform actions or go to other 
locations in the Sync interface

Icon Action

Dashb
oard

Opens the main dashboard

Websit
e

Opens FileCloud user portal. 
You can also open the FileCloud user portal by right-clicking your username in the mini-
dashboard or main dashboard and clicking Account Settings. In the Account Settings
screen, click the link to the server URL.
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Icon Action

Search Opens Sync search 

Setting
s

Opens the Settings page of the main dashboard.

 At the top of the mini-dashboard, click your username to access the options Account Settings, 
Reset, and Exit.

 Click Account Settings to go to the Account Settings page of the main dashboard

 Click Reset to clear your settings.

 Click Exit to log out of Sync, but save your settings.
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Working in the Main Dashboard

You can sync files and folders, change settings, and review information in the main dashboard.

To access the main dashboard:

1. In the system tray, right click on the Sync icon, and choose Open.
Sync's mini-dashboard opens.

2. At the bottom of the mini-dashboard, click the Dashboard icon.

The main dashboard opens. It has several screens, which are listed in the left navigation pane. 
Click the name of a screen to open it.
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Dashboard screen

The Dashboard screen is the first screen that opens in the main dashboard. It displays Sync 
information and lets you turn Sync on and off as well as run Sync manually.
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Activity screen

In the Activity screen, you can view the content of log files, and open files in file explorer. 
For more information about the Activity screen, see View or Clear Log Messages in Sync.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 34

Cloud Storage screen

The Cloud storage screen enables you to view and change your Sync settings for FileCloud content 
in My Files, Team Folders, and Shared with Me.
For more information, see Cloud Storage: Selective Folder Sync.
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Network Folders screen

Most FileCloud Online users do not have access to Network Folders and see the following message 
on the Network Folders screen:



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 36

Backup folders screen

Most FileCloud Online users do not have access to the backup function in Sync and see the following 
message on the Backup folders screen:
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Settings screen

The Settings screen lets you view and change Sync settings.
For more information, see Sync Settings.
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Help screen

The Help screen lets you view log files, import and export Sync configuration, and check for Sync 
updates.
For more information, see Sync Logs. 

Sync Settings
You can view and control Sync settings from the Settings page of the main dashboard.

To get to the Settings page:

1. In the system tray, right click on the Sync icon, and choose Open.
Sync's mini-dashboard opens.
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2. At the bottom of the mini-dashboard, click the Settings icon.

The main dashboard opens to the Settings page.
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Setting  Function

Sync folder location Click Open Sync Folder to open the Sync directories in your file explorer.
Click Change to select a different location (a different drive or folder) for your 
Sync folder in file explorer. 

Upload and 
download

See Limit upload and download rate.

Active sync hours See Limit Sync To a Schedule.

Remote 
management

Allows Sync users to manage their Sync application by overriding an 
Administrator's settings, but from FileCloud version 19.1 and later, 
administrator's may disable the ability to override. See Managing Client 
Devices.

Proxy settings Enabled or disabled by default depending on initial Sync configuration.
You can enable, disable, and change proxy settings here. You must restart Sync 
for this to take effect. 
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Setting  Function

Language Change the language of the inteface. You must restart Sync for this to take 
effect. 

Sync frequency You can change the built-in sync frequency of 120 seconds for cloud 
storage. You must restart Sync for this to take effect. 

Miscellaneous  Show Notifications for Sync Activity - Yes by default. Uncheck to 
change to No. You must restart Sync for this to take effect. 

 Run at Windows Startup - No by default. Check to change to Yes.
 FFO Office Integration - checked (yes) by default. Uncheck to change 

the setting. You must restart Sync for this to take effect.
If you are using DocIQ instead of FFO, the label appears as DocIQ 
Office Integration.
For more information about DocIQ or FFO, see Using DocIQ with 
Office for Sync Users or Using FileCloud for Office with Sync.

 Automatic Locking in FFO - Checked (yes) by default.
If automatic locking in FFO is checked, when you open a file in 
Sync, FFO automatically tries to lock it and give it read-only 
access.  Check or uncheck to change the setting. You must 
restart Sync for this to take effect.
If you are using DocIQ instead of FFO, the label appears as 
Automatic Locking in DocIQ. 

 Trust FFO - Only appears the first time you log in to FileCloud 
Sync.

1. Click Trust FFO to use FileCloud for Office.
2. If you are prompted to allow installation of the FileCloud 

for Office certificate, click Yes.
The Trust FFO button disappears, and you will not have to 
click it again.

 Show Lock Status in Icon Overlay - No by default.  When checked, if a 
user locks a file or folder in Sync, the lock icon overlay appears over it 
in the Sync directory in file explorer.

Limit Sync To a Schedule

You can set a schedule for the times when you want the Sync application to run; otherwise, when it is 
on, it runs 24 hours, every day.

Scheduling Sync is useful if:

https://www.filecloud.com/supportdocs/display/FCDOC/.Using+FileCloud+for+Office+with+FileCloud+Desktop+for+macOS+v23.1
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 you are running the FileCloud Sync app on a busy network and want Sync to run at the least busy 
times

 you want to save your changes to FileCloud only at the end of each day

The settings you use impact the Sync application in the following ways:

If you enter settings, the only time syncing occurs is the time specified in the settings. 
For example:
If you choose:

 Sunday and Tuesday for days of the week

 the hours from 8:00 AM To 10:00 AM

Then Sync is active only on Sundays and Tuesdays and only during the hours between 8 AM and 10 
AM. It is disabled on other days and times.
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Sett
ing

Valu
e Impact Notes

Activ
e 
Sync 
Hour
s

enabl
ed

Sync is active only during the scheduled times.

 At all other times Sync remains disabled, 
which means real-time syncing, offline 
folders syncing, and backup are disabled.

 Sync is off appears on the mini dashboard 
and main dashboard.

 If you choose the Doc editing only mode, then 
you cannot set Active Sync Hours
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Sett
ing

Valu
e Impact Notes

Activ
e 
Sync 
Hour
s

disabl
ed

Sync is always active.

 Sync is on appears on the mini dashboard 
and main dashboard.

 The Sync Now button appears on the mini 
dashboard and the main dashboard.

If the Active Sync Hours settings are 
disabled because you are in Document 
Editing mode, you can enable them by 
clicking Sync is Off in the main 
dashboard or mini-dashboard. The 
dashboard setting now appears 
as Sync is On and Active Sync Hours
settings are enabled. 

Doc 
editi
ng 
only

enabl
ed

This mode always takes precedence over Active 
Sync Hours

If you are in Document editing only mode, the 
Active Sync Hours settings are disabled.

To use Active Sync Hours settings 
again:

 Click Sync is Off in the main 
dashboard or mini-dashboard. It 
now appears as Sync is On and 
Active Sync Hours settings are 
enabled. 

Doc 
editi
ng 
only

disabl
ed

Active Sync Hours settings are enabled and a 
schedule can be set.

To set a schedule for Sync times:

1. In your system tray, right-click on the Sync icon and choose Open.
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2. In the mini-dashboard, click Settings.
The Settings window in the main dashboard opens.

3. In the Settings window, in the Active Sync Hours section, click the toggle to change it to 
Enabled.

The Active Sync Hours dialog box opens.

4. Select Every Day or On a Specific Day.

5. If you choose On a Specific Day, check all of the days that you want Sync active 

6. You can only set one time interval. Use the Start Time and Stop Time fields.
If you want an overnight time interval, the End Time must precede the Start Time. Otherwise, 
Sync assumes the time interval occurs on each checked day separately. See Special cases for 
active sync hours, below.

7. Click Save.

8. Restart Sync to apply your changes.
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Special cases for Active Sync Hours

Case How to configure Notes:

Active times start and stop at 
the same times multiple days, 
that is:
Mon10:00 am - Mon 2:00 
pm 
and 
Tues 10:00 am - Tues 2:00 
pm

The Sync app does not treat 
this as Monday 10:00 am to 
Tuesday at 2:00 pm.

If Stop time is later than Start 
time, do not check the next 
day; it is assumed that the 
time continues into the next 
day.

If you check the next day, the 
app includes the next day and 
its following day as well (see 
the example in the next row).

The Sync app treats this as 
Monday 7:00 pm to Tuesday 
5:00 am.

(If you check Monday and 
Tuesday, The Sync app would 
treat it as
Monday 7:00 pm - Tuesday 
5:00 am and
Tuesday 7:00 pm to 
Wednesday 5:00 am)

Active times are overnight on 
consecutive days, that is:
Mon 9:15 pm - Tue 5:45 am 
and
Tue 9:15 pm - Wed 5:45 am 
and
Wed 9:15 pm - Thu 5:45 am

The Sync app does not treat 
this as Monday 9:15 pm 
through Thursday 5:45 am. 
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Case How to configure Notes:

From a certain time one day 
to the same time the next 
day, for example:
8am Mon - 8am Tues

Not possible, instead schedule from 
Monday 8am to 7:59 am. The Sync app 
assumes that the time period flows into 
Tuesday.

The following setting would 
cause sync to never occur:

Limit upload and download rate

If you are running the FileCloud Sync app on a slow network, when Sync transfers files it can quickly 
use up the resources of the network.

 

 You can limit Sync's upload and download rate to reduce the impact on your network and 
day to day operations.

 Rates are specified in kilobytes (KB/s).

 You can set a limit to be used whenever you are running Sync.

 You can set a limit that is enforced only during a specific interval of time.

 You can set a different rate limit for uploading files than you set for downloading.

 If the available KB/s are less than the specified maximum, then file transfer will be limited to the 
available KB/s.

 Sync maintains the file transfer limits even when there are multiple simultaneous uploads or 
downloads.

For example,

 If the default simultaneous uploads or downloads is 4 and you set a 400 KB/s rate limit

 If 4 streams are active, then each is limited to 100 KB/s 

 If only one stream is active then that stream will take up 400 KB/s

  If you do not specify a rate limit or if it is set to -1, then Sync will use all of the available KB/s.

The ability to limit the rate that Sync uploads and downloads files to reduce the impact on the 
network is available in FileCloud version 18.2 and later.
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To set a rate limit for Sync:

1. In your system tray, right-click on the Sync icon and choose Open.

2. In the mini-dashboard, click Settings.
The Settings window in the main dashboard opens.

3. In the Settings window, in the Upload and Download section, click Change Settings.
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The Upload and Download window opens.

4. Under Global Rate Limits, check Max Upload Speed or Max Download Speed and enter a 
number for KB/s.

5. To set a limit that is enforced only during a specific time interval:

a. Under Scheduled Rate Limits, check Max Upload Speed or Max Download Speed and enter 
a number for KB/s

b. In the lower portion of the window:

i. Leave Every Day checked, or check On a Specific Day and choose the day in the 
Select Day drop-down list.

ii. Leave the Start Time and Stop Time at 0 (to indicate all times) or enter times when 
the scheduled rate limits are effective.
In the following example, maximum upload and download speeds have been set to 
150 KB/s for Saturdays at 6 am to 9 pm only.
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6. Click Save.

7. Restart Sync to apply your changes.

Synchronizing Files

Automatic Syncing

By default, when FileCloud Sync is on, files and folders are automatically synced.

Automatic Sync schedules
By default, automatic syncing takes place 24 hours/day, every day. However, you may change this 
schedule.

 Change the default Sync schedule

Files and folders in Managed Storage are automatically synced every 2 minutes by default, but you can 
change this in the setting Sync Frequency.  

Manual Syncing

You can also sync files manually from the mini-dashboard or main dashboard at any time.

Manually sync from the mini-dashboard

To manually sync from the mini-dashboard:
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1. In your system tray, right-click on the Sync icon and choose Open.
The mini-dashboard opens.

2. If you see Sync is OFF at the top of the mini-dashboard, click the toggle to change the setting to 
Sync is ON. 

3. Across from Sync is ON, click Sync Now.

The mini-dashboard indicates if cloud storage or backups are being processed, lists the files 
being processed, and indicates any errors or conflicts.
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When processing is complete, Cloud storage and Backups displays Idle next to them as well as 
the number of files with errors. To handle error files after syncing see Managing Sync Conflicts
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and Sync Troubleshooting Guide.

To manually sync from the main dashboard:

1. In your system tray, right-click on the Sync icon and choose Open.
The mini-dashboard opens.

a. Click the Dashboard icon.
The main dashboard opens to the Dashboard screen.
Cloud Storage is listed with a Sync Now button next to it if syncing is enabled and files are 
available for syncing. Backup Folders is listed with a Backup Now button next to it if 
backing up is enabled and files are selected for backing up.
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b. Click the Sync Now button to begin syncing files and folders or the Backup now button to 
begin backing up.
The screen indicates that sync or backup is in process:
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When syncing is complete, the screen displays the size and number of files synced and the 
number of skipped files and errors. Files are skipped if there is a problem that prevents 
syncing, such as bad characters in the filename. A warning triangle and errors indicate that 
there was a conflict due to two recently saved versions of the file or another error that 
causes syncing to fail.
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c. To see why files were skipped, resolve conflicts, or review other errors click the skipped 
message or error message.

After syncing:

Managing Sync Conflicts

What is a Sync conflict?

Conflict can arise under the following conditions:

 When two people save the same file at approximately the same time. In this case the first 
person's changes are saved to the server, and when the second person's sync app tries to save 
the file, it realizes there is a new version and prevents the second person's changes from 
uploading and overwriting the first person's changes. In this case the first person's file is 
downloaded instead and saved locally adjacent to the original file with "Conflict_" appended to it.

 While one person was editing a file offline, the file was modified by another user. When the 
person who was offline comes back online and the sync app tries to upload the edited version to 
the server, it detects that there is a new version available and instead of overwriting the changes 
on the server, it downloads the server file locally and mark it as a "Conflict" file.

When two people change the same file at the same time, FileCloud Sync app won't try to merge the 
changes.

 Instead, Sync will save the original file
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 Sync also saves a second version which has the same name but is appended with the 
information about the conflict

By creating a second file, FileCloud Sync ensures that all changes are preserved and one person's 
changes do not overwrite another person's work.

Your Sync conflicts appear in two places, and you can resolve them in either.

A conflict file appears in your browser's file listing It also appears in the Activities window of the 
dashboard

To resolve an individual conflict from the Sync dashboard:

1. In your system tray, right-click on the Sync icon and choose Open.
The mini-dashboard opens. If a previous Sync resulted in conflicts or other errors, it displays an 

Conflict files are named as follows, where filename is the name of the file with the conflict, and the 
date is the date and time of the conflict:

 For a file in a shared folder, where other is the name of the other user who modified the 
file:  filename(Conflict_other (Web browser)_2020-03-25-22-50-36).txt

 For a file in a team folder, where teamname is the team folder account name:  
 filename(Conflict_teamname (Web browser)_2020-03-25-23-01-42).txt

 For a read-only file in a local sync folder,:  filename(Conflict_Read-
Only_2020-04-27-21-35-33).doc
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error notification.

2. Click the error notification.
The dashboard opens to the Activity window with Error selected in the View drop-down list. 
Errors, including conflict errors, are listed below it.

3. To resolve a conflict, click the three dots next to the conflict description.

4. Click Resolve conflict using local file to discard the server file and keep your modified local file.
or
Click Resolve conflict using server file to discard the local file and save the file that is currently 
on the server.

5. If you want to go to your Sync folder in file explorer and resolve the conflict there, click Open 
Location.
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6. If you want to copy and paste the location in a message or file, click Copy Location to Clipboard.

To resolve multiple conflicts from the Sync dashboard:

1. In your system tray, right-click the Sync icon and choose Open.
The mini-dashboard opens. If a previous Sync resulted in conflicts or other errors, it displays an 

error notification.
2. Click the error notification.

The dashboard opens to the Activity window with Error selected in the View drop-down list. 
Conflicts and other errors are listed below it.
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3. At the bottom of the window, click the Resolve Conflicts link.

The window now displays the file conflicts with checkboxes beside them and a Resolve method
drop-down list.
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4. Click All to  check all of the files, or individually check files
.

5. In the Resolve method drop-down list:
Choose Resolve with Local to discard the server file and keep your modified local file for each 
checked conflict.
or
Choose Resolve with Remote to discard the local file and save the file that is currently on the 
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server for each checked conflict.

6. Click Resolve.

7. In the confirmation box, click Yes.

Resolve a conflict from the Sync directory in file explorer:

1. In your system tray, right-click on the Sync icon and choose Open.
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2. In the mini-dashboard, click the Open Sync Folder icon.

File explorer opens and displays your Sync directory.

3. Open the folder in your Sync directory that contains the conflict file or folder.
A conflict file has a yellow warning icon over it and a name in conflict format in parentheses. It 
appears above or below the local version of the file.

4. Right-click on the conflict file, and choose FileCloud Sync > Resolve conflict.

A Resolve Conflict dialog box opens.
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5. If you want to check the content of either file before choosing which copy to save, click Open 
local or Open remote.

6. Select Use local modified file: (filename) to discard the server file and keep your modified local 
file.
or
select Use remote server file: (filename) to discard your modified local file and save the server 
file.

7. Click Resolve, and confirm your change.
The conflict file no longer appears.

Reviewing Skipped Files

When synchronization occurs, some file types in the local Sync folder are not processed by the Sync 
client application because they are on the list of ignored files.

 Files of this type are not uploaded from your local computer to the server.

The following types of files are currently ignored by the Sync client application:

Description Notes

Files in use These are files that have an exclusive write lock or are read-only

File names matching the skip regex string This is configured in a file, usually by your administrator

File names with special characters ~, <, >, :, \, /, *, ?, \r, \n

And also .cache and .tmp.part files

File name extensions which are restricted 
by the server

This is configured by your administrator
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To view a list of skipped files:

1. In your system tray, right-click on the Sync icon and choose Open.

2. If there is a Warnings tag in the mini-dashboard, click the tag.

The Activity screen opens with Skipped (All) appearing in the View drop-down list.

The description for each file indicates why it was skipped.

3. Click the three dots next to the description for options.
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4. Click Open Location to open the folder in file explorer where the file is stored, or click Copy 
Location to Clipboard to copy the storage path so you can paste it into a message or a file.

5. You may go through the files and correct the problems causing them to be skipped and Sync 
again.

To export or clear the skipped files:

 At the bottom of the screen, click Export or Clear.
Clicking Clear does not only clear records in Skipped (All) view, it clears all Sync Activity
records.

Checking Sync Status

You can check the status of your most recent sync in the main dashboard, the mini dashboard, or on 
the system tray icon.
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Status in the main dashboard
After a sync operation runs, if there are any errors or skipped files, the main dashboard displays a 
count in the upper-right corner. It also displays a a red error sign, a yellow warning sign, or a check (to 
indicate a successful run) beside Cloud storage.

Status flags in the mini-dashboard

 If there were conflicts in the most recent sync operation, the mini-dashboard displays a red error 
flag with the number of conflicts.

 If there were skipped files in the most recent sync, the mini-dashboard displays a yellow flag 
with the number of skipped files.

 If the most recent sync was successful, the mini-dashboard displays  a check in a blue circle 
before Cloud storage.
Click the red or yellow flag in the mini-dashboard to go to the main dashboard's Sync Activity
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page to see the conflicts or skipped files.

Status flags in the system tray

You don't have to open one of the dashboards to check your sync status. Sync alerts you to problems 
with a status indicator that appears as a dot overlaying the icon in the system tray:

The color of the dot indicates the status of the most recent sync operation:

Icon Color Status

Red Error in Sync activity
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Yellow Warning about Sync activity

None Sync was successful or no activity

Black
(white circle)

Sync Running

Click the Sync icon to open the mini-dashboard.

Cloud Storage: Selective Folder Sync

Limiting what gets Synced

You can choose to limit which folders in cloud storage get synced. This is useful when you have 
terabytes of data in an account and you only want a few gigabytes of folders locally to conserve 
space.

To limit which folders are synced:

1. In your system tray, right-click on the Sync icon and choose Open.

2. In the mini-dashboard, click Dashboard.

3. In the navigation pane of the dashboard, click Cloud Storage.
The Cloud Storage window opens.

4. Select the radio button for Sync only selected folders.

5. Click Add Folders.
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The Select Folders dialog box opens.

6. In My Files, Team Folders, or Shared with Me, navigate down to a folder that you want to sync, 
and choose Select.

7. Repeat steps 5 and 6 for each folder that you want to sync.
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 To view Sync details about your selected sync folders:   

 In the Cloud Storage window of the dashboard, click one of the selected folders.
Below it, the details about the most recent sync are listed: the number of folders synced, the 
number of files synced, total MB synced, and the number of files ignored (not synced).
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To remove a folder from selective sync:

 In the Cloud Storage window of the dashboard, click the x to the right of the folder that you want 
to remove, and confirm that you want to remove it.

To return to syncing all folders:

 In the Cloud Storage window of the dashboard, select the radio button for Sync Everything.
The box and list of selected folders disappears. If you want to do a selective sync again, when 
you click the Sync only selected folders radio button, the box will be empty, and you must 
manually add the folders for selective sync again.

Selective Sync Behavior when Centralized Configuration is set

When the Sync app behavior is controlled centrally by the administrator (through User Policy → Device 
Configuration settings in the admin portal), users of the Sync app cannot add or remove selective sync 
folders unless they are given permission to override central configuration.

When you switch from syncing all files to selected files, any existing files in your sync folder will not 
be removed automatically. If you want to remove them, you must remove them manually. This is to 
prevent accidental deletion of any user files.
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When a user tries to make any changes, the following message is displayed - "Centralized 
Configuration is being applied. Settings cannot be changed. Please contact your administrator for 
assistance."

Advanced Offline Sync mode

Some users want more granular control over which local folders are synced to which remote folders 
and in which direction.

There is an "advanced offline sync mode" in sync that allows control of such options.

To enable advanced mode: 

1. Exit Sync.

2. Open syncclientconfig.xml, at:

Operating System Path

Windows %APPDATA%\FileCloudSync\syncclientconfig.xml

Mac OSX {HomeDir}\FileCloudSync\syncclientconfig.xml

Linux {HomeDir}\FileCloudSync\syncclientconfig.xml 

3. Add the following entry:

    <rowentry>
        <name>advancedoffline</name>
        <type>bool</type>
        <value>1</value>
    </rowentry>

This is an advanced feature not meant for general use, please enable and use only if there is 
something specific that you need to accomplish.

For Local to Remote syncing to be effective, the Allow Users to Backup setting must be enabled in 
the admin portal. 
For admins, the Allow Users to Backup setting is located in in the admin portal at Settings > 
Endpoint Backup.
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4. Restart Sync.

To add a folder in advanced mode:

1. In the system tray, right click the Sync icon and choose Open.

2. In the mini-dashboard, click Dashboard.

3. In the navigation panel of the dashboard, click Offline Folders.

4. Click Add Folders.

The Add New Offline Folder dialog box opens.

5. In Remote Folder, select the location to sync to.

6. In Local Folder, select the location to sync from.
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7. In Schedule, select one of the following:

 Manual - Choose this to run Sync manually instead of automatically on a schedule.

 a sync frequency in minutes or hours - Choose one of these to specify how frequently Sync 
should run automatically.

 Choose a different schedule - Choose this to run Sync daily or on specified weekdays at a 
specific time. The following dialog box, where you can specify your custom schedule, 
opens:

8. In Mode, choose one of the following:

 Sync - 2 way sync mode. Files from local are uploaded to remote server. Remote changes 
are also synced to local.

 Local to Remote - One way sync, where only changes from local are synced to remote 
server. No changes are synced from remote to local. Note that files deleted locally are not 
deleted remotely. Note: 

 Remote to Local - One way sync, where only changes from remote are synced to local. No 
changes are synced from local to remote. 

9. Click Add Folder.
Now this location will start working in the advanced offline mode configured.
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Backing Up Files
In addition to syncing files automatically, you can also back up specific folders in your Windows, Mac 
or Linux Desktop to FileCloud for safekeeping.

Folders selected for backup are automatically backed up on a schedule selected by the user. 

Configure which files are backed up

Configure the backup schedule

View and restore backups

When advanced offline sync mode is enabled:

 The backup option is not available unless the Mode is set to Local to Remote.

 For remote to local syncing (Mode is set to Remote to Local), the modified dates of local 
folders are updated to the date of syncing, but the server folders keep their original modified 
dates. The modified dates of local files retain the value of their modified dates on the server.
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Selecting Files to Backup

The following procedure explains how to add or modify file and folder backup in Sync after you have 
logged in. To set up backup when you log in to Sync, see Step 4 Backup Folders.

To select the files you want backed up:

1. Launch FileCloud Sync by right-clicking on the icon in your system tray and then selecting Open.

2. In the mini-dashboard, click Dashboard.

3. In the navigation pane of the main dashboard, click Backups.

4. Click Add Folders.
The Select Folders dialog box opens.

Important Note: Backup must be enabled by your FileCloud administrator to allow you to back up 
your computer's files and folders. If your administrator has disabled backup, you will not see the 
Backup link in the navigation pane of the main dashboard.
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5. Expand the directory to the folder that you want to back up.

6. In Schedule, choose how often you want to back up the folder.

7. Check Email notification after backup completes if you want to be notified each time the folders 
in the directory are backed up.
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8. Click Add to Backups.
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The Select Directory dialog box closes and the folder is added for backing up.

Configure the Backup Schedule

By default, folders selected for backup are backed up every 30 minutes.

To change the schedule: 

1. Launch FileCloud Sync by right-clicking on the icon in your system tray and then selecting Open.

2. In the mini-dashboard, click Dashboard.

3. In the navigation pane of the main dashboard, click Backups.

4. Select a folder path in the box.
Below it, folder details including its schedule are displayed.

Important Note: Backup must be allowed by your FileCloud administrator. If your administrator has 
disabled backup, you will not have the option to set up backup.
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5. In Schedule, choose a new time interval or Manual or Custom (the last two options in the drop-
down list).
If you choose a new time interval, sync runs immediately after you save the setting, and at the 
specified interval from that time on.
If you choose Custom, the following dialog box opens.
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a. Set up your custom schedule. You can only choose one Start Time that the custom backup 
runs.

b. Click Save.

c. To run a backup now, click Run Now.

Viewing and Restoring Backups

Viewing Backups
Files on your computer are backed up to your FileCloud My Files/backups folder.

You can view the backups folder by opening FileCloud in your web browser and opening your My Files/
backups folder.

The backups folder includes a sub-folder for each device that is backed up to FileCloud. Each device 
folder includes a sub-folder for each folder backed up from that device.

Note that backed up files are included in the total storage allocated to you in FileCloud.
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Restore Backups
You can restore backups from the FileCloud server by downloading backed up files using the web 
portal, FileCloud Drive or the WebDAV app.

Old Versions of Files in Backup
When you edit and modify files that are being backed up, new versions will be uploaded to FileCloud, 
and it will create a new version of that file. So it is possible to roll back to a previous version.

Deleted Files and Folders in Backup
When files and folders are deleted in a folder that is backed up, they are not removed from the 
FileCloud backup folder. So if files or folders are deleted accidentally, the backup files are not 
removed. If you want to remove backed up files or folders you must delete them directly from the 
FileCloud web portal.

Globally Backing Up User Files and Folders

This topic is for use by admins.

You can configure Sync backup so that specific local paths on all users' computers and devices are 
backed up. This ensures that certain user content, including configuration files, is always backed up 
and easy to restore. 

Requirements:

 Endpoint Backup must be enabled for FileCloud Sync from the Admin Portal.

 FileCloud Sync must be installed on the users' computers and Remote Management must be 
enabled.

 The Sync users' policy in the Admin portal must include this custom device configuration for 
Sync.

To configure Sync to globally back up users' files and folders:

1. Enable Endpoint Backup for FileCloud Sync from the Admin Portal.

a. In the FileCloud admin portal's left navigation bar, scroll down and click Settings. Then, on 

the Settings navigation page, click Endpoint Backup  .
The Endpoint Backup settings page opens.

b. Enable the Allow Users To Backup option and click Save.
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2. Install FileCloud Sync and enable Remote Management
For the device configurations set up in policies to take effect, enable remote management in 
FileCloud Sync.

a. To enable remote management:
           either:

 Have users manually enable the Remote Management option in the FileCloud Sync 
App. They can either do this on the Get Started screen when they log in or in the 
Settings screen after they log in.
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Allow Remote Management in the Get Started screen.

Allow Remote Management in the Settings screen.

or:

 Enable the remote management setting for a mass deployment (set 
allowcentralmgmt to 1).  See Mass Deployment - Default Configuration Support for 
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help with the configuration. 
Mass deployment registry entries must be created before FileCloud Sync is initialized 
in the users' local machines or the configuration in the registry will not take effect.

 You may set a registry key to hide the Allow Remote Management and Remote 
Management settings in Sync so that users cannot disable remote management. 
See Device Configuration XML For Sync for instructions.

 

3. In the policy used by Sync users, set a default device configuration for FileCloud Sync.
For help creating the XML, see the Device Configuration XML documentation for Sync.

a. In the FileCloud admin portal's left navigation bar, scroll down and click Settings. Then, on 

the Settings navigation page, click Policies .
The Policies settings page opens.

b. Edit the policy assigned to the user or group.

c. Click the Device Confgiuration tab.
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d. Enter the configuration in XML format.

Below is a sample script to use:

<xml>
<cloudsync>
<allowuserconfigforbackup>0</allowuserconfigforbackup>
<offline_folder_count>7</offline_folder_count>
<offline_folder_1>C:\Users\${USER}\AppData\Roaming\Microsoft\Outlook|/$
{USERID}/backups/${USERID}/Outlook|1|30m|1|0|0</offline_folder_1>
<offline_folder_2>C:\Users\${USER}\Pictures|/${USERID}/backups/${USERID}/
Pictures|1|30m|1|0|0</offline_folder_2>
<offline_folder_3>C:\Users\${USER}\Desktop|/${USERID}/backups/${USERID}/
Desktop|1|30m|1|0|0</offline_folder_3>
<offline_folder_4>C:\Users\${USER}\Music|/${USERID}/backups/${USERID}/Music|1
|30m|1|0|0</offline_folder_4>
<offline_folder_5>C:\Users\${USER}\Favorites|/${USERID}/backups/${USERID}/
Favorites|1|30m|1|0|0</offline_folder_5>
<offline_folder_6>C:\Users\${USER}\AppData\Roaming\Microsoft\Templates|/$
{USERID}/backups/${USERID}/Office_Templates|1|30m|1|0|0</offline_folder_6>
<offline_folder_7>C:\Users\${USER}\Documents|/${USERID}/backups/${USERID}/
Documents|1|30m|1|0|0</offline_folder_7>
</cloudsync>
</xml>

Notice that the first parameter in Line 5 of the XML above is the local path of the user’s 
computer. The lines after it are the other local directories that need to be included in the 
Sync Backup.
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e. Save the configuration.
Now, the folders specified in the configuration settings will be backed up for all Sync users 
when a Sync backup runs.

Managing Files in File Explorer

You can use FileCloud Sync to synchronize your files with the FileCloud Server.

FileCloud Sync appears as a folder in a file explorer window in Windows Explorer or Mac OSX Finder. 
It's sub-folders are My Files, Network Folders, Team Folders, and Shared with Me.

Sync is an alternative to using the user portal to access files stored on the FileCloud Server. With Sync, 
the files are stored locally, and you work on them locally.

You may set a registry key to hide the Allow Remote Management and Remote 
Management settings in Sync so that users cannot disable remote management. See Device 
Configuration XML For Sync for instructions.

You may set a registry key to hide the Allow Remote Management and Remote 
Management settings in Sync so that users cannot disable remote management. See Device 
Configuration XML For Sync for instructions.

You may set a registry key to hide the Allow Remote Management and Remote 
Management settings in Sync so that users cannot disable remote management. See Device 
Configuration XML For Sync for instructions.

You may set a registry key to hide the Allow Remote Management and Remote 
Management settings in Sync so that users cannot disable remote management. See Device 
Configuration XML For Sync for instructions.

If you are using FileCloud Sync with Mac OSX, you must enable the FileCloudSync extension in your 
system to be able to view right-click options in explorer. See Mac OSX Finder Right-Click Extension
for help.
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In this section:

Browse My Sync Files

FileCloud Sync appears as a mapped drive in a file explorer window in Windows Explorer and Mac OSX 
Finder.

To open Sync in file explorer

1. In your system tray, right-click on the Sync icon and choose Open.

2. At the bottom of the mini-dashboard, click the folder icon.

Your Sync folder in file explorer opens. It has the same folders for My Files, Network Folders, 
and Shared with Me that appear in the FileCloud user portal.
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Navigate to files and sub-folders as you do for any other files and folders in your explorer 
window.

To view FileCloud options:

 Right-click on a file or folder and choose Show more options, then hover over FileCloud Sync to 
view the FileCloud options.

Sharing Files in Sync

File sharing allows you to provide public or private access to files stored in FileCloud and saved in your 
Sync folders.

While files can easily be shared by emailing them to someone, sharing files using Sync allows you to:

 Keep track of who you have shared a file with

 Add comments about the file

 Monitor file versions

 Control changes people make to the file or folder by setting a combination of permissions.

 Have an allocated amount of personal file storage in a common file system

You can share a file in many different ways. 
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To create a share or manage it, select the Share Link option from the right-click menu.

 If the file is already being shared, click the Share Link option to edit or manage the share.

The Share link window opens. By default, the share is private but no recipients are included. You 
can add recipients, or make the share public (allow anyone with the link to view the share), and 
send the link to the person or people you want to share it with.
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In this section:

Sharing Files Publicly in Sync
By default, file shares are private, and you can make them available to specific people. You can share a 
file so that anyone can access the file even if they don't have a FileCloud account. 

When you share a file:

 A Share link window opens to provide the link. By default the share is private.

 Under Share options you can change the share to Allow anyone with link.

 You can send the link in an email inviting users to access the share.

Create a public share:

In your system tray, right-click the Sync icon and choose Open.

1. At the bottom of the mini-dashboard, click the folder icon.
Your Sync folder in file explorer opens.
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2. Navigate to the file or folder you want to share, then right-click on it and choose Show More 
Options. In the next menu choose FileCloud Sync > Share Link.

The Share link dialog box opens. By default the share is private. 

3. Under Sharing permissions, click Allow anyone with link, Allow anyone with link and password, 
or, if it's available, Allow anyone with Secure Web Viewer Link and a password.

4. Change any of the other options under Share options. See Sync: Share options for files for 
information about these settings.

5. To copy the link, click the Copy Link icon at the top of the screen.
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Sharing Files Privately in Sync
When you share a file privately, you share it only with existing FileCloud users or groups, but you can 
invite a new user to create a FileCloud account and then access the share.

Sharing files privately:

 Provides more security than sharing files publicly.

 Is useful when you only have a small number of people you want to share with.

 Requires the user to log in with a FileCloud account to access the file on the User Portal.

Users have the following permission options in private shares:

Permission Description

Read permitted Read permission allows users to view, browse and download files. 
Removing read permission removes the user from the share completely.

Download permitted Download permission allows the user to download and save the file.

Share permitted Share permission allows the user to share your file with other users.
Share permission can be provided only if read and download permission are already 
provided.

To share files privately in Sync

The procedure for sharing a file privately from the Sync folder in content explorer is nearly identical to 
the procedure for sharing a file privately from the user portal, Only the first few steps for selecting the 
file and choosing to share it are different.

Initial steps for sharing a file from Sync:

1. In your system tray, right-click on the Sync icon and choose Open.

2. At the bottom of the the mini-dashboard, click the folder icon. 
Your Sync folder in file explorer opens.

3. Navigate to the file or folder you want to share, then right-click on it and choose Show More 
Options. In the next menu choose FileCloud Sync > Share Link.
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The Share link dialog box opens. By default, the file is shared privately.

4. Go to  Sharing Files Privately and continue from Step 2.

Sync: Share options for files
When you initially share a file or when you edit the share, you can add share options.

Note: To configure share options for a file that has already been shared, right-click a file in the Sync 
folder and choose Share FileCloud Link. 

Perform advanced share actions:

1. In your system tray, right-click on the Sync icon and choose Open.

2. At the bottom of the mini-dashboard, click the folder icon.
Your Sync folder in file explorer opens.

3. Navigate to the file or folder that you want to share, then right-click on it and choose Share 
FileCloud Link.

The Share link dialog box opens. By default the share is private.
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4. Click the icons beside the share link to perform basic actions on it.

 Click Copy Link to paste the link into a message or email.

 Click Open Link to view the shared file in the FileCloud user portal.

 Click Email Link to email the link to one or more users.

5. Change any of the values under Share Options, and click OK.                                                                
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Advanced 
option To change

Share Name Click the link, and enter a new name in Share Name. This is useful if you want to give the 
share a descriptive or memorable name.

Expires Click the link, and click Yes, then choose an expiration date in the date picker.

Max number 
of downloads

Click No Restrictions, and select Restricted to. In Max download allowed, enter the 
maximum number of downloads. This enables you to prevent excessive distribution of the 
file.

Send email 
notifications

Yes, by default. Notifies you when the recipients make changes to the share. Click Yes and 
select No to stop receiving these notifications.

Password 
(Public 
Shares only)

Click the link, and click Yes. You may use the automatically generated password or change it 
to a more descriptive or memorable one. Check Show Password to check what you've 
entered.
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Advanced 
option To change

Sharing 
permissions

Select an option:

 If you select Allow anyone with link, the share is public.
 If you select Allow anyone with link and password, the share is public, and users must 

enter a password to view it. When you choose this option, a password is automatically 
generated and listed, but you may change it.

 (Default) If you selected Allow selected users and/or groups, the share becomes 
private and you may add specific users and groups.

When available:
 If you choose Allow anyone with Secure Web Viewer Link and a password, the share is 

public, and users must view it using a password through a secure viewer. See Using the 
Secure Web Viewer for more information.
For help inviting users and groups and setting their permissions, see:
Sharing Files Privately
Public Share Options for Files
Private Share Options for Files

Lock and Unlock Files in Sync

You can set a lock to prevent other users from opening a file.

Locking tells other users that you are actively using that file.

When a file is locked, the following conditions apply:

 The owner of the lock has full access to that file and can modify it

 An Admin can always override a lock

 Users can download and view the locked file

 Users cannot modify the locked file

When you lock a file, all of the following clients will be subject to the lock restrictions:



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 99

 User Portal accessed from a web browser

 FileCloud Drive

 FileCloud Sync

 Mobile clients

 WebDAV

To lock a file:

1. In your system tray, right-click the Sync icon and choose Open.

2. In the mini-dashboard, click Open.
Your Sync folders open in file explorer.

3. Navigate to the file you want to lock, right-click it, and choose Show more options. Then choose 
FileCloud Sync > Lock file.

If you have checked Show Lock Status in Icon Overlay in Sync Settings, the red lock overlay icon 
appears on the file.

To unlock a file:

1. Right-click the file you want to unlock, and choose Show more options. Then choose select 
Unlock FileCloud File.
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The file is unlocked:

Lock and Unlock Folders in Sync

You can set a lock to prevent other users from opening a folder.

Locking tells other users that you are actively using that folder.

When a folder is locked, the following conditions apply:

 The owner of the lock has full access to that folder and can modify it

 An Admin can always override a lock

 Users can download and view the locked folder

 Users cannot modify the locked folder

When you lock a folder, all of the following clients will be subject to the lock restrictions:
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 User Portal accessed from a web browser

 FileCloud Drive

 FileCloud Sync

 Mobile clients

 WebDAV

To lock a folder:

1. In your system tray, right-click the Sync icon and choose Open.

2. In the mini-dashboard, click Open.
Your Sync folders in file explorer open.

3. Right-click the folder you want to lock, and choose Show more options. Then choose FileCloud 
Sync > Lock folder.

If you have checked Show Lock Status in Icon Overlay in Sync Settings, the red overlay icon 
appears on the folder.

To unlock a folder:
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1. Right-click the folder you want to unlock, and choose Show more options. Then choose 
FileCloud Sync > Unlock folder.

The folder is unlocked:

Create a Direct FileCloud Link in Sync

You can use this option to create a link to a share that can be accessed by users who are already part 
of the share.

The Direct Link option works only with items in the following folders:

 Shared with me

 Team Folders

When members of the share click the link, they are prompted to log in to FileCloud, and then they 
are taken directly to the selected folder or file.
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In the Shared With Me or Team Folders sections, you may create a link to a folder or a file to send to 
users in an existing share without creating a new share. 

When users click the link,  they are prompted to log in and then taken directly to the selected folder or 
file.

To create a direct link:

1. Navigate to the file or folder in Shared With Me or Team Folders.

2. Hover over the file or folder and click the Direct Link icon.

A Direct Link is Ready message pops up.

3. Click Copy Link.

4. Paste the link into an email or a file, and send it to users.

Limitation
For Team Folders, direct links to files in sub-folders that are created by users who have access to 
the parent folder and sub-folder will not work for users who only have access to the sub-folder, 
because the links will include the parent folder path, which does not exist in the file structure of 
those users.
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To create a direct link:

1. In your system tray, right-click the Sync icon and choose Open.

2. In the mini-dashboard, click Open.
Your file explorer opens and displays the Sync folders.

3. Open Team Folders or Shared with Me.

4. Navigate to the item, then right-click it and choose Show More Options. In the next menu 
choose FileCloud Sync > Create Direct FileCloud Link.

The direct link is created and copied to the clipboard. You can now paste it into an email or a 
file.

Performing file explorer actions on Sync files

You can perform most file explorer actions on Sync files and folders. Follow the same procedures you 
use to perform these actions on other files and folders in file explorer, and they are synced to the 
FileCloud server. They include:

 Creating a new folder in your Sync folders.
Sync records this as an upload when it syncs with the FileCloud server.

 Deleting a Sync file or folder.
Sync records this a deletion when it syncs with the FileCloud server.

 Editing a Sync file or folder.
Sync records this as an upload when it syncs with the FileCloud server.

 Moving a Sync file or folder within Sync folders.
Sync records this as a deletion and an upload when it syncs with the FileCloud server.

 Renaming a Sync file or folder.
Sync records this as a deletion and an upload when it syncs with the FileCloud server.
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Delete Files and Folders in Sync

When you are in your Sync folders in your file explorer, you can delete a file or folder from FileCloud by 
moving it from a Sync folder to a folder outside of your Sync folders. When the action is synced to 
FileCloud, it is recorded as a deletion.

In the example below, the file Agreement to Receive Electronic Communication is moved from a sub-
folder in the Sync My Files folder to the external folder Requisition.

When syncing occurs, the Agreement to Receive Electronic Communication file is logged as a 
deletion:
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You can also delete the file through the normal process of right-clicking on the file or folder within the 
Sync folders and choosing Delete.

Download a File in Sync

If you create a new file or folder in FileCloud, when Sync runs and the file is added to the local Sync 
folder, it is recorded as a download action in Sync.

For example, the file onlinecourses.txt is created in a user's My Files folder in the FileCloud user 
portal.
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Sync records the action as a download because it downloads the new file to the local Sync My Files 
folder.

Upload a File in Sync

How to upload files in Sync
Drag and drop files or folders into the Sync folders to upload them to FileCloud.
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Here, a user drags a file from an external folder and drops it into My Files:
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When FileCloud syncs, the action appears as an upload:

Restrictions on filenames and file extensions
Please note the following restrictions when uploading files to FileCloud:

 Files with the same name:

 If you upload a file with the same name and the same case as another file in the same 
folder, it overwrites the file.

 If you upload a file with the same name but a different case than another file in the same 
folder, you cannot upload the file and the File Operations window displays a file name 
conflict message.

 If you upload files with the same name but different file extensions, like myfile.doc and 
myfile.docx, they are treated as different files.

 FileCloud cannot upload files with leading spaces in the filename.

 By default, files with the extensions php, php5, phar, and phtml cannot be uploaded into 
FileCloud.

For Admins
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Work with Comments in Sync

You can add comments to a file, or see version information by viewing the properties.

To view properties:

1. Launch FileCloud Sync by right-clicking on the icon in your system tray, and then selecting File 
Browser.

2. A File Browser window opens, displaying the contents synchronized with FileCloud.

3. Right-click the item you want to view the properties for, and then select View FileCloud 
Properties.

4. Use the following instructions to manage File or Folder Comments.

Resolve conflicts in Sync

Resolve a conflict from the Sync directory in file explorer:

1. In your system tray, right-click on the Sync icon and choose Open.

 To specify which file extensions may be uploaded into FileCloud, see Managing File Extensions
and Restricting File Extensions.

 To restrict certain filenames from being uploaded into FileCloud, see Restricting File Names.
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2. In the mini-dashboard, click the Open Sync Folder icon.

File explorer opens and displays your Sync directory.

3. Open the folder in your Sync directory that contains the conflict file or folder.
A conflict file has a yellow warning icon over it and a name in conflict format in parentheses. It 
appears above or below the local version of the file.

4. Right-click on the conflict file, and choose FileCloud Sync > Resolve conflict.

A Resolve Conflict dialog box opens.
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5. If you want to check the content of either file before choosing which copy to save, click Open 
local or Open remote.

6. Select Use local modified file: (filename) to discard the server file and keep your modified local 
file.
or
select Use remote server file: (filename) to discard your modified local file and save the server 
file.

7. Click Resolve, and confirm your change.
The conflict file no longer appears.

View a file or folder's details in Sync

1. In your system tray, right-click on the Sync icon and choose Open.

2. At the bottom of the the mini-dashboard, click the folder icon. 
Your Sync folder in file explorer opens.

3. In your Sync folders, navigate to the file or folder.

4. Right-click the file or folder and choose Show More Options. In the next menu choose FileCloud 
Sync > View properties.

A Properties dialog box opens to the Details, Metadata, and Versions tabs.

5. To view file or folder details, remain on the Details tab.
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 If you are viewing details of a file, as in the image above, the filename and last modified 
date are shown at the top of the Details tab.

 Under Path the path of the file or folder is listed.

 Under Permissions, your permissions for the file or folder are listed.

6. To see information about a file's versions, click the Versions tab.
The tab lists details of each version of the file and includes a download arrow beside each 
version for downloading it.
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7. To see information about the files metadata, click the Metadata tab.
For information about working in the Metadata tab, see Work with Metadata in Sync.

Work with Metadata in Sync

You can view the metadata attributes for a file, or add an attribute if your administrator allows it.

To view or add metadata:

1. In your system tray, right-click the Sync icon and choose Open.

2. At the bottom of the the mini-dashboard, click the folder icon. In your Sync folders, navigate to 
the file or folder.

3. Right-click the file or folder and choose Show More Options. In the next menu choose FileCloud 
Sync > View properties.
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A Properties dialog box opens to the Details, Metadata, and Versions tabs.

4. Click the Metadata tab.
The metadata sets available for the file or folder are listed.

5. View and if you have permission, add or modify metadata values.
For more information about metadata in FileCloud, see Managing Metadata.
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Sync Icon Overlays

The FileCloud Sync app on Windows shows overlay icons on files and folders to indicate their sync 
status.

The overlay icons appear on all files and folders inside MyFiles, Network Shares, Team Folders, and 
Shared with Me.

The following icon overlays are currently supported.

Icon Status

No 
Icon

File or Folder is new and has not been synced to the sync server.

File or Folder has been synced to server and is up to date.

File has been modified and has not yet been synced to the server.

File is in conflict because changes have been made both in the server and locally. It needs to be 
resolved by the user.

File is in a lock state and the owner must release the lock for other users to update it.  The lock only 
appears if you have checked Show Lock Status in Icon Overlay in Sync Settings.
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Mac OSX Finder Right-Click Extension

Mac OSX Finder Right-Click Extension
To include right-click sharing options with FileCloud Sync on Mac OSX, you must enable FileCloud 
Sync extensions.

1. Open your MacOS settings, and go to System Preferences > Extensions. 

2. Search on extensions, and enable Finder Extensions for filecloudsync.

Now when you go to the Sync folder in the Finder, icons appear to the right of files and folders, 
and FileCloud Sync options appear in the right-click menu.
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Searching in Sync
Beginning with FileCloud Version 20.2, users are able to search for files in Sync using the desktop 
client.

How do I access the search window? 

1. In your system tray, right-click on the Sync icon and choose Open.

2. In the mini-dashboard, click Search.
The Search window opens. The current path is your local Sync folder.
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Basic and Advanced Search

Basic search view Advanced search view

Enter a search term. Searching begins 
automatically. The files and folders returned are 
listed in the lower portion of the Search window.

Check Include Folders to search folder names as 
well as file names.

Click Advanced Options in the Basic search to view the 
Advanced Options fields. Choose any of the advanced 
options:

 All, Name Only, Content Only,or Metadata
 Date range
 Filter by size (check the box, then enter a size 

range)

Click Update to begin the search. The results appear in 
Basic search view.
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Accessing items after searching

Access a file after searching:

1. In the Search window, right-click the file.

2. To open the file in an application, click Open File.

3. To view the file listing in the Sync folder, click Open Folder.

4. To view the file listing in FileCloud, click Open Website.
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Access a folder after searching:

1. In the Search window, right-click the folder.

2. To view the folder in the Sync folder, click Open Folder.

3. To view the folder in FileCloud, click Open Website.

Also see:
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Changing the Sync search path

You can change the search path without leaving the Search window.

To change the search path from the Search window:

1. Click the folder icon next to the search box.

All Paths opens:

2. Click the arrow to expand All Paths, and navigate to the folder you want to search.
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3. Click the folder.
The Search window displays the new path:

 

Content Search in Sync

Content search enables you to search through the text in file types such as txt, pdf, doc, docx, xls, xlsx, 
ppt, and pptx.

Note that your admin must have configured content search in FileCloud for content searches to work.

Any files with matches are displayed with the link Show Content Hit below them.

To search in content:
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1. Access the Search window in Sync.

2. Click Advanced Options.
Advanced options appear.

3. In the drop-down list, choose Content Only.

4. Enter a search term.

5. Click Update.
The Search window displays the results with the link Show Content Hit below each result.
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6. Hover your cursor over Show Content Hit to view the text containing the search term:
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Metadata Search in Sync

You can search on metadata from any of the metadata sets in Sync.

To search on metadata:

1. Access the Search window in Sync.

2. Click Advanced Options.
Advanced options appear.

3. In the drop-down list, choose Metadata.

A Conditions defined field appears.

4. To define conditions, click + to the right of the field.
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A Generate Metadata Conditions window opens. Add search conditions in this window.

5. In the drop-down list, choose a metadata type.
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A drop-down list of the metadata type's attributes appears below it.

6. Choose an attribute.
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A field for the attribute value appears below it.
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7. Enter a value in the attribute field, and click Add.
The value is case-sensitive.

8. Add any number of additional conditions, and click Apply.
The search results are returned.
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Refreshing Sync
Users can refresh Sync from the Sync dashboard. Admins can refresh Sync for a particular user or 
users from the Device Management screen by entering a command.

For users: Refresh Sync from the dashboard

1. To open the mini-dashboard, In your system tray, right-click on the Sync icon and choose Open.

2. To open the main dashboard, in the mini-dashboard, click Dashboard.

3. In the navigation panel, click Help.

4. Click Full Sync Now.

Files and folders are immediately re-synced.
Refresh Sync Complete appears at the bottom of the dashboard.

For admins: Refresh Sync from the admin portal
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1. Log in to the admin portal, and in the navigation panel, click Devices.

2. In the Manage Devices screen, select the check boxes of the Sync devices to refresh.

3. In the upper-right corner of the screen, click Command.

The Send Config Command dialog box opens.

4. Enter the following xml:
<cloudsync><refreshsync>1</refreshsync></cloudsync>

This command only works correctly when run in the Manage Devices screen, as shown in this 
procedure.  Do not use it by entering it into the Device Configuration tab of a policy, as this will 
cause the command to run and refresh Sync every 5 minutes.
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5. Click Send.

View or Clear Log Messages in Sync
You can view log messages to troubleshoot Sync issues, or clear the log if the file is getting too large.

To view log messages:

1. In your system tray, right-click the Sync icon and choose Open.

2. In the mini-dashboard, click Dashboard.

3. In the navigation pane of the dashboard, click Activity.
The Sync Activity page opens. By default, View is set to All, and all Sync activities are listed.

Full Sync now and Reset (from the username drop-down list) are two different actions. Full Sync 
now clears your sync database and performs a new Sync without clearing your Sync configuration. 
Reset clears your configuration (the folders you have set up to sync) and also clears your sync 
database.

Note: Clicking Sync Now in the main dashboard or mini dashboard, performs an immediate sync of 
any changes so you don't have to wait for the automatic sync to run. It neither clears your Sync 
database nor clears your Sync configuration. 
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4. To view only certain types of log files, choose from the options in the View drop-down list.
The full list of options in the View drop-down list is:

 All

 Uploaded

 Downloaded

 Errors - You can resolve errors in this view. See Resolve conflicts in Sync.

 Skipped (All) 

 Skipped (My Files)

 Skipped (Network Folders)

 Skipped (Backup Folders)

 Skipped (Root Folder)
Note: For more information about skipped files, see Reviewing Skipped Files.

5. To search for a file in your current view, enter a string into the search bar.

To export activities:

 To export a spreadsheet file of the list of files in your current view, click Export.

To clear the log file:

1. On the Activity screen, click Clear Activities.
This clears all entries from the log, not just the entries for the current view.

Updating a Changed Password in Sync
If your password is updated outside of Sync while you are working in Sync, a message tells you that 
you must enter the changed password. 

To update to the changed password so you can continue working in Sync:

1. When the following message pops up, click on the text:
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The following screen opens:

2. Enter the changed password into Password and click Save.
A message that Sync has saved the password and is validating it appears.

3. Continue working in Sync.

Using DocIQ with Office for Sync Users

The Password field on the Account Settings screen cannot be used to change your password 
from Sync; you can only use it to update your password in Sync after it has been changed 
outside of Sync.

New FileCloud Sync users: DocIQ has been replaced with FileCloud for Office. Please see 
the FileCloud for Office with Sync documentation.

Current FileCloud Sync users (DocIQ users): FileCloud no longer supports DocIQ. Later this year, 
DocIQ will be fully deprecated. Although you can continue to use DocIQ with the current release, we 
recommend using FileCloud for Office, which can be downloaded from the Office add-ins store. Now, 
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DocIQ is a Microsoft Office add-in for FileCloud Sync and FileCloud Drive clients. 

DocIQ works with the following Microsoft Office applications:

 Word 
 Excel
 PowerPoint

What does DocIQ do?

DocIQ works with Office documents to help you manage shared files.

DocIQ gives you the ability to:

 manage file locking
 collaborate with your colleagues through comments 
 see how shared files are being managed 

How do I use DocIQ?

1. You open an Office application such as Word, Excel or 
PowerPoint.

2. Inside the Office application, you open a file saved to a 
FileCloud Sync or FileCloud Drive folder.

3.  DocIQ displays as a task panel inside the Office application 
with the following information:

 File details

 Lock status

 File sharing details

 Comments attached to the file

How do I install and work with DocIQ?

1. Install DocIQ with Sync.
2. Configure DocIQ for Sync.
3. Work with file locking.
4. Troubleshoot Doc IQ issues.

Install DocIQ with Sync

when you upgrade FileCloud Sync, you are given the choice of using FileCloud for Office or 
continuing to use DocIQ. If you choose to use FileCloud for Office, please see the FileCloud for 
Office with Sync documentation.

For users who begin using FileCloud in version 23.1 or users who have not used DocIQ previously: 
You will not see an option to install DocIQ when you install or upgrade FileCloud Sync. Instead, you 
will be given the option of installing FileCloud for Office.

Current FileCloud Sync users (DocIQ users): Later this year, DocIQ will be deprecated, and FileCloud 
will no longer support it. Although you can continue to use DocIQ, we recommend using FileCloud for 
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DocIQ allows you to easily manage FileCloud options for a file directly in Microsoft Office applications.

To install DocIQ, you just need to update your FileCloud Sync software to the latest version.

Install FileCloud Sync

FAQ's
Do I need to do anything before installing it?

It's easy! Just make sure you have this:

 Microsoft Office - Version 2007 or later for Windows 

DocIQ does not support Microsoft Office for Mac OS. If you are a macOS user, install FileCloud for 
Office (FFO).

How do I continue to use it?

You may continue to use DocIQ when you update the FileCloud Sync Client.
When you reach this screen in the setup wizard, choose Continue using DocIQ.

Install FileCloud Sync

Office, which can be downloaded from the Office add-ins store. Now, when you upgrade FileCloud 
Sync, you are given the choice of using FileCloud for Office or continuing to use DocIQ. If you choose 
to use FileCloud for Office, please see the Using FileCloud for Office with Sync documentation.
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Where is DocIQ installed on my computer?

DocIQ is installed in the following folder:

program files(x86) / DocIQ

Configure DocIQ for Sync

DocIQ gets all configuration information from FileCloud Sync and Drive.

For example, when a file is opened from Sync, DocIQ will know which FileCloud account you are using.

 This allows DocIQ to show you information about the file that is uploaded to the FileCloud Server 
site in the Office application.

There are a few properties that can be configured in Sync and Drive for DocIQ:

Option Description How to Configure

Enable or Disable 
DocIQ Integration

This option removes the DocIQ panel 
that is shown in a Microsoft Office 
application after DocIQ is installed 
and enabled.

This option is useful if you only need 
to disable DocIQ for a short time while 
troubleshooting computer issues.

This option does not permanently 
remove DocIQ. To remove DocIQ, you 
have the following options:

 uninstall Sync or Drive
 use the Windows Programs 

Control Panel to remove DocIQ

1. In your system tray, right-click on the 
Sync icon and choose Open.

2. At the bottom of the mini-dashboard, 
click Settings.
The Settings page opens in the main 
dashboard.

3. Beside Miscellaneous, disable DocIQ by 
unchecking DocIQ Office integration.

4. To enable DocIQ again, check DocIQ 
Office integration.

This configuration can be set in the admin 
portal (via centralized device configuration) 
using the following command:

<cloudsync>
<officehelperdisabled>0</
officehelperdisabled>
</cloudsync>

Setting this value to 0 will enable DocIQ 
automatically, and setting it to 1 will disable 
DocIQ automatically.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 140

Automatically 
enable Lock on file 
open

This creates the following scenario:

 When a supported file from Sync 
or Drive is opened

 DocIQ will automatically attempt 
to lock the file, with read allowed 
status.

1. In your system tray, right-click on the 
Sync icon and choose Open.

2. At the bottom of the mini-dashboard, 
click Settings.
The Settings page opens in the main 
dashboard.

3. Beside Miscellaneous, disable 
automatic locking in DocIQ by 
unchecking Automatic locking in 
DocIQ.

4. To enable automatic locking in DocIQ 
again, check Automatic locking in 
DocIQ.

This configuration can be set in the admin 
portal (via centralized device configuration) 
using the following command:

<cloudsync>
<officehelperlockonedit>1</
officehelperlockonedit>
</cloudsync>

Setting this value to 1 will enable locking 
automatically, and setting it to 0 will disable 
locking automatically.

Work with DocIQ File Locking in Sync

You can use file locking to:

 See if you have the file locked for editing

 Easily turn locking on and off

 Prevent or enable downloads of this file

Locking is critical for shared files, since another user can also open the file and make changes.

 When one user opens a file, DocIQ automatically locks the file for editing. 

 The lock is shown right in the Office application you are using to edit the file.

FAQ's

How do I know the status of a lock?

To see the lock status:

1. In a Microsoft Office application, open a file saved to your Sync folder.

2. In the DocIQ panel, under the file name, location, and date information, you can see the lock 
status.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 141

File is not locked when:

 Lock is OFF

File is locked (read allowed) when:

 
 Lock is ON
 Prevent Download is OFF



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 142

File is locked (read blocked) when:

 Lock is ON
 Prevent Download is ON

 

The following table describes what each lock status means and how it impacts what you can do with 
the file and others you have shared it with.

Lock Status Access by lock owner Access by others

File is locked (read 
allowed)

Read and Modification allowed Only read is allowed, no modification is 
allowed

File is locked (read 
blocked)

Read and Modification allowed No Read and Modification is allowed

File is not locked Read and Modification allowed Read and Modification allowed

When does the lock status change?

In the following scenario:

 When a supported file from Sync or Drive is opened

 When automatic lock on an open file is enabled

DocIQ will automatically attempt to lock the file, with read allowed status.

For a file with a Read Blocked status:

If USER1 has locked (read blocked) the file:

 FileCloud Sync will not download the file for USER2

However, if USER2 has already downloaded the file, then:
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 FileCloud Sync will allow DocIQ to open the file

 FileCloud Drive will not allow the file to be opened by USER2, unless Drive has already cached 
the file

You can use the following table to understand the status of lock:

Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

An unlocked file is 
opened by USER1

File is not locked File is locked (read 
allowed) by USER1

File is not 
locked

An unlocked file is 
opened by USER1

File is not locked File is not locked File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is Locked 
(Read 
Blocked) by 
USER1
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 Note that you cannot enable Prevent Download unless DocIQ Lock is also enabled.

How can I prevent another using from downloading a file I am working on?

When you lock a file, you can block other users from reading the file by enabling Prevent download.

 Note that you can not enable Prevent Download unless DocIQ Lock is also enabled.

If another user, USER2, attempts to download the file, USER2 will see the following conditions:

 The file cannot be downloaded from the FileCloud User Portal

 FileCloud Sync will not download the file that is locked and read-blocked.

 FileCloud Drive will not open the file that is locked and read-blocked.

 DocIQ will open the file from a Sync path when file is already available in the Sync client 
(previously downloaded).

 DocIQ will open the file from a Drive path when the Drive client allows a file to be opened.

Troubleshoot DocIQ in Sync

DocIQ is very straightforward to install, configure, and use.

If you encounter issues, try using these troubleshooting tips.

Tips for general issues

Review the DocIQ Log files

DocIQ logs are found in %appdata%/DocIQ/data/DocIQaddin.log

 

DocIQ is not diplayed in your Office app

Check if DocIQ office integration is enabled in Sync/Drive Path:
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1. Check if the file you opened is in a Sync or Drive folder

2. Reconnect to Drive or Sync.

a. From the System Tray, right-click the FileCloud icon, and select Exit; then start Sync again.

3. In an Office application, such as Word, open File Options

a. From the menu, select File, then Options.

a. In Add-ins, under Active Application Add-ins verify that FileCloud DocIQ is listed.

 

 

DocIQ cannot get file details

Check if file is available in FileCloud by logging into the FileCloud User Portal.

Logging in to the User Portal

 

To temporarily disable DocIQ to troubleshoot other computer issues, you can

Configure DocIQ for Sync

 

If you need to, you can uninstall DocIQ in the following ways:
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From the Windows Control Panel

1. Next to the Start button (

), in the search box, type Control Panel.

2. From the results, select Control Panel.

3. Select Programs and Features, and then select DocIQ.

4. At the top of the list, next to Organize, click Uninstall.

Uninstall the Sync application

DocIQ will be uninstalled when Sync application is uninstalled.

1. Next to the Start button (

), in the search box, type Control Panel.

2. From the results, select Control Panel.

3. Select Programs and Features, and then select FileCloudSync.

4. At the top of the list, next to Organize, click Uninstall.

Uninstall the Drive application

DocIQ will be uninstalled when Drive application is uninstalled.

1. Next to the Start button (

), in the search box, type Control Panel.

2. From the results, select Control Panel.

3. Select Programs and Features, and then select FileCloudDrive.

4. At the top of the list, next to Organize, click Uninstall.

 

Using FileCloud for Office with Sync

FileCloud for Office is an MS Office add-in for Word, Excel, and PowerPoint which can be used in 
both Windows and macOS with FileCloud Sync, FileCloud Drive, and FileCloud Desktop. It is available 
in FileCloud beginning with version 23.1.
For instructions on how to install FileCloud for Office, see Using FileCloud for Office.
If you have been using FileCloud Sync with DocIQ, see the instructions for previous users of DocIQ at 
the bottom of this page.
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Before using FileCloud for Office with Sync

The first time you install Sync or upgrade Sync to use FileCloud for Office you must:

 Confirm that you trust FileCloud for Office and enable it as shown in the following procedure.

To confirm that you trust FileCloud for Office:

1. After you log in to FileCloud Sync, click the Settings tab.

2. Click the Trust FFO button.

The Trust FFO button disappears, and the checkboxes for FFO Office integration and Automatic 
locking in FFO are automatically checked:

FileCloud for Office is now enabled in Sync, but to use it in Office files, you must include the add-
in in each type of Office file (Word, Excel, and PowerPoint) in your FileCloud Sync directory.

Note: To use FileCloud for Office without the automatic locking feature, uncheck Automatic 
locking in FFO.

Working with FileCloud for Office in Sync

The FileCloud for Office task panel displays information about a file and enables you to:
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 Lock or unlock a file.

 Prevent or allow download of a file while locked.

 Share a file.

 Manage file versions, and view file details and metadata.

Lock or unlock a file
Locking and unlocking files

You can use the file locking function in FileCloud for Office to:

 See if you have a file locked for editing

 Turn a file lock on or off

 Prevent or enable downloads of a locked file

If a shared file is not locked when you open it for edit, another user can also open the file and make 
changes.
To avoid this, by default, FileCloud for Office automatically locks files for editing when they are 
opened.
When you open an Office file in your client directory, the FileCloud for Office panel shows File is 
locked, and by default, users are allowed to download or read the file (Prevent download is disabled).

 To prevent other users from downloading or reading the file while it is locked, click the Prevent 
download slider.
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 To unlock the file while you have it opened for edit, click Unlock. Now other users can modify as 
well as view and download the file.
Note: Prevent download cannot be enabled when the file is unlocked.
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The following table describes what each lock status means and how it impacts what you and others 
you have shared the file with can do with the file.

Lock Status Access by lock owner Access by others

File is locked (download 
allowed)

Read and modification 
allowed

Only read is allowed, no modification is 
allowed

File is locked (download 
prevented)

Read and modification 
allowed

Neither read nor modification is allowed

File is not locked Read and modification 
allowed

Read and modification allowed

For a locked file with download (read) prevented:
If USER1 has locked (and read blocked) the file:
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You can use the following table to understand the status of lock:

 The FileCloud client will not download the file for USER2

However, if USER2 has already downloaded the file in Sync or Drive, then:

 FileCloud Sync will allow FileCloud for Office to open the file.

 FileCloud Drive will not allow the file to be opened by USER2, unless Drive has already cached 
the file.

If an admin prevents file locking after a user has locked a file in a client:

 The lock is automatically removed from the file

 Additional files cannot be locked using FileCloud for Office, and when you attempt to lock a file, 
an error message similar to the following appears:

If you are an admin and want to disable locking, see Managing User Locks.
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Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

An unlocked file is 
opened by USER1

File is not locked File is locked (read 
allowed) by USER1

File is not 
locked

An unlocked file is 
opened by USER1

File is not locked File is not locked File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is Locked 
(Read 
Blocked) by 
USER1

Share a file
Sharing a file

To share a file or folder that is opened with FileCloud for Office:
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1. In the FileCloud for Office panel, click Create.

A Share Link screen that is nearly identical to the one in the user portal opens:
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2. Share the file using the same settings and options that you would for a share in the user portal. 
See Sharing Files and Folders for help.
Note: The option for downloading the share QR code, which is available for shares created from 
the user portal, is not available for shares created in FileCloud for Office.
After you have shared the file, the FileCloud for Office panel displays details of the share:

3. Click Manage to change the options or permissions in the share.

Download versions, view details and metadata
Downloading versions, viewing details, viewing metadata

Versions
To view a file's version information in FileCloud for Office:

1. At the bottom of the FileCloud for Office panel, click the + across from Versions.
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The expanded Versions section shows you version information about the file.
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To download file versions in FileCloud for Office:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.
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2. Click Download for the version that you want to download, and save it.

Details
To view file details:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.

2. Click the Details tab.
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The details shown are the filename and type, the last modified date, the path of the file in 
FileCloud, and your permissions for the file.

Metadata
To view metadata information for the file:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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2. The Properties dialog box opens to the Versions tab.

3. Click the Metadata tab.
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Each metadata set applied to the file is listed with the values for its fields. 

FileCloud for Office log locations

Locating FFO logs

The locations of log files for FileCloud for Office in Windows and macOS are the following:

Windows: %appdata%/FFOServer

macOS:  /Users/[USERNAME]/Library/Preferences/FFOServer

View and add comments

Viewing and adding comments

Comments added to files and folders in FileCloud for Office also appear in the user portal and any of 
the other client apps.

To view and add comments in FileCloud for Office:

1. If Comments is not visible in the FileCloud for Office panel, scroll down to the bottom of the 
panel.

2. Click the + across from Comments.
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Any existing comments added to the file or folder here or anywhere else in FileCloud appear 
above the Comments box.
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3. To add a new comment, click inside the Comments box and enter the comment.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 165

4. Click Add comment.
The comment is added.
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For previous users of DocIQ

If you have never used FileCloud Sync with DocIQ before, the installer will automatically configure Sync 
for use with FileCloud for Office, and this section does not apply to you.

If you have previously been using FileCloud Sync with DocIQ, when you run the FileCloud Sync installer, 
the first screen of the wizard introduces you to FileCloud for Office:
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The installer prompts you to choose whether you want to continue using DocIQ or switch to FileCloud 
for Office (DocIQ will be deprecated in the future).



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Sync – 168

 
Choose whether you want to use FileCloud for Office or DocIQ. If you choose FileCloud for Office, you 
are also required to install an add-in.
The installer configures your Sync installation to function with the option you have chosen. 

Sync Troubleshooting Guide
The FileCloud Sync client  ensures that the content of your local files is exactly the same as the same 
files on the FileCloud server.  

But, because of the wide variety of local computer environments and network and server 
configurations, there may be occasional issues when synchronization occurs. 

You can troubleshoot synchronization issues by understanding how sync works and taking steps to 
resolve specific issues.
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Files that don't sync

Under the following conditions, FileCloud sync client might be unable to sync files to or from your 
FileCloud installations.

Long Filenames or Paths
Windows Operating Systems only allow files and folder names of around 260 characters or less. So 
paths longer than those are not synced. If the entire file path and name exceed 260 characters, 
shorten the name or move the file or folder to a higher-level folder within your FileCloud. 
Note: This is a limitation of Windows explorer, not a limitation of FileCloud Sync.

Names Ending with "." or ","
Files and folders ending with these characters will cause an error. The files must be renamed.

Special Characters
FileCloud Sync doesn't sync some files with characters that are incompatible with some operating 
systems. 

Rename them to something more suitable for use across multiple operating systems.

The following files will also not be synchronized:

 The * character

 The < character

 The > character

 The : character

 The \ character

 The / character

 The | character

 The ? character

 The * character

 The ~ character

 tonido.db

 Thumbs.db

 desktop.ini

 Anything ending with .tmp

 Anything ending with .lnk
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Change Sync Folder Location

The FileCloud Sync app stores synchronized files at the following default locations:

 Windows: C:\users\<user>\Documents\FileCloud

 Mac OSX: {HomeDir}\FileCloud

 Linux: {HomeDir}\FileCloud

To change the Sync folder location:

1. In your system tray, right-click the Sync icon, and choose Open.
The mini-dashboard opens. 

2. At the bottom of the mini-dashboard, click Settings
The main dashboard opens to the Settings screen.

3. Across from Sync Folder Location, click Change.

 Files or Folders ending with space

 .tonidocache

 Folders with the name .cache

 Anything starting with Conflict_

 sync.ico

 .ds_store (starting with 4.71 version of Sync Client)

 Any hidden files (usually files starting with . in Linux and files with hidden attribute in windows)

 File names and file extensions which are restricted by the server admin

 Files that are in use

Beginning in Version 19.1, FileCloud supports overriding file type restrictions. To allow users to sync 
file types such as lnk, ini and thumbs.db, as well as hidden files, use the allowedfilelist option on 
page XML Options for Sync. 

Sync only detects changes when the file size changes. If the file size does not change, then the file 
modification is not detected by sync.
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Your content explorer opens.

4. Choose a new Sync folder.
At the bottom of the Settings screen, the message Changes Saved. Restart Sync to apply the 
changes is shown.

5. Restart Sync.

Sync Logs

If the FileCloud Sync client stops working, you might need to send Sync data logs to Technical 
Support, so they can help address the issue.

To access log files:

1. In your system tray, right-click the Sync icon and click Open.

2. In the mini-dashboard, click Dashboard. 

3. In the main dashboard, click  Help.
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 To get the most recent log file, click Export Sync Log File.

 To get all the log files, click Open Log Folder.
The folder where the synclient.log files are located opens. Sometimes there are multiple 
syncclient.log files numbered syncclient.log.0, syncclient.log.1, etc. You can copy them all to a 
zip file and send it via email to support.

Sync Engine Types

FileCloud Sync has two types of synchronization engines.

 A real-time synchronization engine 
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 A periodic synchronization engine

Real-time Synchronization 
Real-time synchronization synchronizes files as they change locally and with minimum delay from the 
server.  You can initiate a sync immediately using the Sync Now option. Real-time synchronization 
works for all files inside Managed Storage (My Files and Shared with Me) .

Periodic Synchronization 
Periodic synchronization synchronizes files on a specified time interval starting at every 30 minutes, 1 
hour, etc, depending on your setting in Sync Frequency in the Settings screen of the main 
dashboard.  Backing up files from your local computer to your remote server is also a form of periodic 
synchronization.

Real-time Synchronization Periodic Synchronization

Local Change 
Upload 
Frequency

Uploads local changes as soon as a local file 
changes.

Uploads changes after specific 
intervals.

Remote 
Change 
Download 
Frequency

Default is every 2 minutes; can be changed by 
changing the Sync Frequency in the Settings screen
of the main dashboard.

Downloads changes after specific 
intervals.

Type of 
Remote 
Storage

Managed Storage (My Files and Shared with Me)  Local to remote backup, 

Initial Setup Folders under My Files and Shared Folders with 
Sync permissions are automatically downloaded.

User manually chooses folders to 
download and sync.

Limits  Managed Files (no limit, tested up to 300,000 
files).

Efficient up to 500-1000 folders. 
The more folders, the longer it takes 
to synchronize.

View Sync Error Details

View errors from the Sync Activity screen

To view details about an error from the Sync Activity screen:

1. In the system tray, right-click the Sync icon and choose Open.
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2. In the mini-dashboard, click Dashboard.

3. In the main dashboard, click Activity.
The Sync Activity screen opens.

4. In the View drop-down list, choose Errors.
The screen lists activities that resulted in errors along with the location of the error.

5. To access options for managing the conflict, click the three dots next to the error description. 

6. To resolve file conflicts, see Managing Sync Conflicts.

Sync Errors: Causes and Resolutions

Because of the wide variety of local computer environments and the many network and server 
configurations, there can sometimes be issues when synchronization occurs. 

  Click an issue in the following list to read more about it.

Shared with Me Folder is not syncing

Cause

The shared folder must have permissions set in order for you to sync with it.

Resolution

Make sure the shared folder has Sync permissions enabled.

Private Share Permissions for Folders

Team Folders are not synchronizing

Cause

FileCloud treats Team Folders in the same way as Managed Storage.

 If one file fails to synchronize because it is locked, the sync operation is cancelled, and no files 
in Team Folders are synced.. 

Resolution
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Verify that none of the files on the server that you are trying to sync are locked.

Initial sync is taking too long

Cause

When starting up for the first time on a new computer, Sync:

1. Downloads all the files from the FileCloud server; and

2. Stores the files in the temporary Sync cache folder; and

3. Copies the files into the Sync folder.

If there are a large number of files and data on the FileCloud server, initially downloading the files will 
take a long time.

 Subsequent file synchronization will be faster.

Resolution

 At the top of the mini-dashboard or the main dashboard (in the Dashboard screen) confirm that you 
see the message Sync is ON, which indicates that Sync is enabled. 
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 In the main dashboard, on the Activity screen, in the View drop-down list, choose Errors.

If there are errors, please find the description of the error type on this page.

Download Sync Error

Cause

After downloading files, Sync finds an inconsistency with the downloaded file from the server. This 
could be due to several factors:

 An interruption in the download

 A temporary interruption in network availability

 A problem with the file on the server

Resolution

 Download the same file via the web browser and see if it downloads correctly.

 Note the size of the file. Does the size match the size displayed in the web browser listing? 

 If the size matches then there could be a transient network condition. Try syncing the files 
again.  

 If the file size doesn't match then there is something wrong with storage. Please contact 
FileCloud support.

Upload Sync Error

Cause

Sync is unable to upload a file back to the server.

Resolution

 Try uploading the same file to the same location using the web browser.

 If the upload fails, then note the error.

 The problem could be that the location you are trying to upload to has no permissions or that 
there is an issue with a server configuration or the environment.

 Check with your administrator to see if the server has sufficient disk space in the drive FileCloud 
is installed on.

 Check the file name for any special characters that could make the upload fail.

 If this is the issue, try renaming the file and see if the upload works.
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File Overlays not appearing on Windows

Cause

The computer requires a reboot after installation.

Resolution

 Check if Windows Explorer integration was installed and the PC was rebooted.

Some files are not syncing

Cause

FileCloud restricts the use of certain special characters in file names. If a file contains one of these 
characters it is not synchronized.

..

\

/

:

*

?

"

<

>

|

FileCloud allows an administrator to restrict certain types of files for security reasons.

Resolution

 Check the full list of special characters that don't get synchronized.

 Check if the file has an extension that is disallowed for Sync by server.

 For example, by default, PHP, PHP5 file extensions don't get synced.

 You can change the allowed file types on the server and restart the sync

Sync is looping continuously on some folders

Cause

If you try to share a folder that contains other folders already being shared, Sync might continuously 
try to sync those folders.

For example:

 You share /SHARED/john/toplevel

 And a sub-folder inside the toplevel folder is also being shared /SHARED/john/toplevel/subfolder
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Resolution

Check if there is a share set up for a top folder and one of its sub-folders, both of which have sync 
permissions. 

 Only sync the top-level folder, which will also cause the sub-folder to be synchronized. 

File changes are not uploading

Cause

Sync uses file sizes to detect file changes and then upload them. Some file formats like XLS don't 
change the file size when content is changed so these files might not be uploaded.

Resolution

 Try changing to XLSX format if possible

 Use the optional parameters to detect changes using file checksums or modified timestamps 
(or both). See: Document Life Cycle Metadata in Working With Built-In Metadata

Number of synced files and sizes don't match Mac OSX Finder

Cause

Finder includes files and folders in the total list of items so that number will be different from the 
number of files reported in Sync.
Also .DS_Store files are not synced by sync app, so those files will not be synced.

A = 'find . -type f | wc -l'
B = 'find . -type f -name ".DS_Store" | wc -l'

Number of files in sync will match A - B

Finally, the size reported by Finder uses a different way of calculating GB size vs FileCloud.

Windows uses the standard GB while Macs use a GB = 1,000,000,000 bytes.

No error is shown when a user copies/pastes a file/folder into the parent folder

Filecloud Sync does not show an error every time a user copies and then pastes a file or folder into a 
read-only parent folder. In FileCloud Drive, the same action displays an error that the parent folder is 
read-only. The user can be confused when no error is shown in FileCloud Sync but is shown in Drive.

Cause: In FileCloud Sync, these errors are shown every 3 hours only.

 The user will see the message: Skipping top level files or folders that are not inside a sync-able 
folder

 The message is displayed in the Activity log and also as a pop-up notification

 Only the name of the very first folder or file that cannot be synchronized is displayed in the 
Activity log and pop-up (Instead of every file and folder name)
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FileCloud Drive

You can use FileCloud Drive to store, access, and share files to collaborate with the people you work 
with or share data with.

 FileCloud Drive is a client application that allows you to access FileCloud and the files you store 
there.

 You can access files in Drive in the same way you access them on a Windows PC in Windows 
Explorer.

 The same features that are available on the User Portal are available in Drive.

 Drive allows you to easily open the User Portal.

 You can access Drive files from Microsoft applications. 

This section describes how to use Drive on a Windows computer; however, you can also use Drive on a 
Mac with FileCloud Drive for Mac.

What is FileCloud Drive?
FileCloud Drive allows you to access files in FileCloud the same way you access them in Windows.

If you are used to working with Windows File Explorer, you may think that changing to a Web-based UI 
will reduce your efficiency. Traditionally, with a Web-based UI, you must open the website to download 
files, then modify them in their application, and then open the website again to upload them back to 
the Web UI.  This effort is eliminated when you work through FileCloud Drive. You can actually edit files 
the same way you edit them in Windows because the files (and folders) appear virtually in File Explorer 
and are directly accessible.

FileCloud Drive versions below 22.1 do not support MacOS Ventura. If you are using MacOS Ventura, 
please install or upgrade to FileCloud Drive 22.1.

FileCloud Drive now supports Big Sur Version 11.3 and higher running on Apple Silicon. However, a 
change to your security settings is required. See FileCloud Drive: Configuration for Big Sur Running 
on Apple Silicon.
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This is how our files are accessible in the FileCloud Server application.  

When you open one of your Drive folders, the same contents that appear in the FileCloud user portal 
are listed. Files are cached when they are initially accessed (either by the system during download or 
by you when you initially open them).

To help you determine how quickly you can access files, checkmark overlays appear on files:

 Files with icons overlaid with a white check on a blue background   are cached. 

 Files with icons overlaid with a blue check on a white background   are not cached.
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The following FileCloud options are available for Drive from the Explorer window when you right-
click on a file or folder in My Files or Network Folders and choose Show More Options > 
FileCloud Drive:

A File A Folder

When you right-click on a file or folder in Team Folders or Shared with Me and choose Show More 
Options, you also see an option to share a link with someone who already has access to the Team 
Folder or Shared with Me. To share a link with someone who already has access to a folder, see 
Sending a link from a Team Folder or Shared With Me

A File in a Team Folder or Shared with Me A Folder in a Team Folder or Shared with Me

Understanding FileCloud Drive
FileCloud Drive provides a virtual view of your FileCloud files and makes it appear as if the files are 
actually local, but in reality they are not. When you open them in your explorer or finder, they are 
downloaded to a local cache. When you save the files, they are saved to the cache and then uploaded 
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to FileCloud's remote server.

When you save your files, confirm that they have been uploaded to FileCloud by looking for the 
notification in the Drive app or the FileCloud user portal notifications.
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File upload notification in Drive app.
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File upload notification in FileCloud user portal.

Network 
Dependency Description Best Practice

 Network must be 
available.

FileCloud Drive depends on your 
network to download files from the 
remote FileCloud server and to upload 
them back to it.

 Use a reliable network connection.

 File 
size determines  
download time.

When you have a large file, for 
example 1 GB, and you try to open it in 
an application via FileCloud Drive, it is 
not instantaneously available like 
smaller files. The time it takes to be 
downloaded from the remote 
connection and then opened is visible 
to you, and depending upon your 
network connectivity this could take a 
while. 

 Use FileCloud Drive to work with small to 
medium sized files 

 Use FileCloud Drive to edit documents 

 Use FileCloud Drive to upload a small 
number of files or download small 
documents. 

 FileCloud Drive is more convenient than 
using the web portal to edit files because it 
avoids manually downloading the file first, 
editing it, and then re-uploading it to the 
server. 

 FileCloud Drive's explorer window 
automatically opens the document in the 
application, allows you to edit, saves it, and 
then uploads the file back to the server.

 Use FileCloud Sync If you are working 
with files that are 1 GB or larger, because 
they are stored directly in File Explorer.
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Network 
Dependency Description Best Practice

 Network 
connectivity 
determines how 
long it takes to 
complete an action.

When you choose an action like copy 
or delete from the system tray menu, 
the cursor icon animates until all 
operations are committed to the 
FileCloud Server. When the action is 
complete, the cursor stops animating. 
The time it takes the action to 
complete depends on the speed of 
your network connection. That is why 
it is better to use Drive with small files 
and small amounts of files at once.

 Wait for the cursor to stop moving 
before choosing another action.

Installing FileCloud Drive

To install FileCloud Drive:

1. Download FileCloud Drive from the following URL:
 http://www.filecloud.com/additional-downloads/#drive

2. To run the installation wizard, click the FileCloudDrive2eSetup.exe execution file you just 
downloaded.

Beginning in FileCloud Version 21.3, Drive installs into the folder Program Files instead of the folder 
Program Files(x86). 

http://www.filecloud.com/additional-downloads/#drive
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The first screen recommends that you use the FileCloud for Office feature.

3. Click Next.

4. Leave the checkbox checked, and click Next.
If you are already a Drive user using DocIQ, and this is an upgrade, the next screen gives you the 
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option of using DocIQ or FileCloud for Office. For more information, see Using FileCloud for 
Office with Drive. If you are a new Drive user, the following screen does not appear.

The next screen appears:
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5. Click Install.
The wizard shows the installation's progress.

When installation is complete, the following screen appears:
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6. Leave Yes, restart the computer now selected to begin using Drive or the latest version of Drive, 
and click Finish.

Checking for Drive Updates

To check if there are updated versions of Drive:

1. Click your username in the upper-left corner of the dashboard, and choose Check for updates.

If there is a new version of Drive available, the message A newer version is now available. 
Updating is highly recommended. Download the new version and exit now? appears.

2. Click Yes.
Drive is closed and the new installation file is downloaded to your system.
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3. Save and run the installation file.
The new version of Drive is installed and you are prompted to restart your computer.

Start and Log In to Drive
After installation and restarting your computer, FileCloud Drive should open automatically.

 The same content that is available from the User Portal is listed locally as a drive.

 You can add/delete/edit files that are stored on your FileCloud Server folder from the drive.

Starting Drive

Starting Drive and the startup wizard

If Drive did not run after you restarted your computer:

1. From the Start menu, click FileCloud Drive > More > Run as administrator.

A log-in window opens.
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2. To change the user interface language from English, use the drop-down list at the bottom of the 
screen.

3. Click the Get Started banner to go to the next screen.

Step 1: The wizard's log-in screen
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After you click the Get Started banner in the first wizard screen, the Login screen opens:

1. Choose a Login Method.
To log in with SSO, see Log In Using Single sign-on (SSO).
To log in using a device authentication code, see Using Code Based Authentication for Drive.

2. In Server URL, enter your server address.

3. In Account, enter your username.

4. In Password, enter your FileCloud account password.
You may enter proxy settings instead.  See Proxy server for FileCloud Drive.

5. Click Login.

Setting Description Example

Server 
URL

The URL to the FileCloud Server.

You can find this URL

 In the Welcome to FileCloud email you received with your 
user account

 By contacting your Administrator

https://
<myteam>.<filecloud_site>.co
m
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Setting Description Example

Account Your FileCloud account name or email address.

You can find this URL

 In the Welcome to FileCloud email you received
 By contacting your Administrator

<user name>

username@myteam.myfileclo
ud.com

Passwor
d

The password to your FileCloud account.

SSO Single sign-on (SSO) is a user authentication process that 
permits you to enter one name and password in order to access 
multiple applications.

Drive users can read about:

Log In Using Single sign-
on (SSO)

Device 
Authenti
cation 
Code

This allows you to get a Device Authorization Code to connect 
to the server instead of a username and password.

Your administrator must configure this option. If they do:

1. You must enter the server URL, the user account name (or 
email), and then click the "Request Access" button.

2. If the request access was successful, you will get the 
following dialog which needs a device authorization code 
to login.

Administrators can read 
about:

 Configuring Desktop 
Apps Login support - Code 
Based Authentication

Drive users can read about:

Using Device 
Authorization Codes

Proxy 
Settings

If your company requires a proxy server to connect to internet, 
then you must provide that information. In the log-in screen of 
the dashboard, click Proxy Settings in the wizard's Log In 
screen.

 Enter Proxy Settings

Step 2: The wizard's Download Limit screen

mailto:username@myteam.myfilecloud.com
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After you click Login, the Download Limit screen opens.

Before a user can read or update a file in Drive, the file must be fully downloaded, which may lead to 
heavy bandwidth usage. To limit this, FileCloud Drive has a maximum file size download limit setting 
which is set to 50 MB by default. You may adjust this setting depending on your system's performance 
and the size of files that your users commonly access in Drive. 

 

1. To change the Download Limit, move the arrow to the left or right.

2. Click the right arrow to go to the next wizard screen.

Step 3: The wizard's General Settings screen

The download limit does not apply to the following file 
types: .txt, .rtf, .doc, .docx, .xls, .xlsx, .ppt, .pptx, and .indd. 
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After you click the right arrow in the Download Limit screen, the General Drive Settings screen opens.

1. Mount Point is entered automatically as your next available drive letter.
Optionally, choose a different drive letter in the Mount Point drop-down list.

2. By default, Recovered folder location is set to %APPDATA%/FileCloudDrive/data/Recovered.
Click Edit to select a new location.
For information about recovering files, see Recover Files After Interrupted Drive Uploads.

3. By default, system notifications are enabled. To turn off system notifications, click the slider 
button for Mute all notifications until it is enabled.

4. By default, when Office files are opened for edit, they are not locked. To lock Office files files 
when they are opened, click the slider button for Lock Office files automatically on edit until it is 
enabled.

5. By default, Drive runs when Windows starts up. To disable running of Drive when Windows 
starts, click the slider button for Run at Windows startup until it is disabled.

6. Click the right arrow to go to the next wizard screen.

Setting the mount point's the volume name:
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By default, FileCloud Drive autogenerates the volume name as FileCloudDrive. This appears in the 
volume label.

To have the volume label use the user's display name:

1. Open the FileCloud Drive configuration file for editing. 
It is located in Program Files/FileCloud Drive/service/config.xml.

2. Add the following key:
<useuniquemountlabel>1</useuniquemountlabel>
Now the user's display name appears in the volume label.

Allowing multiple instances to run:

For a server environment where multiple sessions are simultaneously running, use the keys: 
<multimount> and <useuniquemountlabel>
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1. Open the FileCloud Drive configuration file for editing. 
It is located in Program Files/FileCloud Drive/service/config.xml.

2. To allow multiple instances to run, include the key:
<multimount>1</multimount> 

3. Also include the key:
<useuniquemountlabel>1</useuniquemountlabel>

Step 4. Finish

After you click the right arrow in the General Settings screen, the Finish screen opens.

Click Start using Drive to open the Recent activity screen of the Drive dashboard and the mounted 
Drive folder in file explorer.
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Related topics

Log In Using Single sign-on (SSO)

Single sign-on (SSO) is a type of a user authentication that enables you to log in once to multiple 
software applications. If your admin sets it up, they will provide you with an SSO username and 
password.

Note: Filecloud only supports SAML SSO. It does not support NTLM SSO.
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During FileCloud Drive login, you may choose SSO in the Login screen of the Startup wizard.  

To login to FileCloud using SSO:

1. In the Login screen of the Drive wizard, for Login Method, click SSO.

2. In Server URL, enter your FileCloud address.

3. Click Login.
You are logged in and taken to the next Drive wizard screen, Download Limit.

Using Code Based Authentication for Drive

Your Administrator may require you to log in with a code instead of a user name and password.

To login to the FileCloud Server using a code:

1. In the Login screen of the Drive wizard, for Login Method, click Device Authentication Code.

2. Type in the server URL and the user account name (or email).
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3. Click Login.

4. If the request access was successful, a window for opening the Device Authorization code 
opens:
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5. Sign in to the FileCloud user portal, and go to Settings > Devices.

6. Approve the device.
The following message appears:

7. Copy the Device Authorization Code and paste it into the authorization code field.

8. Click Submit to log in.

9. You are logged in and taken to the next Drive wizard screen, Download Limit.
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FileCloud Drive Two-Factor Authentication

FileCloud Drive supports two-factor authentication (2FA) codes when your administrator enables 
2FA in the FileCloud server. 

 The code is required the first time a new device is connected.

 On subsequent logins to FileCloud Drive the user is prompted to enter a new 2FA code.

  Two-Factor authentication codes are required if the device record is removed by your Administrator 
from the Device Management panel

To log in when 2FA is enabled:

1. When you log in to Drive for the first time, the dashboard appears as:

You receive your authentication code by the method configured by you administrator, such as email or 
SMS.

1. Enter the code, and click Submit.

2. You are logged in and taken to the next Drive wizard screen, Download Limit.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 203

Proxy server for FileCloud Drive

FileCloud Drive can use a proxy server to connect with FileCloud server.

To enter proxy settings:

1. In the Login screen of the Drive wizard, for Login Method, click Proxy Settings.

The Proxy Settings dialog box opens:.

2. Fill in the proxy settings and click Save.

3. Click Login.

4. You are logged in and taken to the next Drive wizard screen, Download Limit.

FileCloud Drive System Tray Options

You can use system tray icons to quickly access menu options for opening the FileCloud Drive 
dashboard, navigating to drive in file explorer, searching for files and exiting FileCloud Drive. 

To open the right-click menu: 

1. In the lower right corner of your Windows desktop, open the system tray.
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2. Right-click on the FileCloud Drive icon.

The menu of options opens:

Optio
n Description

Dash
board

Opens a window of FileCloud Drive activity and settings.

Open 
Folder

Launches an explorer window that displays the contents of the mounted drive volume. If the 
remote server is not available or configured then nothing is launched.

Searc
h

Opens a FileCloud Drive Search window where you can type in a keyword, browse to a specific 
folder, and set Advanced Search options. For more information, read Searching in Drive.

Exit Unmount and exit FileCloud Drive application.

Exit or Log Out of Drive
When you exit Drive, your session ends, but your username, password, and configuration settings are 
saved, so that when you re-open Drive, your settings are automatically filled in.
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Logging out of Drive removes your username, password, and configuration settings and takes you 
back to the startup wizard, where you must enter your server URL, account, and and password and 
configure Drive.

You can exit or log out of Drive from the user drop-down list in the Drive dashboard.

Settings
To change settings for FileCloud Drive:

1. Log in to Drive.
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2. At the bottom of the Drive dashboard, click the Settings button.

The Settings screen of the dashboard opens. The first time you open it after installing, a Trust 
FFO button appears (unless you have chosen to continue to use docIQ.) 
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After you click Trust FFO once, it does not appear on the settings screen again. Now when you 
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click Settings, the following screen appears. 

3. Change any settings.

For more information about the settings, click or expand the links below:

Enable and set the download limit

FileCloud Drive sets a limit on the size of files you can download (with exceptions for some file types) 
to 50MB by default.  

File types that this limit does not apply to are: .txt, .rtf, .doc, .docx, .xls, .xlsx, .ppt, .pptx, and .indd.
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This default limit is set for the following reasons:

 FileCloud Drive must download a file from the server before it can be read, modified, or updated. 

 Windows can pre-fetch files to improve user experience and can request files that are not 
actively used.  

 This activity can sometimes cause heavy bandwidth usage. 

 To limit this, FileCloud Drive has a maximum file size limit setting to prevent downloading large 
files. 

To change the download limit size, slide the pointer to the left or right.

To disable the download limit, click the Enable download limit slider until it appears gray.

Notifications

The default setting is Enable all notifications, which enables display of both Drive system toast 
notifications and floating status notifications.
You may change the setting to:
Mute all notifications - Disables display of both system toast and floating status notifications. Note: 
File transactions and important notifications may be missed.
Mute system notifications - Disables display of system toast notifications, but enables display of 
floating status notifications.
Mute app notifications - Disables display of floating status notifications, but enables display of system 
toast notifications. Note: File transactions and important notifications may be missed.

Lock files automatically on edit

Lock files automatically on edit

Use the automatic lock feature to lock a file on the FileCloud server while it is being edited by one user 
to prevent another user from editing it at the same time.

By default, the automatic lock feature is disabled. To enable it, click the Lock files automatically on 
edit slider.

Note that only certain types of files can be automatically locked. For more information, see Automatic 
Locking in FileCloud Drive.

Disable FFO Office integration

If you have installed FileCloud for Office, the first time you log in and view settings, a Set up FFO label 
and a Trust FFO button appears. You must click the Trust FFO button to install the certificate for FFO. 
This removes the Set up FFO label and Trust FFO button from Settings. They will not appear again. 
However, to use FFO, you are still required to include the FFO add-in.
FileCloud for Office is enabled by default. To disable it, click the Disable FFO Office Integration slider 
so that it turns blue.

Run at Windows Startup

By default, FileCloud Drive is run on Windows startup. To prevent Drive from automatically running on 
startup, click the Run at Windows Startup slider so that it turns gray.

Show Dashboard At Startup
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By default, when FileCloud Drive starts, it automatically displays the dashboard. To prevent Drive from 
automatically displaying the dashboard when it starts, click the Show Dashboard At Startup slider so 
that it turns gray.

Clear Cache

If Drive is not displaying updated information or is running slowly, clear your cache by clicking the 
Clear Cache button.

Get Logs

To open the folder that stores Drive log files, click the Get logs button.

Commit Pending Changes to Server

If you experience a lag between the time you perform an action and the time it is committed it to the 
server, click Commit Pending Changes to Server to commit the changes to the server now.

Automatic Locking in FileCloud Drive
Automatic locking is only supported for certain file types in Drive. When you open file types that do not 
have automatic lock support, you must manually lock them to ensure that Drive does not attempt to 
upload them while they are being edited.

Automatic locking of Adobe and Quickbooks files

In Drive in Windows, automatic locking is supported for the following file types:

 Microsoft Word

 Bluebeam Revu

 Adobe InDesign

 Adobe Illustrator

 Microsoft PowerPoint

 Microsoft Excel

 Corel WordPerfect

 Quickbooks 

 AutoCAD

To enable the automatic lock feature, see 23.261b Settings#Lock-files-automatically-on-edit.

Working in FileCloud Drive
In this section:
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Searching in Drive

How do I access the search window? 

Initiating search from 
the Drive system tray

The taskbar Search option 
opens the basic Search
UI with the default search 
path. 

Initiating search from the 
Drive folder

Initiating search from the dashboard

Basic and Advanced Search

Basic search view Advanced search view
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Enter a search term, and click Enter. The files and 
folders returned are listed in the lower portion of 
the Search window.

By default, file names, content, and metadata are 
searched. To include folders in the search or to 
filter the search, click Show advanced options.

The number of items found appears in the red oval 
near the Search icon at the bottom of the view. 

Click Show advanced options in the basic search to 
view the advanced options fields. Configure any of the 
advanced options:

 Search Location - Click Edit and navigate to the 
folder path that you want to search

 Include Folders - Toggle the button to include 
folders as well as files in the search

 Search type  - All content (default), Name only, 
Content only, or Metadata

 Date - Enter a date range
 Size (KB) -  Enter a size range

Click Start search to begin the search. The results 
appear in the basic search view.

The number of items found appears in the red oval near 
the Search icon at the bottom of the view. 
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Accessing items after searching
After your search results are returned, you can access any location in the item's path in content 
explorer by clicking on it.

Click here: To open here:

Also see:

Content Search in Drive
Content search enables you to search through the text in file types such as txt, pdf, doc, docx, xls, xlsx, 
ppt, pptx. Search results display the matching term in bold.

To perform a content search:

1. Access the Search window in Drive.

2. Click Show advanced options.
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3. In the drop-down list, choose Content Only.

4. Enter a search term.
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5. Click Start Search.
The search returns files that include the search term in their content. The phrase including the 
search term appears in bold.
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Metadata Search in Drive
You can search on metadata from any of the metadata sets in Drive.

To search on metadata:

1. Open the Search window in Drive.

2. Click Show advanced options.

3. Choose Metadata as the Search type and define search conditions.

This video shows you how:
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Viewing FileCloud Drive Activity

You can view live activity as well as the history of recent activity in FileCloud Drive.

To view live activity in Drive:

1. Log in to Drive, or in the system tray, right-click on the Drive icon, and choose Dashboard.
Click the Live button at the bottom of the page.

The ability to cancel pending and in progress downloads and to view a count of pending downloads 
is available in FileCloud version 21.3 and later.
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The number of uploads and downloads pending and in progress appears at the top of the 
dashboard.
While uploads and downloads occur, their progress is shown on the dashboard.
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To cancel pending or in-progress downloads in Drive:
While a file's download is still in progress, a cancel button appears to its right on the Drive dashboard.

 Click the Cancel button to cancel the download.
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To view recent activity in Drive:

1. Log in to Drive, or in the system tray, right-click on the Drive icon, and choose Dashboard.
If the dashboard does not display the Recent Activity screen, click the Activity button at the 
bottom of the page.
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Sharing Files in Drive

File sharing allows you to provide public or private access to files stored in FileCloud Server and saved 
in your Drive folders with various levels of access privileges.

Sharing files allows you to:

 Keep track of who you have shared a file with

 Add comments about the file

 Monitor file versions

 Control changes people make to the file or folder by setting a combination of permissions to 
read, view, modify, copy, or delete it

You can share a file in many different ways. 
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Requires a FileCloud 
Account

Set 
Permissions Set Options Share with 

Everyone 
Share with a 
Specific User 
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 View

 Download

 Share

 Share 
Name

 Expiration

 Restrict 
Downloads

 
Notifications

 Require 
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e
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an account to create 
one

 View

 Download

 Share

 Share 
Name

 Expiration

 
Notifications

   Add Groups of 
multiple user
to share with

   With a FileCloud 
account

Sharing Files or Folders Publicly in Drive
You can share a file or folder so that anyone can access the share even if they don't have a FileCloud 
account.

If you want more security but still want a large number of people to access the file, you can enable 
password protection.

Create a public share:

1. Open your Drive folder and navigate to the file or folder that you want to share.

2. Right-click on the file or folder and choose Show More Options > FileCloud Drive >Share Link.
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The Share Link dialog box opens. By default the share is private.

3. Under Sharing permissions, click Allow anyone with link, Allow anyone with link and password, 
or, if it's available, Allow anyone with Secure Web Viewer Link and a password.

4. Change any of the options under Share options.
The Max number of downloads setting is available for files but not for folders.
See Public Share Options for Files or Share Options for Public and Private Folders for help 
changing the settings.

5. If you click Allow anyone with link and password, the share is still public, but requires users to 
enter the password shown.
You may change the password, and click Save to save it.

6. Click the Copy link button to paste the link (and password if it exists) in a message and send it 
to users to give them access to the shared file
OR
Click the Email link button to open an email message that includes the link (and password if 
included). Fill in the addresses of recipients you want to send the email to.

For information about additional options and settings when sharing files and folders, see Sharing Files 
and Folders
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Sharing Files or Folders Privately in Drive
When you share a file or folder privately, you can either share it with existing FileCloud users or groups 
or invite a new user to create a FileCloud account and then access the share.

Sharing files or folders privately:

 Provides more security than sharing files or folders publicly.

 Is useful when you only have a small number of people you want to share with.

 Requires the user to log in with a FileCloud account to access the file or folder on the User 
Portal.

To share files or folders privately with users or groups

Share a file or folder privately with an existing or new user

1. Open your Drive folder and navigate to the file or folder that you want to share.

2. Right-click on the file or folder and choose Show More Options > FileCloud Drive >Share Link.

The Share Link dialog box opens.

3. Change any of the settings under Share Options. 
See Private Share Options for Files or Share Options for Public and Private Folders for help 
changing the settings.
The Max number of downloads setting is not available for folders.

4. In the Sharing Permissions section, click Invite Users.
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5. Click Invite Users.
An Invite Users to this share dialog box opens.

6. In the Add email address or account box, enter the email address or username of an existing 
user or a new user's email address.
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Adding an existing user.

Adding a new user: when you click Invite, an account is 
created for the user and the account password is sent to 
their email.

7. Click Add to add an existing user or Invite to invite a new user. 

8. Add any number of share users. When you are done adding users, click Add Users to this Share.
The users are added to the share and emails are sent to them with a link to the share. For 
information about sending and editing share emails to users, see Sending an email notification 
for a private share, below.
For any new user(s) you have added to the share, a FileCloud account is automatically created 
for them and an email with the account password is sent to them.
The Users tab lists the users with checkboxes for various types of permissions next to them.
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View is selected by default, and cannot be edited.
The permissions available for files and folders are different. See Private Share Permissions for 
Files or Private Share Permissions for Folders for more information.

9. Change any of the permissions.

10. Click OK.

Sharing files or folders privately with a group

The procedure for sharing files or folders privately with a group is similar to sharing them privately 
with a user.

1. Follow steps 1 through 3, above, in Share a file or folder privately with an existing or new user.

2. In the Share Links dialog box, click the Groups tab.

If you are not able to invite a new user to access your share, contact your administrator about 
allowing new user account creation. See Sharing Files Privately with New Users.
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3. Click Add Group.
An Add Group dialog box opens:
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4. Choose a group and click Add.

5. The Groups tab lists the group with checkboxes for various types of permissions.

6. View is selected by default, and cannot be edited.

7. Change any of the permissions.

8. Add any number of additional groups.

9. Click OK.

Sending an email notification for a private share

Sending an Email Notification for a Private Share

By default, when you are adding a user to a private share, the Send Email box in the Invite users to this 
share dialog box is checked.  

If you leave the box checked, an email with the share link is sent to users added to the share.

To not send the email to share members:

1. Uncheck Send Email before clicking Add Users to this Share.
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To customize the email content

1. Leave Send Email checked and click Edit.

An email form with the subject and text message of the email opens.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 231

2. If you want to change the subject or text of the message, change it here, and click OK. 

3. If you want to add additional recipients, change the format of the email, or remove the link, click 
Advanced.
An email form with additional customization options opens.
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4. Make any changes, and click OK.

Editing a Share Link in Drive
From the Share Link dialog box, you can edit the name of a link to be more descriptive.

1. In the Share Link dialog box, click Modify Link.
The portion of the link that you can change becomes highlighted.
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2. Enter a new name for the link, and click Save.

The link name is changed, and you are prompted to confirm whether or not you want to send an 
email to share recipients with the updated link:

Note: If this is the first time you are adding a user to the share, they will receive an email with the 
link regardless of whether you choose OK or Skip Email.

Copying a Share Link in Drive
In the Share Link dialog box, you can copy a link and then post it in a site or send it to a user.

 In the Share Link dialog box, click the Copy icon next to the share link.

The link is now copied and you may paste it into website or message.

Previewing a Share in Drive
From the Share Link dialog box, you can view a share as it appears to recipients when they click the 
share link.
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 Click the Preview icon next to the share link.

The share link opens in the browser as it would for a user who clicked the link:

Emailing a Share Link in Drive
From the Share Link dialog box, you can email a link to users to give them initial access to your share 
or to resend a private link to share recipients.

1. In the Share Link dialog box, click the Email icon next to the share link.

A Send Share Link via Email dialog box opens.
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2. Enter a To address and a message.

3. Click Send Email.

Sending a link from a Team Folder or Shared With Me
You can use the Direct Link option to copy a link to an item and send it to others who already have 
share access to it. That means they must already have permission to access the item. 

The Direct Link option works only with items in the following folders:

 Shared with me

 Team Folders

After clicking the share link, the user must log in to FileCloud Server, and is then taken directly to 
the selected folder or file.

In the Shared With Me or Team Folders sections, you may create a link to a folder or a file to send to 
users in an existing share without creating a new share. 
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When users click the link,  they are prompted to log in and then taken directly to the selected folder or 
file.

To create a direct link:

1. Navigate to the file or folder in Shared With Me or Team Folders.

2. Hover over the file or folder and click the Direct Link icon.

A Direct Link is Ready message pops up.

3. Click Copy Link.

Limitation
For Team Folders, direct links to files in sub-folders that are created by users who have access to 
the parent folder and sub-folder will not work for users who only have access to the sub-folder, 
because the links will include the parent folder path, which does not exist in the file structure of 
those users.
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4. Paste the link into an email or a file, and send it to users.

To share a file by creating a direct link:

1. Launch FileCloud Drive by right-clicking on the icon in your system tray and choosing Open 
Folder.
A File Explorer window opens, displaying the contents of your mapped drive.

2. Open a Team Folder or Shared with Me folder, right-click the item you want to share, and then 
select Copy Direct FileCloud Drive Link.

The link is copied to the clipboard and if alerts are enabled, the following alert appears:

3. Paste the link and send it to a user.

Using DocIQ with Microsoft Applications

DocIQ is a Microsoft Office add-in for FileCloud Sync and FileCloud Drive clients. 

New FileCloud Drive users: DocIQ has been replaced with FileCloud for Office. Please see the Using 
FileCloud for Office with Drive documentation.

Current FileCloud Drive users (DocIQ users): FileCloud no longer supports DocIQ. Later this year, 
DocIQ will be deprecated. Although you can continue to use DocIQ with the current release, we 
recommend using FileCloud for Office, which can be downloaded from the Office add-ins store. Now, 
when you upgrade FileCloud Drive, you are given the choice of using FileCloud for Office or 
continuing to use DocIQ. If you choose to use FileCloud for Office, please see the Using FileCloud for 
Office with Drive documentation.
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DocIQ works with the following Microsoft Office applications:

 Word 
 Excel
 PowerPoint

What does DocIQ do?

DocIQ works with Office documents to help you manage shared files.

DocIQ gives you the ability to:

 manage file locking
 collaborate with your colleagues through comments 
 see how shared files are being managed 

How do I use DocIQ?

1. Open an Office application such as Word, Excel or PowerPoint.
2. Inside the Office application, you open a file saved to a 

FileCloud Sync or FileCloud Drive folder.
3.  DocIQ displays as a task panel inside the Office application 

with the following information:
 File details

 Lock status

 File sharing details

 Comments attached to the file

How do I install and work with DocIQ?

1. Install DocIQ.
2. Configure DocIQ.
3. Work with file locking.
4. Troubleshoot Doc IQ issues.

Install DocIQ

 Install FileCloud Drive

Where is DocIQ installed on my computer?

DocIQ is installed in the following folder:

 

program files(x86)/DocIQ

DocIQ is no longer supported, and can no longer be installed. When you install or upgrade FileCloud 
Drive, you will be given the option of installing FileCloud for Office.
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Configure DocIQ
DocIQ gets all configuration information from FileCloud Sync and Drive.

For example, when a file is opened from Drive, DocIQ will know which FileCloud account you are using.

 This allows DocIQ to show you information about the file that is uploaded to the FileCloud Server 
site in the Office application.

There are a few properties that can be configured in Sync and Drive for DocIQ:

Option Description How to Configure

Enable or Disable DocIQ 
Integration

This option removes the DocIQ panel 
that is shown in a Microsoft Office 
application after DocIQ is installed and 
enabled.

This option is useful if you only need to 
disable DocIQ for a short time while 
troubleshooting computer issues.

This option does not permanently 
remove DocIQ. To remove DocIQ, you 
have the following options:

 uninstall Sync or Drive
 use the Windows Programs 

Control Panel to remove DocIQ

1. In the system tray, right-click 
on the FileCloud Drive icon, 
and then select Dashboard.

2. Click   .
Settings open.

3. To disable DocIQ, select 
Disable DocIQ Office 
integration.

4. To enable DocIQ,  select 
Disable DocIQ Office 
integration again.

Mute all notifications in 
DocIQ

When other users access a file you have 
open, DocIQ displays notifications in the 
DocIQ panel.

Select this option when you do not want 
to see notifications.

1. In the system tray, right-click 
on the FileCloud Drive icon, 
and then select Dashboard.

2. Click  .
Settings open.

3. To mute notifications for 
DocIQ (as well as all other 
notifications for FileCloud 
Drive) in Notifications, select 
Mute all Notifications.

4. To turn back on notifications 
for DocIQ (as well as all other 
notifications for FileCloud 
Drive) in Notifications, select 
Enable all Notifications.

Work with DocIQ File Locking
You can use file locking to:

 See if you have the file locked for editing

 Easily turn locking on and off
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 Prevent or enable downloads of this file

Locking is critical for shared files, since another user can also open the file and make changes.

 When one user opens a file, DocIQ automatically locks the file for editing. 

 The lock is shown right in the Office application you are using to edit the file.

FAQ's

How do I know the status of a lock?

To see the lock status:

1. In a Microsoft Office application, open a file saved to your Drive folder.

2. In the DocIQ panel, under the file name, location, and date information, you can see the lock 
status.

File is not locked when:

 Lock is OFF

File is locked (read allowed) when:

 Lock is ON
 Prevent Download is OFF

File is locked (read blocked)
when:

 Lock is ON
 Prevent Download is ON

The following table describes what each lock status means and how it impacts what you can do with 
the file and others you have shared it with.

Lock Status Access by lock owner Access by others

File is locked (read 
allowed)

Read and Modification allowed Only read is allowed, no modification is 
allowed

File is locked (read 
blocked)

Read and Modification allowed No Read and Modification is allowed
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Lock Status Access by lock owner Access by others

File is not locked Read and Modification allowed Read and Modification allowed

  

When does the lock status change?

In the following scenario:

 When a supported file from Sync or Drive is opened

 When automatic lock on an open file is enabled

DocIQ will automatically attempt to lock the file, with read allowed status.

For a file with a Read Blocked status:

If USER1 has locked (read blocked) the file:

 FileCloud Sync will not download the file for USER2

However, if USER2 has already downloaded the file, then:

 FileCloud Sync will allow DocIQ to open the file

 FileCloud Drive will not allow the file to be opened by USER2, unless Drive has already cached 
the file

You can use the following table to understand the status of lock:

Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

An unlocked file is 
opened by USER1

File is not locked File is locked (read 
allowed) by USER1

File is not 
locked

An unlocked file is 
opened by USER1

File is not locked File is not locked File is not 
locked

A file is locked by USER1 
before it is opened by 
USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is locked
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Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

A file is locked by USER1 
before it is opened by 
USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is locked

A file is locked by USER1 
before it is opened by 
USER1

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is locked

A file locked by USER1 is 
opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 is 
opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 is 
opened by USER2

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is Locked 
(Read 
Blocked) by 
USER1

 Note that you cannot enable Prevent Download unless DocIQ Lock is also enabled.

How can I prevent another using from downloading a file I am working on?

When you lock a file, you can block other users from reading the file by enabling Prevent download.
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 Note that you can not enable Prevent Download unless DocIQ Lock is also enabled.

If another user, USER2, attempts to download the file, USER2 will see the following conditions:

 The file cannot be downloaded from the FileCloud User Portal

 FileCloud Sync will not download the file that is locked and read-blocked.

 FileCloud Drive will not open the file that is locked and read-blocked.

 DocIQ will open the file from a Sync path when file is already available in the Sync client 
(previously downloaded).

 DocIQ will open the file from a Drive path when the Drive client allows a file to be opened.

Manual file locking in DocIQ

Please note that whether or not manual file locks are released when a file is closed depends on the 
setting for automatic locking:

 Manual locks are released when closing a file and Drive Automatic Locking is not active.

 Manual locks are not released when closing a file and Drive Automatic Locking is active.

Troubleshoot, Disable, and Uninstall DocIQ
DocIQ is very straightforward to install, configure, and use. If you encounter issues, try using these 
troubleshooting tips.

DocIQ is not displayed in your Office app

Check if DocIQ office integration is enabled in Sync/Drive Path:

1. Check if the file you opened is in a Sync or Drive folder

2. Restart Drive or Sync.

3. In an Office application, such as Word, open File Options

a. From the menu, select File > More > Options.

a. In Add-ins, under Active Application Add-ins verify that FileCloud DocIQ is listed.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 244

DocIQ is present but does not appear when I open an Office application

This occurs if the Office application is storing DocIQ as an inactive add-on. To fix this problem, 
activate the DocIQ add-on:



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 245

1. In the Office application, with the file open, select File, then Options.
An Options dialog box opens:

2. In the navigation bar, click Add-ins.

3. Look for FileCloud DocIQ under Inactive Application Add-ins.

4. If it is listed there, make sure the Manage drop-down list at the bottom of the dialog box displays 
COM Add-ins.

5. Click Go.
The COM Add-ins dialog box opens.
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6. Check FileCloud DocIQ.

7. Click OK.
The Office document should now display DocIQ.

To temporarily disable DocIQ to troubleshoot other computer issues, see Configure DocIQ.

If you need to, you can uninstall DocIQ in the following ways:

From the Windows Control Panel

1. Next to the Start button (

), in the search box, type Control Panel.

2. From the results, select Control Panel.

3. Select Programs.

4. Select Programs and Features, and then select DocIQ.

5. At the top of the list, next to Organize, click Uninstall.

Uninstall the Sync application

DocIQ will be uninstalled when Sync application is uninstalled.

1. Next to the Start button (

), in the search box, type Control Panel.

2. From the results, select Control Panel.

3. Select Programs.

4. Select Programs and Features, and then select FileCloudSync.

5. At the top of the list, next to Organize, click Uninstall.
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Uninstall the Drive application

DocIQ will be uninstalled when Drive application is uninstalled.

1. Next to the Start button (

), in the search box, type Control Panel.

2. From the results, select Control Panel.

3. Select Programs.

4. Select Programs and Features, and then select FileCloudDrive.

5. At the top of the list, next to Organize, click Uninstall.

Using FileCloud for Office with Drive

Before using FileCloud for Office with Drive
The first time you install Drive or upgrade Drive to use FileCloud for Office you must:

 Confirm that you trust FileCloud for Office and enable it as shown in the following procedure.

To confirm that you trust FileCloud for Office and enable it:

1. After you log in to FileCloud Drive, click the Settings tab.

FileCloud for Office is an MS Office add-in for Word, Excel, and PowerPoint which can be used in 
both Windows and macOS with FileCloud Sync, FileCloud Drive, and FileCloud Desktop. It is available 
in FileCloud beginning with version 23.1.
For instructions on how to install FileCloud for Office, see Using FileCloud for Office.
If you have been using FileCloud Drive with DocIQ, see the instructions for previous users of DocIQ at 
the bottom of this page.
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2. Click the Trust FFO button.

The Trust FFO button disappears, and Disable FFO Integration remains automatically turned off:
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FileCloud for Office is now enabled in Drive, but to use it in Office files, you must attach the add-
in to to each type of Office file (Word, Excel, and PowerPoint) in your FileCloud Drive directory.

Working with FileCloud for Office in Drive
The FileCloud for Office task panel displays information about a file and enables you to:

 Lock or unlock a file.

 Prevent or allow download of a file while locked.

 Share a file.

 Manage file versions, and view file details and metadata.

Lock or unlock a file

Locking and unlocking files

You can use the file locking function in FileCloud for Office to:

 See if you have a file locked for editing

 Turn a file lock on or off

 Prevent or enable downloads of a locked file
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If a shared file is not locked when you open it for edit, another user can also open the file and make 
changes.
To avoid this, by default, FileCloud for Office automatically locks files for editing when they are 
opened.
When you open an Office file in your client directory, the FileCloud for Office panel shows File is 
locked, and by default, users are allowed to download or read the file (Prevent download is disabled).

 To prevent other users from downloading or reading the file while it is locked, click the Prevent 
download slider.
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 To unlock the file while you have it opened for edit, click Unlock. Now other users can modify as 
well as view and download the file.
Note: Prevent download cannot be enabled when the file is unlocked.
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The following table describes what each lock status means and how it impacts what you and others 
you have shared the file with can do with the file.

Lock Status Access by lock owner Access by others

File is locked (download 
allowed)

Read and modification 
allowed

Only read is allowed, no modification is 
allowed

File is locked (download 
prevented)

Read and modification 
allowed

Neither read nor modification is allowed

File is not locked Read and modification 
allowed

Read and modification allowed

For a locked file with download (read) prevented:
If USER1 has locked (and read blocked) the file:
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You can use the following table to understand the status of lock:

 The FileCloud client will not download the file for USER2

However, if USER2 has already downloaded the file in Sync or Drive, then:

 FileCloud Sync will allow FileCloud for Office to open the file.

 FileCloud Drive will not allow the file to be opened by USER2, unless Drive has already cached 
the file.

If an admin prevents file locking after a user has locked a file in a client:

 The lock is automatically removed from the file

 Additional files cannot be locked using FileCloud for Office, and when you attempt to lock a file, 
an error message similar to the following appears:

If you are an admin and want to disable locking, see Managing User Locks.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 254

Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

An unlocked file is 
opened by USER1

File is not locked File is locked (read 
allowed) by USER1

File is not 
locked

An unlocked file is 
opened by USER1

File is not locked File is not locked File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is Locked 
(Read 
Blocked) by 
USER1

Share a file

Sharing a file

To share a file or folder that is opened with FileCloud for Office:
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1. In the FileCloud for Office panel, click Create.

A Share Link screen that is nearly identical to the one in the user portal opens:
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2. Share the file using the same settings and options that you would for a share in the user portal. 
See Sharing Files and Folders for help.
Note: The option for downloading the share QR code, which is available for shares created from 
the user portal, is not available for shares created in FileCloud for Office.
After you have shared the file, the FileCloud for Office panel displays details of the share:

3. Click Manage to change the options or permissions in the share.

Download versions, view details and metadata

Downloading versions, viewing details, viewing metadata

Versions

To view a file's version information in FileCloud for Office:

1. At the bottom of the FileCloud for Office panel, click the + across from Versions.
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The expanded Versions section shows you version information about the file.
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To download file versions in FileCloud for Office:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 259

The Properties dialog box opens to the Versions tab.
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2. Click Download for the version that you want to download, and save it.

Details

To view file details:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.

2. Click the Details tab.
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The details shown are the filename and type, the last modified date, the path of the file in 
FileCloud, and your permissions for the file.

Metadata

To view metadata information for the file:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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2. The Properties dialog box opens to the Versions tab.

3. Click the Metadata tab.
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Each metadata set applied to the file is listed with the values for its fields. 

FileCloud for Office log locations

Locating FFO logs

The locations of log files for FileCloud for Office in Windows and macOS are the following:

Windows: %appdata%/FFOServer

macOS:  /Users/[USERNAME]/Library/Preferences/FFOServer

View and add comments

Viewing and adding comments

Comments added to files and folders in FileCloud for Office also appear in the user portal and any of 
the other client apps.

To view and add comments in FileCloud for Office:

1. If Comments is not visible in the FileCloud for Office panel, scroll down to the bottom of the 
panel.

2. Click the + across from Comments.
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Any existing comments added to the file or folder here or anywhere else in FileCloud appear 
above the Comments box.
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3. To add a new comment, click inside the Comments box and enter the comment.
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4. Click Add comment.
The comment is added.
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For previous users of DocIQ
If you have never used FileCloud Drive with DocIQ before, the installer will automatically configure 
Drive for use with FileCloud for Office, and this section does not apply to you.

When you run the FileCloud Drive installer, the first screen of the wizard introduces you to FileCloud for 
Office:
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If you have been using FileCloud Drive with DocIQ, the installer prompts you to choose whether you 
want to continue using DocIQ or switch to FileCloud for Office (DocIQ will be deprecated in the future).
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Choose whether you want to use FileCloud for Office or DocIQ. If you choose FileCloud for Office, you 
are also required to install an add-in.
The installer configures your Drive installation to function with the option you have chosen. 

Viewing Your File Permissions

In Drive, you can view the permissions you have on a file or folder by right-clicking it in content explorer 
and choosing Show more options > FileCloud Drive > View properties:



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 271

Drive's Properties window opens to the Details tab, which displays your permissions for the file or 
folder.

Viewing and Modifying Metadata

You can see version and metadata information or add metadata tags by viewing file or folder 
properties.

To view properties:

1. Launch FileCloud Drive by right-clicking on the icon in your system tray and choosing Open 
Folder.

2. A File Explorer window opens, displaying the contents of your mapped drive.
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3. Right-click the item you want to view the properties for, and then select View FileCloud Drive 
Properties.

The Properties dialog box opens.

4. Click the Metadata tab.

5. View the metadata. Modify any values with edit permission,
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Viewing and Downloading File Versions in Drive

When a file is modified in FileCloud, the original file is saved as the prior version.
In Drive, you can view and download all versions of a file by right-clicking it in content explorer and 
choosing Show more options > FileCloud Drive > View properties:

Drive's Properties window opens. Click the Versions tab.
The Versions tab displays each version of the file and enables you to download it.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Drive – 274

Checking Drive Status

Drive indicates its status by the icon shown in the system tray:

Icon Image Status

Drive standard icon Drive action was successful or no activity

Hourglass Drive is performing an action

Hourglass with red dot Error in Drive activity

Click the icon to open the dashboard.

Using FileCloud Drive in a Remote Desktop Service Environment.
Configuration Requirements

 FileCloud Drive needs to have multi-mount enabled. To enable multi-mount, add the parameter 
<multimount>1</multimount> in config.xml.

 To avoid mount letter overwrites, add the parameter <useuniquemountlabel>1</
useuniquemountlabel> in config.xml.

 config.xml file is located at C:\Program Files\FileCloud Drive\service.

Environment Requirements 

 Windows Server 2012-2019 x64

 The Remote Desktop Service environment containing the following minimum requirements (1 
Domain controller /1 RD Connection Broker /1 RD Session Host /1 RD Gateway & Licensing / 1 
RD Web Access (IIS) ).

Additional Information.

 The Remote Desktop Service Terminal Server will share its resources across all active user 
sessions. Due to this FileCloud Drive's performance may be impacted if the server does not have 
enough resources. Please be sure to assign enough resources to your server depending on your 
usage. 

 FileCloud Drive will be hosted on the terminal server, but it will mount directly on the user's 
computer.

 Make sure FileCloud Drive is visible in RD Web Access once you have published it.

 The config.xml file is located at C:\Program Files\FileCloud Drive\service.
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FileCloud Drive Remote Desktop Service Access

In order to provide access to remote users, install FileCloud Drive within the hosting Remote Desktop 
Service server, and then publish it.

To publish FileCloud Drive:

1. Go to Windows Server Manager > Remote Desktop Services> Collections.

2. In the navigation panel, under Collections, choose your collection.
In the image below, the selected collection is FileCloud Deployment.

3. Under Remoteapp Programs, in the Tasks drop-down list, choose Publish RemoteApp 
Programs.
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The Publish RemoteApp Programs dialog box opens.

4. Select FileCloudDrive2 from the list and click Next.
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5. Then click Publish.

6. When publishing completes, close the window.
FileCloudDrive2 appears under RemoteApp Program Name.

Accessing FileCloud Drive via Remote Desktop Web Access.

After you publish FileCloud Drive, if it is enabled in your RemoteApp and Desktops setup, your users 
will have access to it via Web.

To access FileCloud Drive via web:

1. Enter the web IP or URL, and once authenticated, you will see Work Resources with FileCloud 
Drive listed.

2. To open a remote desktop protocol, click on the FileCloud Drive icon.
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3. Click on a file to open it in FileCloud Drive.
NOTE: You may be asked to authenticate your windows credentials as well as FileCloud Drive 
credentials on the first run.

Accessing FileCloud Drive via Remote Desktop

To access FileCloud via Remote Desktop, connect via RDP using the URL or IP provided by the system 
administrator, and authenticate with your username and password. Once done
you will be able to access FileCloud Drive from within the virtual machine.

Troubleshooting Drive

Limitations:
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FAQ - FileCloud Drive

Here are some of the Frequently Asked Questions (FAQ) about FileCloud Drive.

 Click on a link to expand it.

Why Are My Shortcuts Not Working?

There is a limitation to creating shortcuts to FileCloud Drive.  When a user reboots their PC shortcuts 
no longer work because the map FileCloud Drive uses to build the path to your files is deleted when 
the PC reboots. You can create a new shortcut after you navigate through the application, and the map 
is recreated.

Which Special Characters Cannot Be Used in File and Folder Names?

Folder and file names cannot contain:

 ..

 \

 /

 :

 *

 ?

 "

 <

 >

 |

Why, when my computer is restarted, does Drive log me in as the previous log-in user?

By default, Drive automatically logs you in as the previous log-in user even after 
your machine is restarted. 

 If Sophos Antivirus is installed, Drive application performance with large files (10MB+) is 
impacted.
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Can I See a List of My Recent Activities?

How Do I Use a Proxy Server to Connect?

How Do I Lock Files that I Am Editing?

Can I Use Two-Factor Authentication to Connect?

Can I Upload Files Larger Than the Storage Quota?

Drive File Issues

Drive File Issues

FileCloud Drive may be unable to upload files and folders with the following naming characteristics.

Special Characters
FileCloud Drive doesn't upload some files with characters that are incompatible with certain operating 
systems. 

Please rename them to something more suitable for use across multiple operating systems.

The following file and folder names are also not uploaded.

These differ slightly for Drive for Mac.

 The * character

 The < character

 The > character

 The : character

 The \ character

 The / character

 The | character

 The ? character

 The * character

 The ~ character
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Issues with Uploading a File to Drive

Restrictions on filenames and file extensions
Please note the following restrictions when uploading files to FileCloud:

 Files with the same name:

 If you upload a file with the same name and the same case as another file in the same 
folder, it overwrites the file.

 If you upload a file with the same name but a different case than another file in the same 
folder, you cannot upload the file and the File Operations window displays a file name 
conflict message.

 If you upload files with the same name but different file extensions, like myfile.doc and 
myfile.docx, they are treated as different files.

 FileCloud cannot upload files with leading spaces in the filename.

 By default, files with the extensions php, php5, phar, and phtml cannot be uploaded into 
FileCloud.

 tonido.db

 Thumbs.db

 desktop.ini

 * .tmp*

 * .~tmp

 *.lnk

 Files or Folders ending with space

 Files or folders ending with "." or ","

 .tonidocache

 Anything starting with Conflict_

 sync.ico

 .ds_store 

 Any hidden files (usually files starting with . in Linux and files with hidden attribute in windows)

 *.fuse_hidden

 *.crdownload

 *.partial

 *part

 *.download

 *.MACTF

 *.dwl

 *.dwl2
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Why can't I upload files larger than the storage quota to a Network Folder or 
Team Folder?

 To create a drive in Windows, FileCloud must specify a size.

 When FileCloud mounts a virtual drive, your storage quota is used as the size of the drive. 

 This mechanism restricts uploading files larger than the total size of the drive.

If you need to change the storage quota for a particular user, you can edit their current 
policy settings or create a new policy.

Administrators can read more about Setting the Storage Quota for Users

 

To change the upload limit and size of the drive by changing the User Storage Quota:

1. In the FileCloud admin portal's left navigation bar, scroll down and click Settings. Then, on 

the Settings navigation page, click Policies .
The Policies page opens.

2. Click the New Policy button.

For Admins

 To specify which file extensions may be uploaded into FileCloud, see Managing File Extensions
and Restricting File Extensions.

 To restrict certain filenames from being uploaded into FileCloud, see Restricting File Names.

You must have Administrator privileges to reset your storage quota.
If you do not, please contact your administrator to change it for you.
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3. In the New Policy dialog box, type in a name for the policy, and then click Create.

4. Click the edit button for the policy you just created.

5. On the General tab, change the User storage quota.
To set unlimited storage quota for the user, set User storage quota to 0.

6. Click Save.

7. From the left navigation pane, click Users.

8. On the Manage Users screen, click the user who you want to add to the new policy, and then 
click the edit button (
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).

9. On the User Details screen, click Manage Policy.

10. On the User Policy screen, across from Selected Policy click Select.

11. On the Policy List page, select the policy you created for this user, and then click Select.

12. On the User Policy screen, click Close.

13. On the User Details screen, click Save.

To change the default storage size in Drive, please Contact FileCloud Support.

Recover Files After Interrupted Drive Uploads

In the following scenarios, an upload may be interrupted because of network issues or other 
reasons:

 saving documents using FileCloud Drive

 uploading files using FileCloud Drive

In these cases the uploaded file is saved to a Recovered folder.
If there are any recovered files in the Recovered folder, your Live screen alerts you and displays 
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an Open recovered files folder and Clear recovered files folder buttons.

To retry the upload:

1. Click the Open recovered files folder button.
Your file explorer opens to the Recovered folder location.

2. Copy the interrupted file to the server and retry the upload.
To avoid looping, first copy the files into another local directory (for example Downloads) and 
from there into the Drive folder for the upload.

To empty the Recovered folder:

 Click the Clear recovered files folder button.
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Cannot Lock XSL Files in Drive

When DocIQ is not enabled, locking of XSL files is not supported in Drive. In other words, When one 
user has opened an XSL file, other users can open it as well.

However, locking other types of files, including XSLX files, is supported when DocIQ is not enabled.

Blank Error Messages in FileCloud Drive

Problem
In the following scenarios, FileCloud Drive users may see a blank error message when connecting:

Attempted Retry without Admin Intervention

1. A new device using FileCloud Drive tries to login to the FileCloud Server site.

2. An error notification appears without providing any text.

3. The FileCloud user clicks OK in the error message dialog box and then exits FileCloud Drive.

4. The user tries to open FileCloud Drive again.

5. An error notification appears without providing any text.

Attempted Retry with Admin Intervention

1. A new device using FileCloud Drive tries to login to the FileCloud Server site.

2. An error notification appears without providing any text.

3. The FileCloud user clicks OK in the error message dialog box and then exits FileCloud Drive.

4. The administrator logs on to the Admin Portal and deletes the device.

5. The user tries to open FileCloud Drive again.

6. An error notification appears without providing any text.

Cause
This is a known issue when all of the following conditions are set:

Condition For more information

The Administrator enables and configures two-factor authentication  Enable Two-Factor Authentication

The Administrator creates and configures a workflow to block client 
access

 Using Workflows

You are running FileCloud Server version 18.1 or earlier  FileCloud Server 18.1 Notes
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Resolution
This issue is fixed in FileCloud Server 18.2.

When the following conditions occur:

 The Administrator enables and configures two-factor authentication

 The Administrator creates and configures a workflow to block client access

 You are running FileCloud Server version 18.2 or later

The FileCloud Drive user now sees the error message with text:

 
 Upgrade FileCloud

Windows Can't Access This Disk in Drive

Problem
FileCloud Drive users may see the following error message when connecting:

Cause
In the following scenario:

1. The Administrator enables and configures two-factor authentication.

2. The Administrator creates and configures a workflow to block client access.

3. A new device using FileCloud Drive tries to login to the FileCloud Server site.
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4. An error notification appears.

This error appears by design. It is the expected result when all of the following conditions are set:

Condition For more information

The Administrator enables and configures two-factor authentication Enable Two-Factor Authentication

The Administrator creates and configures a workflow to block client 
access

Using Workflows

Resolution
Administrators can explain to the user why the device is blocked by their company policies.

How to uninstall FileCloud Drive
FileCloud Drive can be uninstalled from Windows "Add/Remove Programs" widget.
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FileCloud Drive for Mac

FileCloud Drive for Mac is a client application available for macOS (Catalina and later).  

It allows you to access your FileCloud server files like you would access any other files in Mac through 
the Mac Finder. The files can be edited from and saved directly to your FileCloud server

About FileCloud Drive for Mac

Although FileCloud Drive for Mac makes your remote FileCloud server files available as if it is a local 
drive in your MacOSX Computer, it is important to understand the underlying technology powering 
FileCloud Drive so that you can use it most efficiently for it's intended purpose.

FileCloud Drive for Mac provides a virtual view to your FileCloud files and makes it appear as if the 
files are actually local, but in reality they are not. The files are present on the remote server and if the 
underlying network connection is not available, FileCloud Drive for Mac cannot work. So in cases when 

FileCloud Drive for Mac is entering the end-of-life process and will no longer be available for 
download as of October 1, 2024. Support will no longer be available as of March 31, 2025. For more 
information, see https://www.filecloud.com/end-of-life-policy.

FileCloud Drive versions below 23.1.2 do not support macOS 14 (Sonoma). If you are using macOS 
14, please install or upgrade to FileCloud Drive 23.1.2 or higher.

FileCloud Drive versions below 22.1 do not support macOS Ventura. If you are using macOS Ventura, 
please install or upgrade to FileCloud Drive 22.1 or higher.

FileCloud Drive version 21.1 and higher supports Catalina and Big Sur.

Please note that for Drive running on Apple Silicon M1, Big Sur 11.3 or higher is required and security 
settings have to be adjusted.
See FileCloud Drive: Configuration for Big Sur 11.3 or later versions Running on Apple Silicon.

Beginning with FileCloud 23.1, Drive for Mac includes FileCloud for Office.

https://testbed.filecloudlabs.com/end-of-life-policy/
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you are going to be offline and want access to your files, FileCloud Drive for Mac is not a suitable tool 
and it is recommended to use the FileCloud Sync app instead which keeps a copy of the remote server 
files locally on your computer.

Also, note that when you have a large file (for example, 1 GB) and you try to open it in an application 
via FileCloud Drive for Mac, it will first have to be downloaded from the remote connection and then 
opened. Depending upon your network connectivity this could take a while. So even though these files 
appear connected to your MacOSX, they are in reality in the FileCloud server. 

So it is best to use FileCloud Drive for Mac to work with small to medium sized files, to edit documents 
and use it for uploading small number of files or downloading small documents etc. FileCloud Drive for 
Mac is more convenient than using the web portal to edit files because it avoids downloading the file 
first, editing and then re-uploading it back. This can be done seamlessly by just opening the document 
in the application via explorer, editing and then saving it to upload it back to the FileCloud.

Viewing FileCloud Drive for Mac Activity

FileCloud Drive for Mac provides a way that shows the activities being performed by FileCloud Drive 
for Mac and this provides "under the hood" view. 

Select the "View Activity" option in FileCloud Drive for Mac task bar menu
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FileCloud Drive for Mac Menu Options
This section describes the various menu options in FileCloud Drive for Mac.

Open 
Drive

This will launch a finder window to the mounted drive volume. If the remote server is not available 
or configured then nothing will be launched

Setting
s

This will display the dialog window to input new server information. If a server is already mounted, 
then it will be first unmounted and the new server will be mounted.

Run at 
Startup

This will start FileCloud Drive for Mac automatically when the user logs into the computer.

View 
Activity

Open a window that shows the current activity as well as transfer details

Check 
for 
Update
s

This will check if there is a newer version of FileCloud Drive for Mac is available

Help Launch browser to open online documentation

About Display version information
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Exit Unmount and exit FileCloud Drive for Mac application

Clear 
Cache

FileCloud Drive for Mac stores locally accessed file in a local cache. This cache location will be 
cleared when this option is selected and the volume will be remounted. Any further access to files 
will cause FileCloud Drive for Mac to download it first. Care must be taken to make sure there are 
no existing application are actively using files during this operation.

Open 
Log 
Folder

This option will launch explorer window to the location containing FileCloud log files. This is used 
for debug purposes.

Lock 
Automa
tically 
on Edit

This option will lock a file on file open action and will unlock a file on file cloud action. NOTE this 
function is a file system level behaviour and FileCloud Drive CANNOT KNOW IF A FILE IS 
OPENED IN AN APPLICATION AFTER THE CONTENTS ARE READ. This also attempts to detect 
special cases such as Microsoft Office apps and will attempt to keep the lock enabled when a 
document file is edited but changes in behaviour to MS Office apps can affect this algorithm.

Mute 
All 
Notifica
tions

FileCloud Drive for Mac will try to show notifications on various conditions and selecting this 
option will prevent those notifications from being displayed

Max 
Single 
File 
Limit

FileCloud Drive for Mac will cache a file locally when windows explorer requires it (Typically Finder 
will try to pre-cache files for quicker access or to display thumbnails or previews). The files are also 
cached on file open/copy operations. This option will set a limit to max file size that can be 
accessed. This is primarily meant to manage bandwidth usage .

How Can I Increase File Size Limits for FileCloud Drive for Mac?
FileCloud Drive for Mac downloads a file from server before it can be read/modified/updated FileCloud 
Drive for Mac. MacOSX can prefetch files to improve user experience and can request files that are not 
actively used . This can sometimes cause bandwidth usage. To limit this, FileCloud Drive for Mac has 
maximum file size limit setting to prevent downloading large files. This limit is set to 30MB by default. 
 You can change this value from the FileCloud Drive for Mac context menu.
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How to Fix Problems Uploading Large Files
If you are trying to upload a file of 3-5 GB to Drive for Mac and see an error message or a Waiting to 
Start message that doesn't disappear, you may be able to resolve the problem by granting Drive full 
disk access.

To enable full disk access:

1. Go to System Preferences > Security and Privacy.

2. Click the Privacy tab.

3. Click Full Disk Access in the left panel.

4. If the CloudDrive application does not appear in the window, click the +, and add it.
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Drive now has full disk access.

Proxy Server for FileCloud Drive for Mac
FileCloud Drive for Mac can use proxy server to connect with FileCloud server.

The information should be supplied when you log in to Drive for Mac.

1. Click Proxy Settings to open the Proxy settings dialog box.
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The Proxy settings dialog box opens.

2. Fill in the fields and click Save.

3. To log in to FileCloud, click Login.

Enable Right-Click Support in Drive for Mac
Starting in FileCloud Version 20.1, you can enable right-click support in Drive for Mac.

To enable right-click support in Drive for Mac:

1. Start FileCloud Drive for Mac.

2. Click the Apple logo in the top left corner of the page and choose System Preferences > 
Extensions.

3. In the left pane, click All.

4. Under clouddrive, check the box for Finder Extensions.
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5. To relaunch Finder, click the Apple logo in the top left corner of the page and choose Force Quit 
-> Finder -> Relaunch.

6. Restart your computer.

7. Start FileCloud Drive for Mac again.

Viewing a Crash Report for Drive for Mac
In addition to log file, if the app exits without user intervention,  a crash report file is also very 
useful.  

To get the crash report file:

1. In the Spotlight window, type "console"
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2.  Locate the "User Diagnostic Reports" section.

3.  Expand the User Diagnostic Reports section and locate the report that starts with 
"filecloudmacdrive" and the latest time stamp.

4. Right click the report and select "Reveal in Finder" and email that file.
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FileCloud Drive: Configuration for Big Sur 11.3 or later versions 
Running on Apple Silicon

To configure FileCloud Drive to use Big Sur 11.3 or later versions running on Apple Silicon:

1. Follow the instructions in macOS User Guide to change the level of security used on your startup 
disk to Reduced Security.

2. Install Drive for Mac.
When Drive attempts to start, the message System Extension Blocked appears.

Beginning  in FileCloud Version 21.1, Drive supports using Big Sur versions 11.3 and higher. 
However, you must configure a workaround for FileCloud to run the kernel extension (kext) that Drive 
uses.
Note that prior to version 21.1, Drive does not support Big Sur 11.3 or later versions.

Note: If you see the message, "FileCloudDrive" can't be opened because Apple cannot check 
if for malicious software, see the workaround below.

https://support.apple.com/guide/mac-help/change-startup-disk-security-settings-a-mac-mchl768f7291/mac#:~:text=In%20macOS%20Recovery%2C%20choose%20Utilities,Click%20Security%20Policy.
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3. To open Security and Privacy settings in MacOS, click Open Security Preferences.

4. Click Allow.

5. Click Restart.

6. When MacOS restarts, you can start Drive normally.
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How to uninstall FileCloud Drive for Mac
To uninstall FileCloud Drive for Mac, first you have to quit the Drive app.

Workaround
If you see this message when Drive initially attempts to open:

       
a. On the Drive icon, click CTRL + right-click and choose Open.

       
Drive opens.
b. Reboot your system.
c. Attempt to open Drive again.
    You should now see the System Extension Blocked message shown in Step 2, above, and can 
proceed to Step 3. 
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Then navigate to Applications, select Filecloud Drive for Mac and click Move to Trash. 

To clear the data of FileCloud Drive for Mac, please Contact FileCloud Support.

Enabling Thumbnail Previews in Drive for Mac
Drive for Mac must download all content within a folder in order to generate a thumbnail. To avoid 
potential performance issues, thumbnail previews are disabled by default in Drive for Mac, and files 
are only downloaded when selected. However, thumbnail previews may be enabled in Drive for Mac 
manually.

To enable thumbnail previews in Drive for Mac:

1. Log in to Drive for Mac.

2. At the bottom of the Drive dashboard, click the Settings button.
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3. Click the Enable Thumbnail Preview slider (so that it appears blue).

MacDrive file issues
FileCloud MacDrive may be unable to upload files and folders with the following naming 
characteristics.

Filename length limit

The MacOS operating system only allows file names of 255 characters or less.

Special Characters

FileCloud Drive doesn't upload some files with characters that are incompatible with certain operating 
systems. 

Please rename them to something more suitable for use across multiple operating systems.
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The following file names are also not uploaded.

 The * character

 The < character

 The > character

 The : character

 The \ character

 The / character

 The | character

 The ? character

 The * character

 tonido.db

 Thumbs.db

 desktop.ini

 *.tmp*

 *.~tmp*

 *.lnk

 Files or Folders ending with space 

 Files beginning with a space

 Files or folders ending with "." or ","

 .tonidocache

 Conflict_*.*

 sync.ico

 .ds_store

 Any hidden files (usually files starting with . in Linux and files with hidden attribute in 
windows)~*

 ~*

 *.fuse_hidden

 *.crdownload

 *.partial

 *.part

 *.download*

 *.MACTF

 *.dwl

 *.dwl2
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The following folder is not uploaded

*.sb-*
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FileCloud for Outlook Add-In
The FileCloud for Outlook Add-in enables you to save Outlook email attachments to FileCloud and 
attach FileCloud files to Outlook emails as attachments or share links.

The FileCloud for Outlook Add-in is available in:

 Windows and macOS

 the classic and the new Outlook interfaces

 Outlook desktop and Outlook Web

The FileCloud for Outlook Add-in can only be opened from within an email, either one you are 
composing or one you have received. The add-in appears as a side panel to the right of the email. 

Installing the add-in

For FileCloud admins

Central deployment
As an admin, you can deploy the add-in centrally using the Microsoft 365 Apps admin center. This 
enables you to control who has access to it, and to remove or add access at any time. In addition in 
enables you to automatically insert the add-in into the users' Outlook ribbon, eliminating the 
requirement that they install it themselves. 

To deploy the add-in centrally, see the Microsoft 365 Apps admin center.

User download
The add-in is also available in the Microsoft Office store for individual users. You can allow users to 
install the add-in from there, but you are not able to manage it centrally if they download it this way.  
User steps for installing the add-in are listed below under For FileCloud for Outlook Add-in users.

https://config.office.com/
https://config.office.com/
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For SSO login

To be able to log in with SSO, users must also have the Auth Agent application running on the client 
they are using to access Outlook. 
To install and run the SSO Auth Agent, see Install and Run the SSO Auth Agent .

For FileCloud for Outlook Add-in users

Check with your admin whether the Outlook add-in is available to you already when you click the Apps 
icon   in Outlook, or if you need to add it yourself from the Microsoft Apps store.

To install the add-in from the Microsoft Apps store:

1. Open Outlook, and click the Apps icon.

2. Then click Add apps.

3. In the window that opens, enter FileCloud for Outlook in the search bar.

4. In the window that opens, click Add, and then click Open.
The FileCloud for Outlook app is now added to Outlook.

5. To log in to the add-in with SSO, you must also download the FileCloud Helper service and run it 
on the client where you are running the add-in.
To install and run the SSO Auth Agent, see Install and Run the SSO Auth Agent .
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Logging in to the Outlook add-in

When you open the FileCloud for Outlook add-in, if you are not already logged in to FileCloud, you can 
log in through the add-in.
You can log in by entering your FileCloud server address, username, and password, or if it is enabled, 
you can click the SSO tab and log in using SSO. If 2FA is enabled, you are prompted to log in using 
MFA.

If you are logging into Outlook using SSO through Google Chrome, you must disable Local Network 
Access Checks.
To disable Local Network Access Checks in Chrome:

1. Enter the web address:
chrome://flags/#local-network-access-check

2. Change the setting for Local Network Access Checks to Disabled.

3. Restart Google Chrome.
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Opening FileCloud for Outlook from an email

1. Open Outlook.
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2. Click Home in the menu bar, and then click New mail.

An empty email opens.

3. Click the Apps icon , which appears when Message is selected in the menu bar, and choose 
FileCloud Outlook.

The FileCloud Outlook add-in opens as a panel to the right of the screen.

4. If you are not already logged in to FileCloud, log in.
All of your FileCloud folders appear in the Outlook add-in.
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Attaching a file from FileCloud to an Outlook email

1. Begin composing a new email.

2. Open and log in to FileCloud for Outlook, then navigate to the file that you want to add to the 
email, and select it.

3. Click the attachment icon at the bottom of FileCloud Outlook and choose Attach to Email.

An Attachment Options dialog box opens.
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4. Choose Attach as a File or Attach as a Link, and click Attach.
If you attach as a file, the file appears as an attachment in the email:

If you attach as a link, a share link appears in the email
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The type of share link created is the default share type in your FileCloud system. If the default share 
type in your system is Public, you are not prompted to do anything else.If the default share type in your 
system is Private, you are required to add share recipients. See Adding share recipients to a FileCloud 
share below.

Note: Once you insert the share link, the share is created in FileCloud, even if you do not send the email 
or if you delete the link.

Upload a local file to FileCloud and share in an email

When you are creating an email in FileCloud for Outlook, you can upload a local file to FileCloud, and 
once uploaded, it is automatically attached to the email as a share link.

1. Begin composing a new email.

2. Open and log in to FileCloud for Outlook.

3. Click the attachment icon at the bottom of FileCloud for Outlook, and choose Upload and Share.
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4. Select the local file that you want to upload and share.

5. You are prompted to choose a FileCloud folder:
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6. Navigate to your destination folder, check it, and click Select.
The file is added to the folder and added as a link to your email.

The type of share link created is the default share type in your FileCloud system. If the default share 
type in your system is Public, you are not prompted to do anything else. If the default share type in 
your system is Private, you are required to add share recipients. See Adding share recipients to a 
FileCloud share below.

Note: Once you insert the share link, the share is created in FileCloud, even if you do not send the email 
or if you delete the link.

Adding share recipients to a FileCloud share

If the default share type in your system is private, when you add a FileCloud share link to an email 
through FileCloud for Outlook, you are prompted to choose users to share with.
The email recipient is not automatically added to the share; if you want to add this recipient and other 
users, add them now.
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Add any number of users to the share, and click Done.
A confirmation that the users have been added to the share appears.
The share gives the user view and download permissions, and sets the other share options to the 
defaults for your system. Later, you can open the FileCloud user portal and change the share options.

If the default share type in your system is Public, the link is added directly to the email, and you are not 
prompted to do anything else.
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Attaching a large file to an email

The limit on the size of an email in Outlook is 20 MB. If including an attachment would cause the email 
to be greater than 20 MB, the FileCloud Outlook add-in attaches it as a share link instead, and it is 
added as a share in FileCloud.

As with other shares added to emails, the share is the default type in your system. If the default share 
type is private, you are prompted to add recipients.

Uploading an Outlook attachment to FileCloud

1. In the navigation panel click Inbox or Sent Items, and then open an email.
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2. In the upper-right corner of the email, click the Apps icon, and choose FileCloud Outlook.
(Click More if the Apps icon is not listed).

The FileCloud Outlook add-in opens as a panel to the right of the email.

3. If you are not already logged in to FileCloud, log in.
By default, the email's attachments are listed at the bottom of the screen, and the Save button is 
not yet available.
(You can also configure custom upload settings. See Automatically uploading an email 
attachment to FileCloud, below.)
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4. Navigate to and check the FileCloud folder you want to store the file in.

5. Click Save.
The file is now stored in FileCloud.

Automating attachment upload

You can specify a default FileCloud folder where Outlook attachments are saved.
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You can also automatically save attachments to that folder.

To enter upload settings:

1. After you open the FileCloud Outlook add-in in an email, click the cog icon next to the search bar.

Upload settings appear.
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To set up a default upload folder:

a. Click Select Default Folder.
Your FileCloud folders appear.

b. Navigate to a folder and select it.
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c. Click Save.

d. If you want email attachments to be automatically saved to your default folder when you 
open an email, enable Auto-Upload.
Note: The file is automatically saved only when the email is open and the Outlook add-in is 
opened beside it.
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When the FileCloud Outlook add-in is opened, if you have set up a default folder, but you have not set 
up auto-upload, the FileCloud dashboard gives you the option of saving to the default folder without 
requiring you to navigate to it:
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You can click Save to save to the default folder or navigate to another folder and select it, and then 
click Save.
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When the FileCloud Outlook add-in is opened, if you have set up auto-upload, the FileCloud dashboard 
uploads the email attachment to FileCloud when you open it. 

Restrictions on filetypes and file extensions in FileCloud

Please note the following restrictions when uploading files to FileCloud:

 Files with the same name:

 If you upload a file with the same name and the same case as another file in the same 
folder, it overwrites the file.

 If you upload a file with the same name but a different case than another file in the same 
folder, you cannot upload the file and the File Operations window displays a file name 
conflict message.

 If you upload files with the same name but different file extensions, like myfile.doc and 
myfile.docx, they are treated as different files.

 FileCloud cannot upload files with leading spaces in the filename.

 By default, files with the extensions php, php5, phar, and phtml cannot be uploaded into 
FileCloud.

For Admins

 To specify which file extensions may be uploaded into FileCloud, see Managing File Extensions
and Restricting File Extensions.

 To restrict certain filenames from being uploaded into FileCloud, see Restricting File Names.
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Troubleshooting

I am not able to see the FileCloud Outlook add-in inside Outlook.

At times, MS Outlook may disable an add-in if there is a 0.234 second delay in starting Outlook for any 
reason.   In Outlook, go to File > Options > Add-Ins.  Find the FileCloud Outlook Add-In from the 
disabled add-ins list and enable the add-in. You can set Outlook to always enable FileCloud Outlook 
add-in so that it does not get disabled.

Install and Run the SSO Auth Agent
To log in to the Microsoft Outlook Add-in for FileCloud with SSO, you must have the SSO Auth Agent 
running on the client.

1. On the device that you'll be using the Microsoft Outlook Add-in for FileCloud, go to https://
www.filecloud.com/additional-downloads/ and click the Add-ons tab:

2. Click the Download button for SSO Auth agent for Mac or SSO Auth agent for Windows
depending on your system.
The download is installed on your client.

3. Locate the Auth Agent installer exec in your downloads and open it.
The installation wizard opens:

https://www.filecloud.com/additional-downloads/
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4. Choose Anyone who uses this computer or Only for me, and click Next.
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5. You may change the Destination Folder.

6. Click Install.
When installation is complete, the wizard displays the screen:
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7. Leave Run FileCloud Auth Agent checked, and click Finish.

8. If you are prompted to install certificates, accept the prompts. Icons appear on your screen and 
in your tray to indicate that the Auth Agent is running:

9. If you accidentally reject installation of the certificates, install them by right-clicking the icon in 
the tray and choosing Trust FFOL.
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Integration With Office
FileCloud allows users to share any file or folder with custom permissions.

Install the FileCloud Office Add-In
The FileCloud Office Add-In is the recommended tool for adding FileCloud as a place because it 
provides a richer experience.

 It supports more versions of Microsoft Office and allows you to configure some of the 
associated settings. 

 Installing the FileCloud Add-In allows you to work from your own workspace using your own 
software.

Installing the Office Add-In

To install the FileCloud Office Add-In:

1. Meet System Requirements

System Requirements

Requirement Version Notes

OS Windows 7 and above Older versions of Windows may work but have not 
been tested

Microsoft Office Subscription to the latest version 
is recommended

Microsoft Office 2007 is the minimum version tested

2. Install the Add-In

To install the FileCloud Office Add-In:

1. Download and install the FileCloud Office Add-In through the link in your FileCloud customer 
portal.

2. Accept any security warning and continue installation.

3. Once the installation is complete, restart any open MS Office applications, such as Word or 
Excel.

Once installed, FileCloud will appear as a Ribbon on the main window with the following buttons:
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 Open (from FileCloud)

 Save (to FileCloud)

 Save As (to a new name or location in FileCloud)

 Settings (specify login credentials, default folders, and any proxy settings)

3. Enter Your Login Credentials

The login credentials, when set, are encrypted and stored securely.

To enter your FileCloud credentials:

1. In your MS Office application, on the FileCloud menu, click the Settings icon.

2. Click the Account Settings tab.

3. In Domain URL, enter the FileCloud URL.

4. In Username, enter the name you use to log in to FileCloud.

5. In Password, enter the string of numbers, letters and characters you use to log in to FileCloud.

6. Click Login.

4. Specify a Default Folder

If you do not specify a default folder, you will be prompted for a folder path every time you upload a 
file. If you have one place where you consistently save files, you can avoid this prompt and specify a 
default upload folder. 
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To specify a default upload folder:

1. In your MS Office application, on the FileCloud menu, click the Settings icon.

2. Click the Upload Folder tab.

5. Configure Proxy Settings

If your network uses a proxy server or you want the FileCloud Office Add-In to use a proxy server, you 
can configure proxy settings.

 To get the Proxy Server Address, Port, Username and Password to connect to your proxy server, 
contact your network administrator.

To configure proxy settings:

1. In your MS Office application, on the FileCloud menu, click the Settings icon.

2. Click the Proxy Settings tab.

Using the Office Add-In

To Use the Add-In Options:

1. To open a file, in your MS Office application, on the FileCloud menu, click the Open icon.

2. To Save a file to FileCloud,  in your MS Office application, on the FileCloud menu, click the Save 
icon.

  If the file was originally opened from FileCloud, the file will be automatically saved to that 
corresponding folder in FileCloud. 

  If the file is new, then you must choose the FileCloud path to save the file.

3. To save the file to a different location or with a different name, in your MS Office application, on 
the FileCloud menu, click the Save As icon.

Configure Sync for Edit in Desktop
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Edit in Desktop allows you to select a document file from the Web UI and automatically open it locally 
in its native document editor. Changes you save automatically appear in the cloud as new versions. 
This function is ideal for users who need to edit files on their desktops, but don’t want to install 
FileCloud Drive or sync all files to their local machine. It's also more convenient than downloading, 
editing, saving and uploading the saved version back to the cloud. 

File types supported in Edit in Desktop include DOCX, DOC, PPTX, PPT, XLSX, XLS, IDD, PSD, XLSB, TXT 
and MD.

To perform Edit in Desktop, first install the Sync application locally on your computer.

When setting up account information, you may select the option to disable syncing and only provide 
document editing support. If you leave it unchecked, you will be able to use Edit in Desktop as well as 
Offline Syncing.

Next select any file in the web browser, and then click on the Edit in Desktop option to download and 
open the file in the local document editing application.

Edit in Desktop requires the Sync App to be installed on the local computer.
Edit in Desktop does not work when the Sync App is set to run as a service.
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The document is opened in an editor, for example, Microsoft Word. Simply edit as you would normally 
and then click save. The file is saved to the server and a notification shows that the version has been 
saved.

You can continue to edit the document and save it. Each time you save it a new version is uploaded.

Note for Administrators:

To enable Edit in Desktop, you must check the customization option in the Admin control panel.
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Go to Customization →  General → UI Features → Show Edit in Desktop Option.

Access Files Using Mobile Apps
To access Office documents in iOS, see FileCloud iOS Integration with 3rd Party Apps.

To access Office documents in Android, see Using FileCloud with Other Android Apps.

Enabling DocIQ

New FileCloud Sync and FileCloud Drive users: DocIQ has been replaced with FileCloud for Office. 
Please go to Using FileCloud for Office.

Current FileCloud Sync and Drive users (DocIQ users):
DocIQ is entering the end-of-life process and will no longer be available for download as of October 
1, 2024. Support will no longer be available as of December 31, 2024. For more information, see 
https://www.filecloud.com/end-of-life-policy/. 

https://www.filecloud.com/end-of-life-policy/
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DocIQ is a Microsoft Office add-in for FileCloud Sync and FileCloud Drive clients. 

DocIQ works with the following Microsoft Office applications:

 Word 
 Excel
 PowerPoint

What does DocIQ do?

DocIQ works with Office documents to help you manage shared files.

DocIQ gives you the ability to:

 manage file locking
 collaborate with your colleagues through comments 
 see how shared files are being managed 

How do I use DocIQ?

1. You open an Office application such as Word, Excel or 
PowerPoint.

2. Inside the Office application, you open a file saved to a 
FileCloud Sync or FileCloud Drive folder.

3.  DocIQ displays as a task panel inside the Office application 
with the following information:

 File details

 Lock status

 File sharing details

 Comments attached to the file

How do I install and work with DocIQ?

1. Install DocIQ.
2. Configure DocIQ.
3. Work with file locking.
4. Troubleshoot Doc IQ issues.

Now, when you upgrade FileCloud Sync or FileCloud Drive, you are given the choice of using 
FileCloud for Office or continuing to use DocIQ. Although you can continue to use DocIQ with the 
current release, we recommend using FileCloud for Office.
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FileCloud File Browser

The FileCloud File Browser lets you work in a file explorer format where you can perform the 
same view, share, edit, and delete file operations that you perform in the user portal. 

Install and open File Browser

Running File Browser

To start File Browser when it is not running, in your system navigation panel, open the File Browser 
folder and click the File Browser icon.

FileCloud File Browser is entering the end-of-life process and will no longer be available for 
download as of October 1, 2024. Support will no longer be available as of December 31, 2024. For 
more information, see https://www.filecloud.com/end-of-life-policy.

https://testbed.filecloudlabs.com/end-of-life-policy/
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File Browser opens:

System tray icon

When File Browser is running, an icon appears in your system tray. Right click on it to see the following 
options;

 Open Website - Opens FileCloud in the user portal.

 File Browser - Opens the File Browser.

 Search the Cloud - Opens the File Browser search dialog box.  See Search for a File or Folder in 
File Browser.

 Run at Windows Startup - Enabled by default. File Browser starts when you start your system.
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 Logout - Log out of File Browser. You will be prompted to log in again.

 Exit - Close File Browser without logging out. The icon disappears from the system tray.

In this section

Perform File Actions in File Browser
The following actions can be performed on files and folders in File Browser. These actions occur in 
real-time, and are reflected in the user portal soon after they occur.
Many of the actions can be performed by right-clicking on the file or folder and then choosing a menu 
option:

Browsing files

There are several ways you can navigate to locations in the remote FileCloud server in File Browser.

 Use the left folder tree to navigate to different folders.
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 Double-click folders on the right folder listing.

 Enter the full path in the path entry text area, and then press enter.

 Navigate to older locations that you previously visited by using the History back and forward 
arrows.

 In any file listing, select the Refresh icon, or click F5 to refresh the listing.

Creating a new folder

Select the Create Folder icon to create a new folder in the current location.

Deleting Files and Folders

You can delete a file or folder in File Browser.
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Right-click the item you want to delete, and choose Delete.

  Alternatively, select items you want to delete and choose the Edit menu and select the Delete  
option.

Downloading a file

You can download a file in File Browser

1. Right-click the item you want to download and choose Download.
Your file system's explorer window opens.

2. Choose the location where you want to store the downloaded file and select it.

Editing a file

From File Browser, you can quickly open a file for editing in the application you have associated with it 
in your system.

To edit a file:

1. Double-click the file or right-click on it and choose Quick Edit. 
The file opens for editing.

2. Make changes and then click Save.

Locking and unlocking files and folders

You can set a lock to prevent other users from opening a file or folder.

Locking tells other users that you are actively using the file or folder.

When a file or folder is locked, the following conditions apply:

 The owner of the lock has full access to that file or folder and can modify it

 An Admin can always override the lock

 Users cannot download the locked file or folder

 Users cannot view the locked file or folder

 Users cannot modify the locked file or folder

When you lock a file or folder, all of the FileCloud client apps and the FileCloud user portal are subject 
to the lock restrictions.

To lock a file or folder

Right-click the item you want to lock, and then select Lock.

A message indicates if the lock is successful or not.

To unlock a folder:

Right-click the item you want to unlock, and then select Unlock.

A message indicates if the lock is successful or not.

Moving or copying files and folders

You can move or copy a file or folder in File Browser.
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1. Select items you want to move and choose the Edit menu and select Cut or Copy. 

2. Navigate to another path and choose the Edit menu and select Paste.

Renaming files and folders

You can rename a file or folder in File Browser.

1. Select item you want to rename and choose the Edit menu, and select Rename.

2. Type in the new name, and click Enter or OK.

Uploading files and folders

You can drag and drop files or folders into the right folder listing to upload the files directly to 
FileCloud.
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You can also use the following icons located in the top bar to upload a file or upload a folder.

 Clear the pending upload or download queue items by selecting the View menu and selecting Clear 
Queue.

Restrictions on filenames and file extensions in FileCloud

Please note the following restrictions when uploading files to FileCloud:

 Files with the same name:

 If you upload a file with the same name and the same case as another file in the same 
folder, it overwrites the file.

 If you upload a file with the same name but a different case than another file in the same 
folder, you cannot upload the file and the File Operations window displays a file name 
conflict message.

 If you upload files with the same name but different file extensions, like myfile.doc and 
myfile.docx, they are treated as different files.

 FileCloud cannot upload files with leading spaces in the filename.

 By default, files with the extensions php, php5, phar, and phtml cannot be uploaded into 
FileCloud.
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Viewing and clearing the log and the queue

You can view log messages to troubleshoot File Browser issues, or clear the log if it is getting too 
large. You can also view and clear the queue of pending and current actions.

To view the log or queue:

1. In the View menu, choose Logs and Queue.

2. By default, the Log tab opens; click the Queue tab to view the queue.

To clear the log or queue:

In the View menu, choose Clear Queue or Clear Log.

Viewing file information and versions

For Admins

 To specify which file extensions may be uploaded into FileCloud, see Managing File Extensions
and Restricting File Extensions.

 To restrict certain filenames from being uploaded into FileCloud, see Restricting File Names.
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You can view information about file size, create dates, and permissions, and download previous file 
versions in the Details tab of a file's properties.

To access file details and versions:

1. Right-click the item you want to view the properties for, and then select View FileCloud 
Properties.
The FileCloud Properties dialog box opens to the Details tab. On this tab you can view 
information such as file size, create date, and your permissions for the file (hover over the icons 
to see the types of permissions).

2. Click the Edit icon next to Versions to open a list of versions that enables you to download each 
version.

Working with metadata

You can view the metadata attributes for a file, or add an attribute if your administrator allows it.

To view or add metadata:

1. Right-click the item you want to access the metadata for, and then select Properties.
The FileCloud Properties dialog box opens.

2. Click the Metadata tab.
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3. Use the following instructions to manage metadata.

Search for a File or Folder in File Browser
You can search in a folder that appears on the left or right side in File Browser

To search in File Browser:

1. Select a folder in the left panel, and click Search in the menu bar. Then choose Search the Cloud 
for Files/Folders;

OR
Right-click a folder in the right panel, and choose Search;
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OR
Right-click the system tray icon and choose Search the Cloud.

A FileCloud search dialog box opens. It shows the folder path you selected.

2. Enter a search term.
Your search results are returned.
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3. 

4. Right-click a result, and choose Open directory to open the directory in File Browser if it is not 
already open.
Right-click a result, and choose Open browser to open it in the FileCloud user portal.

Click Advanced Options to open advanced search options. For help using these options, see Search.

Share a File or Folder in File Browser
You can share a file or folder from File Browser.

To share a file or folder:

1. Right-click the item you want to share, and select Share.
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A box with a link to the share opens:

 This link is public by default and can be accessed by external users.

 When you share the link with someone, they can access the file even if they do not have a 
FileCloud account.

 You can set advanced options to share the file or folder privately, too.

2. To copy the URL to your clipboard, click Copy URL.
Use the URL you copied to share your item.
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3. To share privately or access advanced share options click Advanced.
A Manage share for file dialog box opens.

See the section Sharing Files and Folders for complete information about sharing and instructions on 
using advanced share options.
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FileCloud WebDAV Access

FileCloud supports the WebDAV protocol to allow accessing your files using a WebDAV client.

Web Distributed Authoring and Versioning is an extension of the Hypertext Transfer Protocol that 
allows clients to perform remote Web content authoring operations.

FileCloud WebDAV Access

Use the following information to use a WebDAV client to access your storage space. 

 In FileCloud 23.241 (December 31, 2024), support for WebDAV in FileCloud ended. For more 
information, see https://www.filecloud.com/end-of-life-policy

 Prior to this, in FileCloud 23.1, as part of the end-of-sale process, WebDAV could no longer be 
enabled or managed through the FileCloud admin portal. The documentation on this page only 
applies to customers who are using FileCloud versions prior to this.

2FA login is not supported for WebDAV.

Ensure that WebDAV is enabled in your server by your Administrator.

WebDAV URL: http://site/webdav/
Username: useraccount
Password: yourpassword

NOTE the trailing slash after "webdav" in the URL. Clients will fail without it
 

https://testbed.filecloudlabs.com/end-of-life-policy/
http://site/webdav/
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WebDAV Client Compatibility

WebDAV Client Browsing 
Folders

Download 
Files

Create 
Folder

Delete Files/
Folders

Upload 
File

WebDAV Navigator (iOS) YES YES YES YES YES

BitKinex 3.2.3 (Windows) YES YES YES YES YES

My WebDav (iOS) YES YES YES YES YES

Finder (Mac OSX) * YES YES YES YES YES

WebDrive (Windows) YES YES YES YES YES

Mac OSX Finder 
Finder generates a lot of unnecessary WebDAV requests. When coupled with AD or LDAP 
authentication this can be slow.
To mount FileCloud WebDAV in Mac Finder: See this link

https://itunes.apple.com/in/app/webdav-navigator/id382551345?mt=8
http://www.bitkinex.com/download
https://itunes.apple.com/us/app/my-webdav/id514325817?mt=8
https://www.webdrive.com/product-downloads/
https://support.apple.com/kb/PH23723?viewlocale=en_US&locale=en_US
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WebDAV Client Browsing 
Folders

Download 
Files

Create 
Folder

Delete Files/
Folders

Upload 
File

NetDrive 1.3.2 
(Windows)

YES YES YES YES YES

CyberDuck 4.3.2 
(Windows & OSX)

YES YES YES YES YES

Microsoft Windows 
Explorer

NO NO NO NO NO

Apple Pages (iOS) YES YES NO NO NO

Office2 HD (iOS) YES YES NO NO YES

OfficeSuite Pro (iOS & 
Android)

YES YES YES YES YES

Documents (iOS) YES YES YES YES NO

Dav -E (iOS) YES NO YES YES YES

Kingsoft Office (iOS & 
Android)

YES YES NO NO NO

Transmit (Mac OSX) YES YES YES YES YES

http://www.netdrive.net/download.html
https://cyberduck.io/?l=en
https://itunes.apple.com/in/app/pages/id361309726?mt=8
https://itunes.apple.com/en/app/office2/id350399839?mt=8
https://itunes.apple.com/in/app/officesuite-pro-microsoft/id675054186?mt=8
https://play.google.com/store/apps/details?id=com.mobisystems.editor.office_registered&hl=en
https://itunes.apple.com/in/app/documents-5-fast-pdf-reader/id364901807?mt=8
http://www.kingsoftstore.com/office-free-ios
http://www.kingsoftstore.com/download-office/android-office-apps
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Save to FileCloud Chrome Browser Extension

Save to FileCloud chrome extension allows users to right click any file (documents, images, audio and 
video) and save to FileCloud.  One can take screenshots of entire page and save to thier respective 
FileCloud account. This extension is useful in activities such as product research, market research, 
web design and others.  Users can also choose the target folder where one want to store the files.

1.  Once the extension is installed, set your FileCloud site URL and click connect. If you have not 
logged into your FileCloud portal, you need to first login.  The default upload path for files is My 
Files. But you can choose an another folder.

2. You can take page screenshot by clicking the "Save entire page ScreenShot". The screenshots 
are automatically uploaded to your FileCloud target directory that you specified. This action is 
also available from browser context menu.

The FileCloud Chrome extension is entering the end-of-life process and will no longer be available for 
download as of October 1, 2024. Support will no longer be available as of December 31, 2024. For 
more information, see https://www.filecloud.com/end-of-life-policy.

https://testbed.filecloudlabs.com/end-of-life-policy/
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3. You can right click an image and Save to FileCloud.

4.  You can right click any document and save that file to FileCloud.
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5. You can right click any file and save that File to FileCloud. While saving, you can also rename the 
file name and change the destination folder
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FileCloud for Gmail Browser Extension

FileCloud for Gmail chrome extension enables users to share files directly from FileCloud without 
leaving their Gmail compose window.  When users share files they can share it as a FileCloud link or as 
a regular file attachment. 

 Users can also store email attachments directly to FileCloud from Gmail.  One can also quickly find 
files using FileCloud search tool to share the file. This extension is really useful for organizations who 
use Gmail as their primary email app.

1.  Once the extension has been installed in your browser, click the FileCloud icon on the Gmail 
compose window. If you have not logged into your FileCloud portal, you need to first login

2. Once you login, you can select a file to share as a link or on attachment.

3. You can also search for a file and share as a gmail attachment.

4. One can also save an attachment directly to FileCloud.

The FileCloud for Gmail extension is entering the end-of-life process and will no longer be available 
for download as of October 1, 2024. Support will no longer be available as of December 31, 2024. 
For more information, see https://www.filecloud.com/end-of-life-policy.

https://testbed.filecloudlabs.com/end-of-life-policy/
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FileCloud Desktop for Windows

FileCloud Desktop for Windows enables you to access your FileCloud files and folders in Windows file 
explorer, where you can work with them online or make them available offline. Changes you make to 
offline files stored in FileCloud are immediately synced to the copies in FileCloud.

FileCloud Desktop for Windows opens as a dashboard that shows you live and recent actions and the 
folders you have downloaded offline, and also gives you access to user settings:

The following features are available beginning in FileCloud Desktop for Windows 23.253:

 Viewing content of WebDRM files

 Self-service user interface customization

 Conflict icons
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When you open FileCloud Desktop, its FileCloud folder becomes available in your Windows explorer. 
From there, you can work with your files online, or download them and work with them offline. Your 
online files and folders appear with cloud icons beside them. When you work with them, you are 
working with the copies in FileCloud, and if you view your user portal, you can see the modifications 
there. Your folders downloaded from FileCloud Desktop as offline folders and their files are marked 
with green icons with white check marks. When you work with them, you are working with downloaded 
copies of the files in FileCloud offline folders, and if you go offline, your changes are not synchronized 
to FileCloud until you go back online.

When a file in Window Explorer's FileCloud folder is opened, the file is temporarily downloaded, but not 
into FileCloud Desktop's offline folders, and it is not synced with FileCloud when you go online. The 
temporarily downloaded files are marked with a white icon with a green check mark.

Files shared with the Secure Web Viewer requirement can be viewed through the Secure Web Viewer 
from FileCloud Desktop. The files appear in the FileCloud root under Shared with Me with a .webdrm 
extension as they would in the web browser. Click Open to view a .webdrm file through the Secure 
Web Viewer.

Sync Status
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When you right-click on a file or folder in the FileCloud Desktop folder, the options Always keep on this 
device, Free up space, and FileCloud Desktop appear in the context menu. These options enable you 
to make files and folders available offline, remove downloaded copies to free up space, and to perform 
FileCloud Desktop tasks. 
FileCloud Desktop tasks include:

 Open in Browser - Open the file or folder in the FileCloud user portal

 Share - Share the file or folder. See Sharing Files and Folders for help.

 Lock - Lock the file so other users cannot edit it.

 Unlock - Unlock a file you have locked so other users can edit it.

 Direct Link - Copy the share link so that you can paste it into a message or email to send to 
users. Only available for items in Team Folders, Shared with Me, and Network Folders.

Notes:

 You may have to right-click directly on the file or folder name to view these options.

 On Windows Server 2019 right-click options are not supported.

If a file or folder is currently being synced with FileCloud, a double arrow icon appears in the Status 
column:

If a file or folder is waiting to be synced with FileCloud, a double arrow icon with an x icon next to it 
appears in the Status column:

If a file or folder is only available online, and therefore cannot be synced, a cloud icon with a not 
available offline icon appears in the Status column:
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FileCloud Desktop automatically installs with FileCloud for Office (FFO), which enables you to 
automatically lock and unlock Office files and share them when you open them from the FileCloud 
Desktop directory.

Begin by installing FileCloud Desktop, and then try out its various functions.

Installing or Upgrading FileCloud Desktop for Windows

To install or upgrade FileCloud Desktop on Windows:

You must have FileCloud 23.232 or higher installed in order to use FileCloud Desktop for Windows.

The supported OS versions for FileCloud Desktop for Windows are:
Windows 10
Windows 11
Windows Server 2019
Windows Server 2022

Note: Windows Server 2016 is not supported for FileCloud Desktop for Windows.

After you initially install FileCloud Desktop for Windows, it updates automatically, and you are not 
required to perform the following process to upgrade (unless you are using a version of FileCloud 
prior to 23.261).
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1.  Uninstall FileCloud Sync if it is installed on the same machine that you are installing FileCloud 
Desktop on; otherwise, FileCloud Desktop will not work properly.

2. Install FileCloud 23.232 or higher if you have not already done so.

3. Run FileCloudDesktopInstaller.msi.
The installer's welcome screen opens:

4. Read the license agreement, and check I accept the terms in the License Agreement.

5. Click Install.
Installation begins. The wizard shows you installation status.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for Windows – 364

When installation is complete, the following screen appears:
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6. Click Finish.
The FileCloud Desktop login page opens.

To migrate from FileCloud Sync to FileCloud Desktop for Windows:

1. Upload all files and folders that you want to migrate from FileCloud Sync to FileCloud Desktop 
for Windows to the FileCloud server.

2. Uninstall FileCloud Sync.

3. Install FileCloud Desktop for Windows following the procedure above in To install or upgrade 
FileCloud Desktop on Windows.

4. When you log in to FileCloud Desktop for Windows, a new sync root for the application is 
populated from the server with your files.
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How autoupdates work

If an autoupdate is available when a user is logged out of FileCloud Desktop for Windows, updating 
automatically occurs.

If an autoupdate is available when a user is logged in to FileCloud Desktop for Windows (or when a 
user logs in), the user is prompted with the message:

If the user clicks Install, FileCloud Desktop is upgraded and the application restarts automatically.

If the user cancels without installing, upgrade either occurs when FileCloud Desktop is not running, or 
when the user logs in, sees the install prompt again, and chooses Install.

Opening and Logging in to FileCloud Desktop in Windows

Initially, the login page for FileCloud Desktop opens after you install it. After that, by default, it opens 
automatically when you start up your computer. If you do not want it open automatically on startup, 
you can change the setting in FileCloud Desktop. 

Beginning in FileCloud 23.261, FileCloud Desktop for Windows is updated automatically by default.

The option to choose the drive letter that displays the FileCloud for Desktop folders in Windows 
explorer is available beginning in FileCloud Desktop for Windows 23.253.
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To open FileCloud Desktop's login screen, search for FileCloud Desktop in the Windows Start menu, 
and choose Open.

Log in using one of the following methods:

Log in with password
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Leave Password selected for Login Method, and enter your Server URL, Account Name (username), 
and Password into the Log in screen, and click Log in:

Log in with SSO

1. Select SSO for Login Method.
The screen changes; now it only displays a field for Server URL.

2. Type the address to the FileCloud server that was sent to you when your FileCloud account was 
created, and click Log in.
You are redirected to the SSO Login page, where you can enter your username and SSO 
password to log in. 
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Log in with Device Authorization Code

1. Select Device Authorization Code for Login Method.
The screen changes to:
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2. Enter your Server URL and Account Name (username).
An Enter Device Code dialog box opens.

3. Click Open Website.
The log-in screen of the user portal opens.

4. Log-in to the user portal.

5. In the upper-right corner of the screen, click your username and choose Settings.

6. In the Settings screen, click Devices.
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7. Next to the listing for FileCloud Desktop, click the check.

A dialog box with the device authentication code opens.

8. Enter the authentication code into the Enter Device Code dialog box, and click Submit.

The next wizard screen includes an option for selecting Mount Point, a drive letter that your FileCloud 
Desktop files. A Mount Point ensures correct functioning if your content uses Excel macros or cross 
references other files. Only specify it in these scenarios; otherwise, leave the setting at Default.

1. To choose a Mount Point, enable the toggle next to default.
The drop-down list now shows the available mount point letters:

Although the drive letter appears in Windows Explorer, you are not intended to work with the 
FileCloud Desktop files from that location; work from them in the FileCloud Desktop root that is 
selected when you click the folder icon in the dashboard.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for Windows – 372

2. Choose a letter.
Your FileCloud Desktop files will appear in Windows explorer at that location, but you cannot 
work with them from there; continue to work with them from the FileCloud Desktop root.

Continue to move through the wizard until the dashboard opens to the Live screen. FileCloud Desktop 
cannot begin tracking and synchronizing online and offline FileCloud file activity until you download 
FileCloud folders and files to your local drive. So initially, the Live tab appears empty.
Click the folder icon at the bottom of the FileCloud Desktop dashboard to view the FileCloud folder, 
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which now appears in File Explorer.

If this is the first time you have logged in to FileCloud Desktop, each file and folder should appear with 
a cloud icon next to it, which indicates that it hasn't been downloaded locally (made available offline) 
yet.
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Begin setting up FileCloud Desktop by making FileCloud files and folders available offline.

For more information about the dashboard, see Using the Dashboard in FileCloud Desktop for 
Windows.

Push service is down 

If the Push service is down warning appears at the top of your dashboard, you are unable to sync files 
and folders. Please contact your admin, who is able to restart the service so that you are able to sync 
files and folders again.

Admins: If users are seeing the Push service is down warning, restart the Push service from the 
FileCloud admin portal.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for Windows – 375

Working from the FileCloud Desktop for Windows Taskbar Icon
After you log in to FileCloud Desktop for Windows, a FileCloud icon appears in the taskbar. You can 
right-click on the icon to perform FileCloud Desktop tasks.

 Open Dashboard - Opens the FileCloud Desktop for Windows dashboard.

 Log out - Logs the currently logged in user out of FileCloud Desktop for Windows without 
shutting down the application.

 About FileCloud Desktop - Shows details about the FileCloud Desktop build:

 Exit - Closes the FileCloud Desktop for Windows application.

On file conflict

If there is an existing file conflict, an additional task is listed:

 Show Conflicts

Clicking on it takes you to the Recent Activity tab in the dashboard where the conflict is listed. See 
How FileCloud Desktop for Windows handles change conflicts for more information about file 
conflicts.
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Using the Dashboard in FileCloud Desktop for Windows
FileCloud Desktop for Windows opens to its dashboard, which has the tabs Live, Activity, Offline, and 
Settings, and a button for opening your FileCloud website (in Windows explorer).

Live tab
The dashboard opens to the Live tab, which shows current uploads and downloads of files and 
folders. 

 You will only see uploads and downloads that take a substantial amount of time in progress. To 
search for a file or folder in the list, enter a string from its name into the Filter items box.
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Activity tab
To view a list of recent FileCloud Desktop activities, click the Activity tab:

To filter activities on the Activity tab
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 To filter activities by activity type, choose an option in the Activity drop-down list.

 To filter activities by date, choose Any date, Last hour, or Last 24 hours in the Date drop-down 
list.
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 To filter by any string in the listing (including the action, file path, date, or time) enter the string 
into Filter items.
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Offline tab
To view files and folders that you have moved offline using FileCloud Desktop, click the Offline tab.

 To remove folders from the offline location from the Offline tab, see Remove Files from Offline 
Folders.

 To open an offline folder in its location in Windows explorer, click the folder icon next to it.

Settings tab
To view FileCloud Desktop for Windows settings, click the Settings tab.
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For information about FileCloud Desktop settings, see FileCloud Desktop for Windows Settings.

More Options
To access more options from the FileCloud Desktop for Windows dashboard, click the arrow next to 
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the user image:

 To open your FileCloud user portal, click Open website.

 For this end user help, log files, and the version of FileCloud Desktop for Windows that you are 
running click Help.
The following dialog box opens:

 Click FileCloud Desktop help to access this end user help.
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 Click Get logs to access the contents of the Logs folder for FileCloud Desktop.

 To log out of FileCloud Desktop for Windows, click Log out.

 You are warned that logging out will clear and remove the FileCloud folder that appears in the 
Windows Explorer, and asked to confirm.

 Click Log out.
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FileCloud Desktop for Windows Settings

To change your settings in FileCloud Desktop, click the Settings tab at the bottom of the dashboard.

Setting Description

Mute all 
notifications

When enabled, all notifications sent from FileCloud Desktop are turned off.

Default is disabled.

Lock 
automatically on 
edit

When enabled, files opened for edit through FileCloud Desktop are locked, and other 
users cannot edit them. When the files are closed they are unlocked again.

Default is disabled.

This feature is not available in the current FileCloud Desktop for Windows 
beta version. The option may be set to enabled, but the feature remains 
disabled.
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Setting Description

Trust FileCloud 
for Office/
FileCloud for 
Office 
integration

FileCloud for Office is an add-in that allows users to:

 Automatically lock Office files when they open them
 Share Office files while working with them in FileCloud clients

When you initially install FileCloud Desktop, the Trust FileCloud for Office button 
appears. Click it to use FileCloud for Office.
After you click the button, it disappears, and the FileCloud for Office integration 
setting is enabled, which means FileCloud for Office is active. 
When FileCloud for Office is disabled, FileCloud Desktop does not integrate with 
FileCloud for Office.

Default is disabled (FileCloud for Office is available and appears in FileCloud Desktop).

Run at system 
startup

When enabled, begin running FileCloud Desktop when the system starts.

Default is disabled.

App language User interface language. Change to any of the language options.

Default is English.

Sync frequency 
(minutes) 

Interval between automatic sync events for Network Folders. Choose any interval in 
the drop-down list.

Default is 10 minutes.

Make Files and Folders Available Offline in FileCloud Desktop for 
Windows
To use FileCloud Desktop for Windows to synchronize offline and online changes you make to 
FileCloud files and folders, first download the folders with contents that you want to synchronize. 

When you log in to FileCloud Desktop, your FileCloud files and folders become available in File Explorer 
in a FileCloud folder:

To make files and folders available offline:

1. In File Explorer, locate the FileCloud folder. 
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2. Right-click on each file or folder that you want to be able to synchronize, and choose Always 
keep on this device. 
Note: You may have to right-click directly on the file or folder name to bring up the correct 
options.

FileCloud downloads the file or the folder and its contents to your local drive (and moves it into 
its offline folder), and replaces the cloud icon with a green circle icon to indicate that it is 
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available offline. Changes to the offline files are now synced with the copies in FileCloud.
Note: If you click Open or Open with next to a file you can edit it offline, but its changes aren't 
synced with FileCloud. A file downloaded with Open has a white circle icon with a green check. 
You are still able to choose Make available offline and put it into a FileCloud offline folder that 
will sync with FileCloud.
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FileCloud Desktop's dashboard shows you the progress of the files being downloaded on the 
Live tab. These disappear as soon as download is complete.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for Windows – 390

On the Activity tab, FileCloud Desktop shows you the download actions for the same files. 
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The Offline tab shows you folders that you have stored offline:

Remove Files and Folders from Offline Folders for FileCloud 
Desktop for Windows
You can remove an offline folder, either through the FileCloud Desktop dashboard or through File 
Explorer.

To remove an offline folder through the FileCloud Desktop dashboard:

1. In the FileCloud Desktop dashboard, click the Offline tab.

2. Click the Remove button next to the folder that you want to remove as an offline folder.
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The folder is no longer an offline folder. It no longer appears on the Offline tab of the FileCloud 
Desktop dashboard and the FileCloud Desktop offline icon no longer appears next to it in the File 
Explorer. 
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To remove an offline file or folder through Windows explorer:

1. In Windows explorer, right-click on the file (it should have a green icon next to it).
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2. In the drop-down list, Always keep on this device is checked. Click it to remove the check and 
remove it as an offline folder.
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The green circular icon is replaced with a white circular icon, which indicates that the file is still 
downloaded but not marked for syncing with FileCloud as an offline folder.

The file is also no longer listed on the Offline tab of the FileCloud Desktop dashboard.

To free up local space:
When a file or folder is downloaded locally, but not stored as a FileCloud offline file or folder for 
syncing with FileCloud, you can delete the local version to free up space.

1. In Windows, right-click on a file that is marked with a white circular icon.

2. In the drop-down list, choose Free up space.
The white circular icon is replaced with a cloud icon, which indicates that now the file is only 
available remotely in FileCloud.

Working with Offline Files from FileCloud Desktop for Windows
After you make files and folders available offline, you can perform any of the regular File Explorer 
actions on them when you are offline, and the changes are synchronized with the copies in FileCloud 
when you go back online. 
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For example, in the following procedure, a downloaded file is edited from file explorer while the user is 
offline. 
When the user goes back online, the Activities tab of FileCloud Desktop lists the action as a 
modification of the file, and the Live tab of FileCloud Desktop shows an upload.

1. In Windows explorer, while you are offline, right-click on an offline file (a file with a green circular 
icon) and choose Open or Open with.

The file opens in the default or selected application.

2. Make edits to the file.

3. Save your edits, and close the file.

4. Go back online.

5. Click the Activities tab in FileCloud Desktop.
The latest activity listing indicates that the file has been modified. 
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In addition, the modified file is synced with FileCloud (uploaded to FileCloud) and replaces the 
original file in FileCloud, so that the edited file is now the same offline and online.

6. If you want to confirm that the file has been synchronized, open or preview the file in FileCloud 
and check its contents.
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Working with Online Files in FileCloud Desktop for Windows
In the FileCloud Desktop folder in Windows explorer, any file or folder with a cloud next to it is online in 
FileCloud; when you edit or otherwise modify the file or folder from Windows explorer, you are actually 
modifying it in FileCloud, and the changes appear immediately in the files in the FileCloud user portal 
and other clients.

You can see this in the following video, which shows the online FileCloud files in Windows explorer and 
in the FileCloud user portal side by side. The folder is renamed from Wiki proposals to Wiki ideas in 
Windows explorer, and as soon as the user portal is refreshed, the change appears there as well. No 
sync action is needed.https://www.youtube.com/embed/ipun78UnVNc?si=iwHZMJg1VWGbwUDd

https://www.youtube.com/embed/ipun78UnVNc?si=iwHZMJg1VWGbwUDd
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In the 

Activity tab of the FileCloud Desktop dashboard, you can see action for renaming the folder Wiki 
proposals to Wiki ideas:
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The same is true if you edit, delete, create, or copy a file in either interface. It appears almost 
immediately on the other. (You can check the Activity tab to monitor when syncing has occurred.)
The following example shows how a file created in the FileCloud user portal automatically appears in 
the online folder in Windows explorer:

Shar
ing 

Files and Folders in FileCloud Desktop for Windows
You can share a file or folder in FileCloud from the FileCloud Desktop for Windows folder in File 
Explorer.

To share a file or folder:

1. In the FileCloud Desktop dashboard, click the folder icon. 
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File Explorer opens to the FileCloud folder that you are logged in to in FileCloud Desktop.

2. Navigate to the file or folder that you want to share and right-click it.

3. In the menu, choose FileCloud Desktop > Share.
Note: On Windows Server 2019 this option is not supported.
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A FileCloud Share Link dialog box opens.
For help creating the share, see Sharing Files and Folders.

How FileCloud Desktop for Windows handles change conflicts

File conflict occurs when FileCloud Desktop for Windows cannot determine which copy of a file is the 
most recent.

How to know there is a conflict

FileCloud Desktop indicates that there is a conflict in the following ways:
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 The Recent Activity dashboard screen shows a warning icon beside the action and indicates 
Modifying the file [filename] ended in a conflict. In addition, the Activity tab at the bottom of the 
dashboard is overlaid with a warning icon that indicates the number of conflicts:

If you click the more icon next to the conflict file it gives you the options:
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Open file location - Takes you to the folder storing the file in the FileCloud Desktop root in 
Windows Explorer. The original file (not the conflict file) is highlighted.
Learn more about conflicts - Takes you to the current help page.
Dismiss this conflict - Removes the conflict from your Recent Activity screen, but maintains the 
conflict file so you may resolve the conflict later.

 In the desktop tray, the FileCloud Desktop icon is overlaid with a warning icon:

 Right-clicking on the desktop tray icon shows the option Show conflicts. Clicking on it takes you 
to the Recent Activity screen in the dashboard where the conflict is listed.
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What causes a conflict

It can arise under the following conditions:

 When two users save the same file at approximately the same time. 

 When one user is editing a file offline, and the file is modified by another user in FileCloud. When 
the person who was offline comes back online and FileCloud Desktop tries to upload the edited 
version to the server, it detects that there is a new version available.

FileCloud’s resolution: the conflict file

In these cases:

 If the conflict files have been edited by two different users:
FileCloud Desktop for Windows automatically resolves the conflict by saving the copy of the file 
on the server with the original filename, and saving the local copy of the file with the name 
[filename]-[username].[ext]. Both files are saved locally in FileCloud.

 If the conflict files have been edited by the same user:
FileCloud Desktop for Windows automatically resolves the conflict by saving the copy of the file 
on the server with the original filename, and saving the local copy of the file with the 
name [filename]-[machine name].[ext]. Both files are saved locally in FileCloud.
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How to know there is a conflict
FileCloud Desktop indicates that there is a conflict in the following ways:

 The Recent Activity dashboard screen shows a warning icon beside the action and indicates 
Modifying the file [filename] ended in a conflict. In addition, the Activity tab at the bottom of the 
dashboard is overlaid with a warning icon that indicates the number of conflicts:

If you click the more icon next to the conflict file it gives you the options:



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for Windows – 407

Open file location - Takes you to the folder storing the file in the FileCloud Desktop root in 
macOS Finder. The original file (not the conflict file) is highlighted.
Learn more about conflicts - Takes you to the current help page.
Dismiss this conflict - Removes the conflict from your Recent Activity screen, but maintains the 
conflict file so you may resolve the conflict later.

 In the desktop tray, the FileCloud Desktop icon is overlaid with a warning icon. Clicking it shows 
the option Show conflicts. Clicking Show Conflicts takes you to the Recent Activity screen in the 
dashboard where the conflict is listed.

Mass Deployment Configuration for FileCloud Desktop for Windows
You can configure mass deployment settings for FileCloud Desktop for Windows through Remote 
client management (RMC).

To configure mass deployment settings through RMC
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You can configure client device settings for FileCloud Desktop for Windows remotely by specifying the 
configuration XML in the Device Configuration tab of FileCloud policies.

1. In the FileCloud admin portal's left navigation bar, scroll down and click Settings. Then, on 

the Settings navigation page, click Policies  .
The Policies settings page opens.

2. Edit the policy of the users whose client device settings you want to modify.

3. Click the Device Configuration tab.

4. Paste or type in the remote device configuration XML in Device Configuration using any number 
of parameters from the table below.

<xml>
    <fileclouddesktopwindows>
        <setting>
            <key>runatstartup</key>
            <value>1</value>
            <default>1</default>
        </setting>
    </fileclouddesktopwindows>
</xml>

For most clients, if the user changes the configuration locally, then the remote settings configured 
by the Administrator will override those settings the next time the client refreshes its settings.
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<default> is an optional tag that indicates if the setting can be changed through the user 
interface. 
A value of 1 indicates the setting is a default and can be changed by the user through the user 
interface.
A value of 0 (or omission of <default>) indicates that the setting is overridden and cannot be 
changed by the user through the user interface.

Supported parameters for FileCloud Desktop for Windows. All parameters are optional. Add one of 
more of these parameters (using  <key>, <value>, and <default> tags) in the <setting> tags in the XML.

Key Description Values

runatstartup Run FileCloud Desktop for Windows on 
system startup.

0 (disabled)
1 (enabled) default

loglevel Level of details stored in log files, where 
information is the least detailed, and trace 
is the most detailed.

"information" default
"debug"
"trace"
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language Language of the FileCloud Desktop for 
Windows user interface.

Value Language

nl Dutch

en (default) English 

de German

es Spanish

pt Portuguese

fr French

ar Arabic

it Italian

ru Russian

mutenotificat
ions

Suppress all notifications on FileCloud 
Desktop.

0 (disabled, notifications are shown) default
1 (enabled, notifications are not shown) 

Example:

The code below shows example settings:

<xml>
<fileclouddesktopwindows>
  <setting>
    <key>runatstartup</key>
    <value>1</value>
    <default>1</default>
  </setting>
  <setting>
    <key>loglevel</key>
    <value>debug</value>
  </setting>
  <setting>
    <key>language</key>
    <value>en</value>
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  </setting>
  <setting>
    <key>mutenotifications</key>
    <value>0</value>
  </setting>
</fileclouddesktopwindows>
</xml>

In this example:

 The application runs at startup (runatstartup = 1, default = 1). Default value.

 The log level is set to "debug" (loglevel = debug). Overridden value.

 The language is set to "en" (language = en). Default value.

 Notifications are not muted (mutenotifications = 0). Default value.

If a key is not supported or a value is incorrect, the application skips it and logs a warning message.

Precedence of settings

Settings take precedence in the following order, from lowest to highest:

1. RMC default

2. User preferences 

3. Override RMC settings

Using FileCloud for Office with FileCloud Desktop for Windows

Before using FileCloud for Office with FileCloud Desktop for Windows

The first time you install FileCloud Desktop for Windows, you must:

 Confirm that you trust FileCloud for Office and enable it as shown in the following procedure.

To confirm that you trust FileCloud for Office and enable it:

FileCloud for Office is an MS Office add-in for Word, Excel, and PowerPoint which can be used in 
both Windows and macOS with FileCloud Sync, FileCloud Drive, and FileCloud Desktop. It is available 
in FileCloud beginning with version 23.1.
For instructions on how to install FileCloud for Office, see Using FileCloud for Office.
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1. After you log in to FileCloud Desktop for Windows, click the Settings tab.

2. Then, click the Trust FileCloud for Office button.

The Trust FileCloud for Office button disappears, and the slider for FileCloud For Office 
integration becomes accessible, and is enabled by default. Leave enabled to be able to use 
FileCloud for Office.
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FileCloud for Office is now enabled, but to use it in Office files, you must attach the add-in to 
each type of Office file from your FileCloud Desktop directory.

Working with FileCloud for Office in FileCloud Desktop for Windows

The FileCloud for Office task panel displays information about a file and enables you to:

 Lock or unlock a file.

 Prevent or allow download of a file while locked.

 Share a file.

 Manage file versions, and view file details and metadata.
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Lock or unlock a file
Locking and unlocking files

You can use the file locking function in FileCloud for Office to:

 See if you have a file locked for editing

 Turn a file lock on or off

 Prevent or enable downloads of a locked file

If a shared file is not locked when you open it for edit, another user can also open the file and make 
changes.
To avoid this, by default, FileCloud for Office automatically locks files for editing when they are 
opened.
When you open an Office file in your client directory, the FileCloud for Office panel shows File is 
locked, and by default, users are allowed to download or read the file (Prevent download is disabled).

 To prevent other users from downloading or reading the file while it is locked, click the Prevent 
download slider.
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 To unlock the file while you have it opened for edit, click Unlock. Now other users can modify as 
well as view and download the file.
Note: Prevent download cannot be enabled when the file is unlocked.
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The following table describes what each lock status means and how it impacts what you and others 
you have shared the file with can do with the file.

Lock Status Access by lock owner Access by others

File is locked (download 
allowed)

Read and modification 
allowed

Only read is allowed, no modification is 
allowed

File is locked (download 
prevented)

Read and modification 
allowed

Neither read nor modification is allowed

File is not locked Read and modification 
allowed

Read and modification allowed

For a locked file with download (read) prevented:
If USER1 has locked (and read blocked) the file:
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You can use the following table to understand the status of lock:

 The FileCloud client will not download the file for USER2

However, if USER2 has already downloaded the file in Sync or Drive, then:

 FileCloud Sync will allow FileCloud for Office to open the file.

 FileCloud Drive will not allow the file to be opened by USER2, unless Drive has already cached 
the file.

If an admin prevents file locking after a user has locked a file in a client:

 The lock is automatically removed from the file

 Additional files cannot be locked using FileCloud for Office, and when you attempt to lock a file, 
an error message similar to the following appears:

If you are an admin and want to disable locking, see Managing User Locks.
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Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

An unlocked file is 
opened by USER1

File is not locked File is locked (read 
allowed) by USER1

File is not 
locked

An unlocked file is 
opened by USER1

File is not locked File is not locked File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is Locked 
(Read 
Blocked) by 
USER1

Share a file
Sharing a file

To share a file or folder that is opened with FileCloud for Office:
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1. In the FileCloud for Office panel, click Create.

A Share Link screen that is nearly identical to the one in the user portal opens:
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2. Share the file using the same settings and options that you would for a share in the user portal. 
See Sharing Files and Folders for help.
Note: The option for downloading the share QR code, which is available for shares created from 
the user portal, is not available for shares created in FileCloud for Office.
After you have shared the file, the FileCloud for Office panel displays details of the share:

3. Click Manage to change the options or permissions in the share.

Download versions, view details and metadata
Downloading versions, viewing details, viewing metadata

Versions
To view a file's version information in FileCloud for Office:

1. At the bottom of the FileCloud for Office panel, click the + across from Versions.
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The expanded Versions section shows you version information about the file.
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To download file versions in FileCloud for Office:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.
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2. Click Download for the version that you want to download, and save it.

Details
To view file details:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.

2. Click the Details tab.
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The details shown are the filename and type, the last modified date, the path of the file in 
FileCloud, and your permissions for the file.

Metadata
To view metadata information for the file:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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2. The Properties dialog box opens to the Versions tab.

3. Click the Metadata tab.
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Each metadata set applied to the file is listed with the values for its fields. 

FileCloud for Office log locations

Locating FFO logs

The locations of log files for FileCloud for Office in Windows and macOS are the following:

Windows: %appdata%/FFOServer

macOS:  /Users/[USERNAME]/Library/Preferences/FFOServer

View and add comments

Viewing and adding comments

Comments added to files and folders in FileCloud for Office also appear in the user portal and any of 
the other client apps.

To view and add comments in FileCloud for Office:

1. If Comments is not visible in the FileCloud for Office panel, scroll down to the bottom of the 
panel.

2. Click the + across from Comments.
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Any existing comments added to the file or folder here or anywhere else in FileCloud appear 
above the Comments box.
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3. To add a new comment, click inside the Comments box and enter the comment.
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4. Click Add comment.
The comment is added.
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Sending Feedback from FileCloud Desktop for Windows
You can send feedback about FileCloud Desktop for Windows to FileCloud directly from the 
dashboard.

To send feedback:

1. From any tab in the dashboard, click Send Feedback.
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A Send Feedback screen opens:
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2. To send a message about something you like or dislike:

a.  Click I like something or I dislike something, and enter your email and comment.
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b. Click Submit.
A message tells you that the FileCloud Product Management team will review your 
message.
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3. To share an idea, click I have an idea.
You are taken directly to the FileCloud Ideas forum, where you can enter your idea.
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White Labeling in FileCloud Desktop for Windows

There are two different options for white labeling your FileCloud Desktop for Windows user interface:

 Complete white labeling - Customers with Enterprise Advanced licenses can use this option, 
which enables branding with custom logos and names for system components. Complete white 
labeling is optimal for OEM’s and service providers. If you are interested, please 23.261b 
Contact FileCloud Support to confirm that you meet minimum eligibility requirements.

 Self service white labeling - All customers can take advantage of this feature, which enables 
customization of the product name and support docs url through a simple JSON file, as shown 
in the instructions below. MDM installation is also required.

Complete white labeling

Once you have confirmed your eligibility for white labeling and purchased it through FileCloud Sales, 
you will be asked to set up an update server for the white labeled system and to provide FileCloud 

Self service white labelling for FileCloud Desktop for Windows is available in version 23.253.0 and 
later.

Customization of product documentation is not supported; however, upon request, product 
documentation can be provided to you in Word format for your own customization.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for Windows – 438

Support with icons, strings, and other resources necessary for the customization. FileCloud Support 
will provide you with a custom installer for FileCloud and custom FileCloud upgrades.

Self service white labeling

To complete self service white labeling, create your JSON file in the format shown below and install it 
on your user’s FileCloud Desktop for Windows clients using mass deployment.

To initially create the JSON file:

1. In a text editor such as Notepad, create a file with the following contents, but enter your own 
values for the keys.
Exclude any of the properties you do not want to customize.

{
"product_name": "ExampleCloud App",
"upgrade_url": "https://www.example.com/download/",
"support_docs_url": "https://www.example.com/doc/",
"display_name_shell": "ExampleCloud"
}

The fields appear in the following locations in FileCloud:
product_name - Log-in wizard and dashboard
upgrade_url - Not used in user interface
support_docs_url - Log-in wizard and dashboard
display_name_shell - Windows explorer (application root)

2. In Windows explorer, enter %APPDATA%.

3. Create the folder Cloud Branding in %APPDATA% if it doesn’t exist already.

4. Save your json file in %APPDATA%\Cloud Branding\ as cloud_storage_branding.json.

5. When users open or restart FileCloud Desktop, they will see your customizations in the following 
locations:

 Login Wizard
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 Title bar in dashboard
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 Right-click menu for icon in desktop tray
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 Help popup

 Windows explorer
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FileCloud Desktop for macOS

FileCloud Desktop for macOS enables you to access your FileCloud files and folders in the Finder, 
where you can work with them online or make them available offline. Changes you make to offline files 
stored in FileCloud are immediately synced to the copies in FileCloud.

FileCloud Desktop for macOS opens as a dashboard that shows you live and recent actions and the 
folders you have downloaded offline, and also gives you access to user settings:

When you open FileCloud Desktop, its FileCloud folder becomes available in your Finder. From there, 
you can work with your files online, or download them and work with them offline. Your online files and 
folders appear with cloud icons beside them. When you work with them, you are working with the 

The following features are available beginning in FileCloud Desktop for macOS 23.261:

 Viewing content of WebDRM files

 Self-service user interface customization
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copies in FileCloud, and if you view your user portal, you can see the modifications there. Your 
downloaded folders and their files are marked with green icons with check marks. When you work with 
them, you are working with downloaded copies of the files, but your changes are immediately 
synchronized to FileCloud.

Files shared with the Secure Web Viewer requirement can be viewed through the Secure Web Viewer 
from FileCloud Desktop. The files appear in the FileCloud root under Shared with Me with a .webdrm 
extension as they would in the web browser. Click Open to view a .webdrm file through the Secure 
Web Viewer.

FileCloud Desktop automatically installs with FileCloud for Office (FFO), which enables you to 
automatically lock and unlock Office files and share them when you open them from the FileCloud 
Desktop directory.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for macOS – 445

Begin by installing FileCloud Desktop, and then try out its various functions.

Installing and Upgrading FileCloud Desktop for macOS

To install or upgrade FileCloud Desktop on macOS:

1.  Uninstall FileCloud Sync if it is installed on the same machine that you are installing FileCloud 
Desktop on; otherwise, FileCloud Desktop will not work properly.

2. Install or upgrade to the latest FileCloud version if you do not have FileCloud 23.1 or higher 
already installed.

3. Download FileCloud Desktop for macOS at https://www.filecloud.com/additional-downloads/. 
Then unzip and run FileCloudDesktopInstaller.pkg.
The installer's welcome screen opens:

FileCloud Desktop is supported on macOS Sequoia 15.7 and higher.
(Ventura 13.3.1 is not officially supported, but may function as expected.)

You must have FileCloud 23.1 or higher installed in order to use FileCloud Desktop for macOS.

After you initially install FileCloud Desktop for macOS, it updates automatically, and you are not 
required to perform the following process to upgrade (unless you are using a version of FileCloud 
prior to 23.261).

https://www.filecloud.com/additional-downloads/
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4. Click Continue.
The Select a Destination screen opens.

5. Leave Install for all users of this computer or select a different option, then click Continue.
The Installation Type screen opens.
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By default, FileCloud Desktop is installed in your Apps folder.

6. To install it in another location click Change Install Location.

7. Click Install, and during installation, follow any prompts to allow processing to complete.
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When installation is complete, the following message appears:

8. Click Close.
The following message prompting you to move the installer application into your trash folder 
appears.

9. In most cases, it is a good idea to choose Move to Trash.  

 
When installation is complete, the FileCloud Desktop login page opens.
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The following notification appears on your screen..

10. If you do not want FileCloud Desktop to open automatically when you log in, you can change the 
setting after you log into the application.
If you do not want related software running in the background, change it in your System Settings 
in General > Login Items.

To migrate from FileCloud Sync to FileCloud Desktop for macOS:

1. Upload all files and folders that you want to migrate from FileCloud Sync to FileCloud Desktop 
for macOS to the FileCloud server.

2. Uninstall FileCloud Sync.

3. Install FileCloud Desktop for madOS following the procedure Installing and Upgrading FileCloud 
Desktop for macOS | To install or upgrade FileCloud Desktop on macOS:, above.

4. When you log in to FileCloud Desktop for macOS, a new sync root is populated from the server 
with your files.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for macOS – 450

How autoupdates work

Beginning in FileCloud 23.261, FileCloud Desktop for macOS is updated automatically by default.

If an autoupdate is available when a user is logged out of FileCloud Desktop for macOS, updating 
automatically occurs.

If an autoupdate is available when a user is logged in to FileCloud Desktop for macOS (or when a user 
logs in), FileCloud Desktop is upgraded and the application restarts automatically.

Opening and Logging in to FileCloud Desktop in macOS
Initially, the login page for FileCloud Desktop opens after you install it. After that, by default, it opens 
automatically when you start up your computer. If you do not want it open automatically on startup, 
you can change the setting in FileCloud Desktop. 
 
To open FileCloud Desktop's login screen from macOS Finder, double-click the icon in your 
Applications folder.

Log in with password

Admins: Users who are running the FileCloud Desktop for macOS app when it is being upgraded in 
the background must restart the app to see the updated version.
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Leave Password selected for Login Method, and enter your Server URL, Account Name (username), 
and Password into the Log in screen, and click Log in:

Log in with SSO

1. Select SSO for Login Method.
The screen changes to:
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2. Type the address to the FileCloud server that was sent to you when your FileCloud account was 
created.
You are redirected to the SSO Login page, where you can enter your username and SSO 
password to log in. 
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Log in with Device Authorization Code

1. Select Device Authorization Code for Login Method.
The screen changes to:
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2. Enter your Server URL and Account Name (username).
An Enter Device Code dialog box opens.

3. Click Open Website.
The log-in screen of the user portal opens.

4. Log-in to the user portal.

5. In the upper-right corner of the screen, click your username and choose Settings.

6. In the Settings screen, click Devices.
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7. Next to the listing for FileCloud Desktop, click the check.

A dialog box with the device authentication code opens.

8. Enter the authentication code into the Enter Device Code dialog box, and click Submit.

Log in using Proxy Settings

1. Click Proxy Settings.

A dialog box with proxy settings opens:
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2. Click the Enable Proxy slider to enable use of proxy settings.

3. Fill in the proxy settings.

4. Save your changes.

The first time you log in, you may be prompted to give FileCloud Desktop full disk access.
Follow the prompts to go to Settings > Privacy and Security > Full Disk Access and enable Full Disk 
Access for FileCloud Desktop.
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Once that is configured, login moves through a few screens introducing you to FileCloud Desktop, and 
then opens the FileCloud Desktop dashboard. 
The dashboard opens to the Live screen. FileCloud Desktop cannot begin tracking and synchronizing 
online and offline FileCloud file activity until you download FileCloud folders and files to your local 
drive. So initially, the Live tab appears empty.
Click the folder icon at the bottom of the FileCloud Desktop dashboard to view the FileCloud folder, 
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which now appears under Locations in your finder.

If this is the first time you have logged in to FileCloud Desktop, each file and folder should appear with 
a cloud icon next to it, which indicates that it hasn't been downloaded locally (made available offline) 
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yet.

Begin setting up FileCloud Desktop by making FileCloud files and folders available offline.

For more information about the dashboard, see Using the Dashboard in FileCloud Desktop for macOS.

Working from the FileCloud Desktop for macOS Menu Bar Icon
After you login in to FileCloud Desktop for macOS, a FileCloud icon appears in the taskbar. Click the 
icon to perform FileCloud Desktop tasks.

 Open Dashboard - Opens the FileCloud Desktop for macOS dashboard.

 Log out - Logs the currently logged in user out of FileCloud Desktop for macOS without shutting 
down the application.
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 About FileCloud Desktop - Shows details about the FileCloud Desktop build:

 Exit - Closes the FileCloud Desktop for macOS application.

Sync indicator

To indicate that FileCloud Desktop is currently syncing, the FileCloud icon displays rotating arrows:

On file conflict

If there is an existing file conflict, an additional task is listed:

 Show Conflicts

Clicking on it takes you to the Recent Activity tab in the dashboard where the conflict is listed. See 
How FileCloud Desktop for macOS handles change conflicts for more information about file conflicts.

Using the Dashboard in FileCloud Desktop for macOS
FileCloud Desktop for macOS opens to its dashboard, which has the tabs Live, Activity, Offline, and 
Settings, and a button for opening your FileCloud website (in the user portal).

Live tab
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The dashboard opens to the Live tab, which displays a list of recently accessed files and folders:

 To search for a file or folder in the list, enter a string from its name into the Filter items box.

Activity tab
To view a list of recent FileCloud Desktop activities, click the Activity tab:
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To filter activities on the Activity tab
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 To filter activities by activity type, choose an option in the Activity drop-down list.

 To filter activities by date, choose Any date, Last hour, or Last 24 hours in the Date drop-down 
list.
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 To filter by any string in the listing (including the action, file path, date, or time) enter the string 
into Filter items.
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Offline tab
To view folders that you have moved offline using FileCloud Desktop, click the Offline tab.

 To remove folders from the offline location from the Offline tab, see Remove Files from Offline 
Folders.

 To open an offline folder in its location in the Finder, click the folder icon next to it.

Settings tab
To view FileCloud Desktop for macOS settings, click the Settings tab.
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For information about FileCloud Desktop settings, see FileCloud Desktop Settings.

More Options
To access more options from the FileCloud Desktop for macOS dashboard, click the down arrow next 
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to your username:

 To open your FileCloud user portal, click Open website.

 For this end user help and log files, as well as the version of FileCloud Desktop for macOS that 
you are running click Help.
The following dialog box opens:

 Click FileCloud Desktop help to access this end user help.
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 Click Get logs to open the Finder to the Logs folder, where you can access your FileCloud 
Desktop for macOS log files.

 To log out of FileCloud Desktop for macOS, click Log out.
You are warned that:

This means that in addition to logging you out, FileCloud Desktop clears and removes the 
FileCloud folder that appears in the Finder.

FileCloud Desktop Settings

To change your settings in FileCloud Desktop, click the Settings tab at the bottom of the dashboard.
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Setting Description

Mute all 
notifications

When enabled, all notifications sent from FileCloud Desktop are turned off.

Default is disabled.

Lock 
automatically on 
edit

When enabled, files opened for edit through FileCloud Desktop are locked, and other 
users cannot edit them. When the files are closed they are unlocked again.

Default is enabled.

FileCloud For 
Office 
Integration/
Trust FileCloud 
for Office

FileCloud for Office is an add-in that allows users to automatically:

 Lock Office files when they open them 
 Share Office files while working with them in FileCloud clients

When you initially install FileCloud Desktop, the Trust FileCloud for Office button 
appears. Click it to use FileCloud for Office.
After you click the button, it disappears. The FileCloud For Office Integration setting 
remains disabled until you enable it.

Run at system 
startup

When enabled, begin running FileCloud Desktop when the system starts.

Default is enabled.
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Setting Description

App language User interface language. Change to any of the language options.

Default is English.

Network share 
offline folders
Sync frequency 
(minutes) 

Interval between automatic sync events for Network Folders. Choose any interval in 
the drop-down list.

Default is 10 minutes.

Note: Most FileCloud Online systems do not include Network Folders.

Make Files and Folders Available Offline
To use FileCloud Desktop for macOS to synchronize offline and online changes you make to FileCloud 
files and folders, first download the folders with contents that you want to synchronize. 

When you log in to FileCloud Desktop, your FileCloud folders become available in your Finder in a 
FileCloud folder:

To mark files and folders Available Offline:

1. In your Finder, click the FileCloud folder. 

2. Right-click on each folder with contents that you want to be able to synchronize, and choose 
Quick Actions > Make available offline. 
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FileCloud downloads the folders and their contents to your local drive (and moves them into its 
offline folder), and replaces the cloud icon with a green icon to indicate that they are available 
for synchronization with FileCloud Desktop. 
Note: If you click Download Now next to a file or folder you can edit it offline, but it is not in a 
FileCloud offline folder, and its changes aren't synced with FileCloud. Files downloaded with
Download Now do not display an icon (neither the cloud icon nor the green icon) next to them. 
You are still able to choose Make available offline for the folder to put it into an FileCloud offline 
folder that will sync with FileCloud.
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FileCloud Desktop's dashboard shows you the progress of the files being downloaded on the 
Live tab. These disappear as soon as download is complete.
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On the Activity tab, FileCloud Desktop shows you the download actions for the same files. 
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The Offline tab shows you the folders that you have just made available offline:

Remove Files from Offline Folders
You can remove a file's ability to be edited offline by removing it from the offline folder, either through 
the FileCloud Desktop dashboard or through your Finder.

To remove a file from the offline folder through the FileCloud Desktop dashboard:

1. In the FileCloud Desktop dashboard, click the Offline tab.

2. Click the Remove button next to the file that you want to remove from the Offline folder.
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The file is no longer available offline. It no longer appears on the Offline tab of the FileCloud 
Desktop dashboard and the offline icon no longer appears next to it in the Finder. 
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To remove a file from the offline folder through the Finder:

1. In the Finder, right-click on the file (it should have a green icon next to it).

2. In the drop-down list, click Remove from offline folders.
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The green icons no longer appear next to the folder or its contents.
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The file is no longer listed on the Offline tab of the FileCloud Desktop dashboard.
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Working with Offline Files from FileCloud Desktop for macOS
After you make files and folders available offline, you can perform any of the regular Finder actions on 
them, and the changes are synchronized with the copies in FileCloud when you go back online. 

For example, in the following procedure, a downloaded file is edited from the Finder while the user is 
offline. When the user goes back online, the Activities tab of FileCloud Desktop lists the action as a 
modification of the file, and the Live tab of FileCloud Desktop shows an upload.

1. In the Finder, while you are offline, right-click on an offline file (a file with a green circular icon) 
and choose Open or Open with.
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The file opens in the default or selected application.

2. Make edits to the file.

3. Save your edits, and close the file.

4. Go back online.

5. Click the Activities tab in FileCloud Desktop.
The latest activity listing indicates that the file has been modified.
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In addition, the modified file is synced with FileCloud (uploaded to FileCloud) and replaces the 
original file in FileCloud, so that the edited file is now the same offline and online.

6. If you want to confirm that the file has been synchronized, open or preview the file in FileCloud 
and check its contents.
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Working with Online Files in FileCloud Desktop for macOS
In the FileCloud Desktop folder in your Finder, any file or folder with a cloud next to it is online in 
FileCloud; when you edit or otherwise modify the file or folder from the Finder, you are actually 
modifying it in FileCloud, and the changes appear immediately in the files in the FileCloud user portal 
and other clients.

You can see this in the following video, which shows the online FileCloud files in the Finder and in the 
FileCloud user portal side by side. The file is renamed from Tax Info to Tax Forms in the Finder, and as 
soon as the user portal is refreshed, the change appears there as well. No sync action is needed. 
https://www.youtube.com/embed/CRAOKrzsKu4?si=IyC467hDBF9K40D7

In the 

Activity tab of the FileCloud Desktop dashboard, you can see actions for renaming the folder Tax Info 

https://www.youtube.com/embed/CRAOKrzsKu4?si=IyC467hDBF9K40D7
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to Tax Forms:

The same is true if you edit, delete, create, or copy a file in either interface. It appears almost 
immediately on the other. (You can check the Activity tab to monitor when syncing has occurred.)
The following example shows how a file created in the FileCloud user portal automatically appears in 
the online folder in the Finder:



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for macOS – 485

Shar
ing 

Files and Folders in FileCloud Desktop for macOS
You can share a file or folder in FileCloud from the FileCloud Desktop for macOS folder in File Explorer.

To share a file or folder:

1. In the FileCloud Desktop dashboard, click the folder icon. 
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File Explorer opens to the FileCloud folder that you are logged in to in FileCloud Desktop.

2. Navigate to the file or folder that you want to share and right-click it.

3. In the menu, choose FileCloud Desktop > Share.
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A FileCloud Share Link dialog box opens.
For help creating the share, see Sharing Files and Folders.

How FileCloud Desktop for macOS handles change conflicts

How to know there is a conflict

FileCloud Desktop indicates that there is a conflict in the following ways:
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 The Recent Activity dashboard screen shows a warning icon beside the action and indicates 
Modifying the file [filename] ended in a conflict. In addition, the Activity tab at the bottom of the 
dashboard is overlaid with a warning icon that indicates the number of conflicts:

If you click the more icon next to the conflict file it gives you the options:
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Open file location - Takes you to the folder storing the file in the FileCloud Desktop root in 
macOS Finder. The original file (not the conflict file) is highlighted.
Learn more about conflicts - Takes you to the current help page.
Dismiss this conflict - Removes the conflict from your Recent Activity screen, but maintains the 
conflict file so you may resolve the conflict later.

 In the desktop tray, the FileCloud Desktop icon is overlaid with a warning icon. Clicking it shows 
the option Show conflicts. Clicking Show Conflicts takes you to the Recent Activity screen in the 
dashboard where the conflict is listed.

What causes a conflict

File conflict occurs when FileCloud Desktop for macOS cannot determine which copy of a file is the 
most recent. It can arise under the following conditions:

 When two users save the same file at approximately the same time. 
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 When one user is editing a file offline, and the file is modified by another user in FileCloud. When 
the person who was offline comes back online and FileCloud Desktop tries to upload the edited 
version to the server, it detects that there is a new version available.

FileCloud’s resolution: the conflict file

In these cases:

 If the conflict files have been edited by two different users:
FileCloud Desktop for macOS automatically resolves the conflict by saving the copy of the file 
on the server with the original filename, and saving the local copy of the file with the name 
[filename]-[username].[ext]. Both files are saved locally in FileCloud.

 If the conflict files have been edited by the same user:
FileCloud Desktop for macOS automatically resolves the conflict by saving the copy of the file 
on the server with the original filename, and saving the local copy of the file with the name 
[filename]-[machine name].[ext]. Both files are saved locally in FileCloud.

In the following example, the users Melanie and test-user edit the file sample1.xls at the same time. 
The following events occur:

 Melanie edits sample1.xls on the FileCloud server. test-user edits sample1.xls in a local 
download from FileCloud Desktop for macOS. 

 They save the file at the same time.

 Melanie's edits are saved in sample1.xls.

 test-user's edits are saved in sample1-test-user.xls.

 Both files appear on the server.

How to resolve a file conflict:

1. Review the conflicting versions by opening each version of the file and comparing their contents.

2. Decide which version to keep.
Either:
Keep the version with the most recent or correct changes;
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Or:
Manually merge the changes from the multiple versions into a single file.

3. Save the final version with the original file name once you’ve identified or merged the correct 
content.

4. Delete the remaining conflict files or move them to another folder for reference.
This helps prevent future confusion and ensures only one version continues to sync.

5. Verify that now, the version you saved syncs successfully without generating warnings.

Mass Deployment Configuration for FileCloud Desktop for macOS
You can configure mass deployment settings for FileCloud Desktop for macOS through Remote client 
management (RMC).

To configure FileCloud Desktop for macOS for mass deployment through RMC

You can configure client device settings for FileCloud Desktop for macOS remotely by specifying the 
configuration XML in the Device Configuration tab of FileCloud policies.

1. In the FileCloud admin portal's left navigation bar, scroll down and click Settings. Then, on 

the Settings navigation page, click Policies  .

For most clients, if the user changes the configuration locally, then the remote settings configured 
by the Administrator will override those settings the next time the client refreshes its settings.
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The Policies settings page opens.

2. Edit the policy of the users whose client device settings you want to modify.

3. Click the Device Configuration tab.

4. Paste or type in the remote device configuration XML in Device Configuration using any number 
of parameters from the table below.

<xml>
  <fileclouddesktopmac>    
     <setting>
        <key>runatstartup</key>
        <value>1</value><        
        <default>1</default>
     </setting>
  </fileclouddesktopmac>
</xml>
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<default> is an optional tag that indicates if the setting can be changed through the user 
interface. 
A value of 1 indicates the setting is a default and can be changed by the user through the user 
interface.
A value of 0 (or omission of <default>) indicates that the setting is overridden and cannot be 
changed by the user through the user interface.

Supported parameters for FileCloud Desktop for macOS. All parameters are optional. Add one of 
more of these parameters (using  <key>, <value>, and <default> tags) in the <setting> tags in the 
XML.

Parameter 
(Key) Description Values

lockonopen Automatically lock files when they are 
opened.

0 (disabled) 
1 (enabled) default

runatstartup Run FileCloud Desktop for macOS on 
system startup.

0 (disabled)
1 (enabled) default

loglevel Level of details stored in log files, where 
information is the least detailed, and 
trace is the most detailed.

"information" default
"debug"
"trace"
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Parameter 
(Key) Description Values

language Language of the FileCloud Desktop for 
macOS user interface.

Value Language

nl Dutch

en (default) English 

de German

es Spanish

pt Portuguese

fr French

ar Arabic

it Italian

ru Russian

mutenotifica
tions

Suppress all notifications on FileCloud 
Desktop.

0 (disabled, notifications are shown) 
default
1 (enabled, notifications are not shown) 

Example:

The code below shows example settings:

<xml>
<fileclouddesktopmac>      
  <setting>
    <key>lockonopen</key>
    <value>1</value>
  </setting>
  <setting>
    <key>runatstartup</key>
    <value>1</value>
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    <default>1</default>
  </setting>
  <setting>
    <key>loglevel</key>
    <value>debug</value>
  </setting>
  <setting>
    <key>language</key>
    <value>en</value>
  </setting>
  <setting>
    <key>mutenotifications</key>
    <value>0</value>
  </setting>
 </fileclouddesktopmac>
</xml>

In this example:

 Files are automatically locked when they are opened by FileCloud Desktop (lockonopen = 1). 
Default value.

 The application runs at startup (runatstartup = 1, default = 1). Default value.

 The log level is set to "debug" (loglevel = debug). Overridden value.

 The language is set to "en" (language = en). Default value.

 Notifications are not muted (mutenotifications = 0). Default value.

If a key is not supported or a value is incorrect, the application skips it and logs a warning message.

Using FileCloud for Office with FileCloud Desktop for macOS

Before using FileCloud for Office with FileCloud Desktop for macOS

The first time you install FileCloud Desktop for macOS, you must:

 Confirm that you trust FileCloud for Office and enable it as shown in the following procedure.

To confirm that you trust FileCloud for Office:

1. After you log in to FileCloud Desktop for MacOS, click the Settings tab.

2. Then, click the Trust FileCloud for Office button.

FileCloud for Office is an MS Office add-in for Word, Excel, and PowerPoint which can be used in 
both Windows and macOS with FileCloud Sync, FileCloud Drive, and FileCloud Desktop. It is available 
in FileCloud beginning with version 23.1.
For instructions on how to install FileCloud for Office, see Using FileCloud for Office.
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The Trust FileCloud for Office button disappears, and the slider for FileCloud For Office 
integration becomes accessible, and is turned off by default. Click it to turn it on so you are able 
to use FileCloud for Office.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for macOS – 497

FileCloud for Office is now enabled, but to use it in Office files, you must attach the add-in to 
each type of Office file from your FileCloud Desktop directory.

Working with FileCloud for Office in FileCloud Desktop for macOS

The FileCloud for Office task panel displays information about a file and enables you to:

 Lock or unlock a file.

 Prevent or allow download of a file while locked.

 Share a file.

 Manage file versions, and view file details and metadata.

Lock or unlock a file
Locking and unlocking files
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You can use the file locking function in FileCloud for Office to:

 See if you have a file locked for editing

 Turn a file lock on or off

 Prevent or enable downloads of a locked file

If a shared file is not locked when you open it for edit, another user can also open the file and make 
changes.
To avoid this, by default, FileCloud for Office automatically locks files for editing when they are 
opened.
When you open an Office file in your client directory, the FileCloud for Office panel shows File is 
locked, and by default, users are allowed to download or read the file (Prevent download is disabled).

 To prevent other users from downloading or reading the file while it is locked, click the Prevent 
download slider.
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 To unlock the file while you have it opened for edit, click Unlock. Now other users can modify as 
well as view and download the file.
Note: Prevent download cannot be enabled when the file is unlocked.
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The following table describes what each lock status means and how it impacts what you and others 
you have shared the file with can do with the file.

Lock Status Access by lock owner Access by others

File is locked (download 
allowed)

Read and modification 
allowed

Only read is allowed, no modification is 
allowed

File is locked (download 
prevented)

Read and modification 
allowed

Neither read nor modification is allowed

File is not locked Read and modification 
allowed

Read and modification allowed

For a locked file with download (read) prevented:
If USER1 has locked (and read blocked) the file:

 The FileCloud client will not download the file for USER2
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You can use the following table to understand the status of lock:

However, if USER2 has already downloaded the file in Sync or Drive, then:

 FileCloud Sync will allow FileCloud for Office to open the file.

 FileCloud Drive will not allow the file to be opened by USER2, unless Drive has already cached 
the file.

If an admin prevents file locking after a user has locked a file in a client:

 The lock is automatically removed from the file

 Additional files cannot be locked using FileCloud for Office, and when you attempt to lock a file, 
an error message similar to the following appears:

If you are an admin and want to disable locking, see Managing User Locks.
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Action

Doc IQ 
Lock
Enable
d

Preve
nt
Downl
oad

Lock Status
Before Open

Lock Status
After Open

Lock Status
After close

An unlocked file is 
opened by USER1

File is not locked File is locked (read 
allowed) by USER1

File is not 
locked

An unlocked file is 
opened by USER1

File is not locked File is not locked File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Allowed) by 
User 1

File is Locked (Read 
Allowed) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER1

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is not 
locked

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Allowed) by 
USER1

File is Locked (Read 
Allowed) by USER1

File is Locked 
(Read 
Allowed) by 
USER1

A file locked by USER1 
is opened by USER2

File is Locked 
(Read Blocked) by 
USER1

File is Locked (Read 
Blocked) by USER1

File is Locked 
(Read 
Blocked) by 
USER1

Share a file
Sharing a file

To share a file or folder that is opened with FileCloud for Office:
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1. In the FileCloud for Office panel, click Create.

A Share Link screen that is nearly identical to the one in the user portal opens:
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2. Share the file using the same settings and options that you would for a share in the user portal. 
See Sharing Files and Folders for help.
Note: The option for downloading the share QR code, which is available for shares created from 
the user portal, is not available for shares created in FileCloud for Office.
After you have shared the file, the FileCloud for Office panel displays details of the share:

3. Click Manage to change the options or permissions in the share.

Download versions, view details and metadata
Downloading versions, viewing details, viewing metadata



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

FileCloud Desktop for macOS – 505

Versions
To view a file's version information in FileCloud for Office:

1. At the bottom of the FileCloud for Office panel, click the + across from Versions.

The expanded Versions section shows you version information about the file.
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To download file versions in FileCloud for Office:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.
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2. Click Download for the version that you want to download, and save it.

Details
To view file details:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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The Properties dialog box opens to the Versions tab.

2. Click the Details tab.
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The details shown are the filename and type, the last modified date, the path of the file in 
FileCloud, and your permissions for the file.

Metadata
To view metadata information for the file:

1. In the Versions section of the FileCloud for Office panel, click Manage versions.
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2. The Properties dialog box opens to the Versions tab.

3. Click the Metadata tab.
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Each metadata set applied to the file is listed with the values for its fields. 

FileCloud for Office log locations

Locating FFO logs

The locations of log files for FileCloud for Office in Windows and macOS are the following:

Windows: %appdata%/FFOServer

macOS:  /Users/[USERNAME]/Library/Preferences/FFOServer

View and add comments

Viewing and adding comments

Comments added to files and folders in FileCloud for Office also appear in the user portal and any of 
the other client apps.

To view and add comments in FileCloud for Office:
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1. If Comments is not visible in the FileCloud for Office panel, scroll down to the bottom of the 
panel.

2. Click the + across from Comments.

Any existing comments added to the file or folder here or anywhere else in FileCloud appear 
above the Comments box.
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3. To add a new comment, click inside the Comments box and enter the comment.
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4. Click Add comment.
The comment is added.
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Sending Feedback from FileCloud Desktop for macOS
You can send feedback about FileCloud Desktop for macOS to FileCloud directly from the dashboard.

To send feedback:

1. From any tab in the dashboard, click Send Feedback.
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A Send Feedback screen opens:
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2. To send a message about something you like or dislike:

a.  Click I like something or I dislike something, and enter your email and comment.
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b. Click Submit.
A message tells you that the FileCloud Product Management team will review your 
message.
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3. To share an idea, click I have an idea.
You are taken directly to the FileCloud Ideas forum, where you can enter your idea.
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White Labeling in FileCloud Desktop for macOS

There are two different options for white labeling your FileCloud Desktop for macOS user interface:

 Complete white labeling - Customers with Enterprise Advanced licenses can use this option, 
which enables branding with custom logos and names for system components. Complete white 
labeling is optimal for OEM's and service providers. If you are interested, please 23.261b Contact 
FileCloud Support to confirm that you meet minimum eligibility requirements.

 Self service white labeling - All customers can take advantage of this feature, which enables 
customization of the product name and support docs url through a simple JSON file, as shown 
in the instructions below. MDM installation is also required.

Self service white labelling for FileCloud Desktop for macOS is available in version 23.261.0 and 
later.

Customization of product documentation is not supported; however, upon request, product 
documentation can be provided to you in Word format for your own customization.
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Complete white labeling

Once you have confirmed your eligibility for white labeling and purchased it through FileCloud Sales, 
you will be asked to set up an update server for the white labeled system and to provide FileCloud 
Support with icons, strings, and other resources necessary for the customization. FileCloud Support 
will provide you with a custom installer for FileCloud and custom FileCloud upgrades.

Self service white labeling

To complete self service white labeling, create your JSON file in the format shown below and install it 
on your user's FileCloud Desktop for Windows clients using mass deployment.

To initially create the JSON file:

1. In a text editor such as Notepad, create a file with the following contents, but enter your own 
values for the keys.
Exclude any of the properties you do not want to customize.

{
"product_name": "ExampleCloud App",
"short_company_name": "MyCompany"
"upgrade_url": "https://www.example.com/download/",
"support_docs_url": "https://www.example.com/doc/",
"display_name_shell": "ExampleCloud"
}

The fields appear in the following locations in FileCloud:
product_name - Log-in wizard, dashboard, Help pop-up
short_company_name - Help pop-up
upgrade_url - Not used in user interface
support_docs_url - Log-in wizard and Help pop-up
display_name_shell - Not used in user interface

2. In the macOS finder, go to /Users/<username>/Library/Application Support.

3. Create the folder Cloud Branding if it doesn't exist already.

4. Save your json file in the Cloud Branding folder as cloud_storage_branding.json.

5. When users open or restart FileCloud Desktop, they will see your customizations in the following 
locations:

 Login Wizard
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 Title bar in dashboard
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 Menu for icon in toolbar

 Help popup
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Managing FileCloud Client Apps with MDM Software

Mobile device management (MDM) software enables you to manage all of your users' devices and 
apply security to them. You can use MDM software with FileCloud's client apps installed on laptop, 
desktop, and tablet computers.

To add a FileCloud client to MDM software:

1. Enroll Your Device

Since there are many MDM providers and ways to enroll, please check your MDM documentation for 
instructions on how to enroll your users' devices.

As an example, to enroll your users' Windows devices in Miradore MDM:

1. Log in to Miradore MDM.

2. Add or import the device user(s) to Miradore MDM.

3. In the navigation panel, go to Enrollment > Enroll Device.

This page is intended for FileCloud admins only, and addresses management of FileCloud client 
apps with MDM software. Individual MDM software applications may be configurable with certain 
operating systems only, and therefore may be effective with specific FileCloud client apps only. 
At the current time, Miradore MDM has been tested with FileCloud Desktop for macOS and FileCloud 
Desktop for Windows. The examples given below use Miradore MDM configured for FileCloud 
Desktop for Windows. However, other MDM software that supports Windows and macOS may be 
used with FileCloud Desktop and other FileCloud clients..

See Using MDM Software with FileCloud Mobile Apps for information about using MDM software 
with FileCloud's mobile apps.
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4. Click the Windows icon.

5. Under Single device enrollment, leave Full management and Add user selected. Then choose a 
user and click Begin enrollment.

The screen indicates that the user's device is being enrolled.
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It notifies you when enrollment is complete.
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6. To confirm that the device is actively enrolled, in the navigation panel, go to Management > 
Devices and check that the device is listed with a green icon.

2. Add the FileCloud client app to your MDM

Please check your specific MDM's documentation for instructions on how to add an app to your MDM 
software.

In general, the steps for adding a FileCloud client app to your MDM are:

1. Download the application package of the FileCloud client.
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2. Open your MDM software.

3. Add the FileCloud client app.

4. Assign or deploy the FileCloud client app to the devices enrolled with the MDM.

For example, to add FileCloud Desktop for Windows to Miradore MDM:

1. Download FileCloud Desktop for Windows at https://www.filecloud.com/additional-downloads/.

2. Log in to Miradore MDM.

3. Add FileCloud Desktop for Windows to Miradore MDM.

a. In the navigation panel, go to Management > Applications.

b. On the Applications page, click Add > Windows application.

https://www.filecloud.com/additional-downloads/
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c. In Step 1, select MSI (file upload), and click Next.

d. In Step 2, select the FileCloudDesktopInstaller.msi file, and fill in any the other fields. Leave 
Deployment context set to Device. Then click Create.

The application is uploaded and appears in your list of applications. Note that it may 
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appear in Pending Uploads until it is uploaded.

3. Deploy the FileCloud App to the devices

Deploying the FileCloud client to the devices enables you to manage them with the MDM.

To deploy the FileCloud client to an enrolled device in our Miradore MDM example:

1. Navigate to the Management > Applications page if you are not already there.

2. Check the FileCloud client that you want to deploy to the device or devices you enrolled, and 
click Deploy.



FileCloud Online Version 23.261 FileCloud Client Applications and Add-ins

Managing FileCloud Client Apps with MDM Software – 533

3. Click Next.

4. Check the device or devices to deploy the application to, and click Next.
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5. Review the deployment information, and click Deploy.

You receive confirmation that the application is deployed.
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Now you can manage use of FileCloud Desktop for Windows on the devices it has been 
deployed to.

To update a FileCloud client app in MDM software:

1. Follow the process described in Step 2, above, for adding the FileCloud client app but upload the 
new version of the file.
It is listed under Applications like the original file.

2. Follow the process described in Step 3, above, for deploying the updated application to the 
devices you previously deployed it to.
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